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Since some years, the bringing-in of the IT systems to the business competitiveness becomes more and more
visible. The latter went from tools processing recurrent operations to tools running and optimizing the day to day
activity. Nowadays, the Enterprise Resource Planning softwares are even frequently at the origine of getting a
competitive advantage.

The departments based organization, vertically structured, is coming out and the integration around processes is
the everyday reply to the companies reactiveness need, reliability and anticipation. We need to be able to
understand each other, to work efficiently between sales and marketing people, technicians, accountants and
logisticians of a same company in order to optimize the global functioning.

For that, we need a common language, shared referentials, practices and communication modes. The ERPs
(Enterprise Resource Planning), constitute the ideal tool for a such organization of the business.

But, the risks and the integration costs have always been as important as the the advantages procured by such
systems. It's why less than 5% of the small and medium enterprises are today equipped with an ERP. Moreover,
the giant editors such as SAP, Microsoft or Oracle have never reconciled the power and the exhaustiveness of an
ERP with the simplicity and flexibility expected by the users. And yet these criteria are exactly what the small
and medium enterprises are today looking for.

The economical and development models of Open Source have been able to bring an appropriate solution to these
not resolved cost and quality issues of this kind of software.

To make the ERPs accessible to the small enterprises, we first needed to cut the costs. Open Source permitted to
remove an intermediary (the distributor), to decrease the development costs thanks to reusing open source
softwares, to significantly reduce the commercial and marketing costs by the free publishing of the software.

As regards the Open Source quality, we may say that this one is the result of a free interaction between thousands
of contributors and partners working on the same project.

It is important that a such software shouln't be designed by only one editor but by specialists in numerous
domains. Indeed, it's not possible to be in the same time accountant, technician, salesman, specialist in ISO9001
quality, specialist in food processing, to know the ways and costums of the pharmaceutical industry, etc...

For that, what's better than a worldwide network of partners and contributors. Each actor makes one's contribution
to the edifice, according to his business skills. We are going to see all the way through this book, that when this
work is well organized, the result exceeds our expectations.

But the real challenge in developping is to make these solutions simple and flexible, as complete as they may be.
But to reach this quality level, we need a conductor able to organize all theses activities. Thus, the development
team of the editor Tiny is mainly in charge of the software organization, synchronization and consistency.

And Tiny ERP excels in these domains !

Grâce à son extrême modularité, les développements collaboratifs ont pu être parfaitement intégrés, permettant à
chaque entreprise de choisir parmi une grande liste de fonctions disponibles. Comme la plupart des logiciels
libres, l'accessibilité, la flexibilité et la simplicité sont les maîtres mots du développement. En effet, on ne peut
plus se permettre de former les utilisateurs pendant plusieurs mois sur le système puisque ceux-ci peuvent le
télécharger et l'utiliser directement.

Vous trouverez ainsi des modules pour tous les types de besoins, permettant à chaque entreprise de construire son
système sur mesure par le simple assemblage et paramétrage de modules. Il y a des dizaines de modules qui vont
du module très spécifique tel que l'interface EDI pour l'agro-alimentaire qui a été utilisé pour l'interface avec les
magasins Match et Leclerc jusqu'au simple module d'automatisation de la commande de sandwichs à midi, en
tenant compte des préférences gastronomiques des employés.

Et les résultats sont impressionnants. Tiny ERP est le logiciel de gestion le plus téléchargé au monde avec plus de
500 installations par jour. Il est disponible en 16 langues et possède un réseau de partenaires et contributeurs
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mondial. Plus de 200 développeurs participent au projet sur le système de développement collaboratif Tiny Forge.

A notre connaissance, Tiny ERP est le seul système de gestion qui est à la fois utilisé par de grands comptes mais
également par des indépendants. Cette diversité est à l'image de la solution: un rapport élégant entre l'étendue
fonctionnelle du logiciel et une très grande accessibilité.

Et cette diversité se retrouve également dans les secteurs et métiers qui utilisent le logiciel: agro-alimentaire,
textiles, sociétés de services, production, pharmaceutique, libraires, huissier de justice, ventes publiques,
informatique, négoce, etc.

Enfin, un tel logiciel n'a pu voir le jour que par une exceptionnelle qualité du code, de l'architecture et les
technologies libres utilisées. En effet, vous allez être très surpris de découvrir lors de l'installation que Tiny ERP
fait moins de 1Mb: il tient sur une disquette ! On est bien loin de cette image d'"usines à gaz" qu'ont acquise les
ERP propriétaires au cours de ces dernières années...
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Who is this book aimed at ?

Chapter to entirely write!

Should be written around the advantages obtained / researched needs compared with:

Freelance• 
Small and medium enterprises• 
Big accounts• 

 Who is this book aimed at ? 6
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Book Structure

The first section deals with the installation of the software. Two operating systems have been covered : Windows
and Linux/ Debian. You will find there in the first part the server and database installation, while the second part
is dedicated to the client.

Then, each of the chapters below deals with a function of the company. The following functions are successively
analyzed : Customer Relationship Management, Accounting and Finance, Human Resources and Timesheets,
Inventory Control, Purchase Order & Procurement, Sales Order, Production, Project Management, Marketing,
eCommerce site interface and System Administration.

These different chapters are all structured in the same way. The first section deals with the definition of the
function, its role and its integration in the whole company. This section is mainly represented by the flow of
information. It is mainly useful for the system administrator, keen on understanding the relations between all the
documents. Then, the different operations are described from a user point of view. Then, a section describes the
module settings, useful for the system initial configuration. Finally, the chapters end by a technical data sheet
summarizing all the functionalities of the module. Those can be very useful to help you in evaluating the software
concordance compared to specific needs.

After this overview of the functions of the enterprise, we will deal with the software implementation. That
implementation is covered in 3 phases : the installation for putting into production, the system initial
configuration and the data import.

Then we will finish by a chapter describing the organization of Tiny ERP's project. We describe there the
economical model guarantor of the software perenniality, the roles of the different actors in the product evolution
and an overview of many available optional modules.

 Book Structure 7
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Using the interface

 Using the interface 8
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Getting started with the interface

Learn first how to use the Tiny ERP client graphic interface.

In this section, we are going to successively learn how to be connected to the Tiny ERP server, to use the basic
functionalities of the software, to surf in the menu and forms. The more advanced functionalities are also
described, such as keyboard shortcuts, requests, tree structures and other software facilities.

All the documents, modules and different functions of Tiny ERP have a homogeneous interface. Once this first
approach mastered, you will be able to surf and use every module of Tiny ERP.

 Getting started with the interface 9
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The first time...

During the first launch of the Tiny ERP client, a survey screen appears.

 ∆

This screen ensures you to participate in a Tiny survey, the company editing Tiny ERP. The different fields are
optional and you can leave them empty before clicking on the enter button.

This survey ensures developers to have a better perception of people using the system, and so to be able to better
target the future developments. This windows only appears the very first time.

Maybe the survey will be displayed in an other language than french or english. Indeed, this one automatically
takes the language configured by default on your computer. Once connected to the system, Tiny ERP can take the
data configured for your user account and then you will be able to change the default language.

 The first time... 10
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The login window

Before to be able to start using Tiny ERP, you need to be identified. That's why the fist window to be displayed is
the login window.

Depending on your system configuration, it's possible that this window doesn't automatically appear when
launching the program. Then you can obtain it thanks to the menubar on the top: File > Connect.

 ∆

In this window, you can type your login and password. If it's the very first installation, two users have been
created, ensuring you to test the system.

User Password Access rights
admin admin Reaches every installed function
demo demo Limited view to users functions

Changing the server

During the first Tiny ERP use, or if the server configuration has changed, maybe you will have to specify the
address and port of this one.

 The login window 11
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 ∆

To reach these parameters that you certainly will only have once to type, click the arrow icon to the left of
�Server parameters�. Then the Server and Port fields will appear. You can modify them. Tiny ERP automatically
records these parameters for the next connection.

If the server runs on the same machine than the client, keep "localhost" as server address.
8069 is the port used by default when installing the server.

It is recommended to use the IP address of the machine where the Tiny ERP server is installed.
However, if your network allows it, you can also use the name of the machine.

Changing the server 12
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The main window

After identification, the Tiny ERP main window appears on the screen. This window contains several parts that
we are going to discover together.

Icons

The icons are always present on the screen. They ensure you to do most of the usual operations (open, save,
search, ...) and never change from one form to another. Further we will detail the different ones.

Statebar

The statebar is another Tiny ERP window component that always stays visible. In this bar you can find, from left
to right :

Keyboards shortcuts• 
The name and first name of the user currently recorded• 

 The main window 13
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The address and the port of the server• 
Information related to the requests.• 

The requests are a kind of private messages sent to the users to inform them of important things. The requests are
also used as internal communication system between the differents users. Further we will come back to them.

Maybe a lock will be visible in the statebar. In that case, that means that you are connected in secured mode. (via
HTTPS protocol).

The notation ^N represents the keys combination <CTRL>+<N>

The menu

The last "fixed� part of the interface is the menu. It includes different sections that ensure you to do different
actions.

File: general actions• 
Users: actions peculiar to the current user• 
Form: actions about the current record or form• 
Plugins: launching a plugin on the current record• 
Help: obtain help or information about Tiny ERP.• 

Some letters of the menu elements are underlined. They are the keys of keyboard shortcuts. If the menu is already
focalized, you just will have to press this key to open the concerned menu (ex: <O> will open the Options menu).
From anywhere in the application, it is also possible to open a menu with keys combination <ALT>+<the
underlind letter> (ex: <ALT>+<H> will open the Help menu)

Statebar 14
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Inside...

In addition to the different elements that we have just seen, the Tiny ERP main window, the one which is
displayed after identification, also contains the menu itself. This menu may be different depending on the
connected user rights. It also depends on the company profile.

The Tiny ERP menu is a tree. That means that each menu element is containing one or more other elements. You
can "open" each menu or submenu by clicking on the arrow icon on the left (  ) of the menu element that you
wish expanding.

Once the menu expanded as wished, you can open a form by double-clicking on the menu element concerned.

The menu directories, represented by a half-opened file, are generally not associated to forms. If you double-click
on a menu which has no associated form, a warning message tells that there is no associated action to this menu.

During your first connection to the system, the menu is displayed in english even if you have correctly loaded the
french language during the installation. It is beacause the system takes the preferencies of the connected user for
selecting the right language. To move to the french language, use the menu above : User > Preferencies. Then
select french.

Inside... 15

18/09/06



1

This change of language will only apply to the next opened windows. To open a new menu in french, use the
meny above: File > New menu. (or CTRL + T). Another solution is to disconnect then reconnect via the
'File'menu.

Inside... 16

18/09/06



1

Shortcuts

On the left part of the �menu� window are the user's shortcuts. Each user has his own shortcuts. That ensures to
have a compilation of the more frequently used menus in order to reach the frequently used forms as fast as
possible.

To add such a shortcut, you have to select the menu option that you want to insert into the shorcuts then click on
the �add� icon (  ).

To reach the form associated to this shortcut, you will have to either double-click on it, in the shortcuts, or select

it then click on the �go to� icon(  ).
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Tabs

In Tiny ERP, when you open a form, this one is displayed in a new tab. It's possible to navigate from a form to
another by selecting the corresponding tabs or to come back to the main menu by clicking on the tab "Menu".

This tabs system is very practical to process several actions in the same time. Indeed, imagine that you are
recording a quote for a customer. The phone rings and another customer asks you for information. You can leave
the tab related to the opened quote, then open a new tab for browsing the information of the customer calling you
on the telephone. Once you put the telephone down, you can close the Partners tab and come back to the quote in
progress.

Be careful, some forms themselves contain tabs which ensure to navigate in various parts of a same form. The
above picture proposes 5 vertical tabs ("Information", "Procurement (days)", "Names", "Descriptions",
"Packaging") for the products form, which is itself displayed horizontaly in the tab "Product" as "Menu",
"Partners", "Sales Order" and "Language".
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Using forms

In a form, we can see several distinct sections :

On the central part, the form itself• 
On the bottom, an information bar.• 

In this bar, we have two sections:

On the left: information about the current record : number of selected records and id of the one in edit
mode

• 

On the right: the status of the current record : saved, invalid, ...• 
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The fields

In the Tiny ERP form, you can find fields of different colors (white, grey and blue).

The white fields are fields that we can call standard,• 
The blue fields are mandatory fields,• 
The grey fields are in mode read-only, they can't be modified.• 

If you forget to fill in a mandatory field or if it is not filled as expected by Tiny ERP, during the form recording,
that one won't be saved and the omitted field will become red.

An error message will also appear in the right part ("Status" area) of the information bar peculiar to the record.

Maybe the mandatory field isn't located in the current tab of the form. When you have an
error message in the information bar, think to verify all the tabs of the form.

The fields types:

There are eleven fields types in Tiny ERP. Here below is a list and a description of each one of them.

1. Text

Simple field to fill with one or more words. The size of this type of field is limited to a number of characters. If
the text that you type into this field is longer than the maximum size, characters typed on the keyboard won't be
added anymore to the screen.

2. Number

Simple field to fill with a number. We can notice on the right of the field two buttons (upward-arrow /
downward-arrow). These buttons can be used to increase or decrease the number inside the field.

There are two types of number fields : integer and float.

We can also increase/decrease this number by positionning the mouse above the field and
by using the wheel.
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3. Date

Field to fill with a date. To fill that field, you can click on the button located on the right of the field and
symbolizing a magnifying glass. Then a new window including a calendar is dispalyed. You just have to click on
the wanted date and valide your choice.

The dates fields are differently represented from one country to another. The representation of the
dates is defined by the configuration of your machine. Thus it is always preferable to use the
calendar to fill the dates, if the correct format isn't known.

Three types of date fields are aivalable in Tiny ERP:

The simple dates, example: 04/05/1979• 
The dates with hours, example: 04/05/1979 06:43:36• 
The simple hours: 06:43:36• 

4. Selection

To fill this kind of field (combo box), you have to click on the button on its right and symbolizing a
downward-arrow, then to select one element of the list box.

5. Check box

This field is represented by a box that you can check or uncheck.

6. Description

This is an equivalent to the field of text type, but larger. There is no size limit and the way to generate a CR/LF.

 3. Date 21
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There is also a version of the field description with layout elements : bold, italic and underline.

7. URL/E-mail

Field being used for typing websites or email addresses. To go to the indicated address or to send an email using
your mail application, you just have to click on the button on the right of the field.

The types URL and E-mail are defined by the programmer. They are not interchangeable by the user. If a field is
related to an URL don't forget to indicate the protocol (http:// ou ftp://) at the beginning of the address.

8. Translatable

These fields (generally text or description) can be translated, you have to click on the flag on the right of the field
to get a popup giving different translations of this field.

According to the user language, the value displayed in this field can be different. The same for the reports. Thus,
an order form can display the english or french product name, depending on the language by default defined in
the client form.

For a language to be available during a translation, it has to be added during the software
instalaltion.

9. Multiple relations

This field specifies the relations between the current record and several other records. To add relations you can
press the �add� button, which opens a search window. You can also add records by typing either the exact code
or part of the resource name then press <ENTER> or click on the button �add�.

If Tiny ERP finds one and single result, the window of research isn't opened and the record is directly added.
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Example of use of the type of field many2many: a customer can be part of one or more
categories (he can be in the same time contractor and "good customer"). A category can be
related to one or more customers.

10. Linked relations

This field too specifies a relation between the current record and several other record (of same or different types).
You can directly create a record with which you want a link thanks to the �new� icon(  ) on the top left of the
field. If that record already exists, you can open it thanks to the �open� icon (  ). It is possible to navigate
between the different linked records thanks to the navigation icons(  ).

There is a �list� version of this field to which one you can move thanks to the �list� icon (  ).

An example of use of this type of field : A partner can have serveral addresses (a shipping address and an
invoicing address). Each address only belongs to one partner. This field is also used, for example, to create
different command lines in an order form.

11. Simple relation

This field specifies the relation between the current record and another record (of same or different types).

Yo can directly create a record with which you want a link thanks to the �new� icon (  ) on the right of the field.
If this record already exists, you can search it thanks to the �search� icon (  ) on the extreme right of the field.

Once the relation between the two records is done, the �search� icon (  ) switches to the �open� icon (  ).

While clicking on this icon, it will be possible to see and/or modify the linked record. It is also possible to seek a
record by typing its exact code or part of its name then pressing <ENTER>.

Be careful, if you indicate the code or the name of the record and that you forget to press <ENTER>, the
�search� icon won't be transformed into �open� icon and the field will be considered by Tiny ERP as not filled.
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Example of use of the type of field many2one : a couple of orders has been placed by only one
customer. Each order is so related to the same customer.

Generally, the fields with linked relations have their equivalent simple relation in the associated resource.
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The icons

In the first pages of the book, we had a quick overview of the different icons available in the graphic interface of
the TinyERP client program.

Now we are going to come back to these icons, and see more in the detail what they allow us to do. That is to say
the operations on the current resources (partners, sales orders, etc) in list or form modes.

 (New): Creates a new record.• 

 (Save): Saves the current record.• 

 (Delete): Deletes the current record.• 

If you try to remove a record which is used and required by another resource, TinyERP will then
display an error message.

 (Search): Opens the search window peculiar to the current resource.• 
 (Navigation arrows): Allow to go to previous/next record.• 

 (List/Form modes): switches to list or form mode and vice versa.• 

 (Wizard): If the current resource proposes only one possible action, click on this wizard icon to
launch this action. If the current resource proposes several actions, click on this icon to display the list of
the available actions.

• 

 (Print): If the current resource proposes only one report, Tiny ERP prints this report. If the current
resource proposes several reports, choose among the available reports.

• 

 (Preferences): Displays and allows to modify the preferences related to the current record.• 

 (Attach): Displays and allows to add/modify/delete the attached files related to the current record.• 
 (Close): Closes the tab in progress.• 

The 'Action' and 'Print' icons have a different attitude depending on whether you are in list or form mode. If you
are in form mode, the action or report is only related to the record displayed on the screen, even if there are
several records selected. If you are in list mode, the action or report is related to the whole selected records.

The distinction between the form and list modes is very important because it allows you to use the same operation
in several ways. For example, you can print an invoice in form mode or print the list of the unpaid invoices in list
mode. And that, with the same action.

The 'Action', 'Print', 'Preferences' and 'Attach' icons only work if one record is selected. To do these actions on a
new record, think to saving it before.

The menu icons

Icons also exist in the menu. It's important to know their meaning; first of all to know what kind of form will be
opened, but also to help you in selecting the right menu option. For example, if you wish to key in your number
of worked hours; you know that, in order to speed-up the input, the interface will display an editable list. Thus
you won't click on a menu option which preceding icon is in the form mode.
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Let us review the different icons :

: Indicates a menu without action, but containing submenus.If you double-click on it, you will obtain
an error message indicating that no action is associated to this menu option.

• 

: Indicates that a form will be displayed if you click on it.• 
: Indicates that a list will be displayed if you click on it.• 
: Indicates that a tree will be displayed if you click on it.• 
: Indicates that the fact of double-clicking on the menu option launches an action. Results may be

different; opening a new element (form, list, tree), printing a report, displaying a questionnaire and
waiting for the keyboarding...

• 

: Indicates that the fact of double-clicking on the menu option prints report.• 

Don't forget that any type of menu can also contain sub-elements, in the same way that menu options with a
folder icon can do (  ). Thus, there are often several entry points towards the same document in Tiny ERP to
make easier the fast access to the data.
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The menus

The "File" menu

Connect: Allows to be connected to Tinyerp server (if you are already connected, displays a message in
the status bar informing that you are already connected, in the keyboard shorcuts area)

• 

Disconnect: Allows to be disconnected from a Tiny ERP server (works only when you are already
connected to a Tiny ERP server)

• 

New window: re-opens a �Menu� tab• 
Close the window: close sthe current window• 
Exit: opens a dialogue box asking to confirm that your wish to quit the application.• 

The "User" menu

Preferences: allows to change preferences (such as the language) of the current user• 
Send a request: allows to create a new request• 
Read my requests: allows to browse the requests received• 
Requests in wait: allows to obtain my requests sent but not yet treated by the recipient.• 

We will see the concept and principle of the requests in the following chapter.

The "Form" menu
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New, Save, Delete, Find, Next, Previous, Switch to list/form have the same function that their
counterparts previously covered in the icons bar.

• 

Duplicate: creates a distinct record, copy of the current recording• 
Previous/Next Window: goes to the previous/next tab• 
View logs: show who created and modified the current record as well as the dates on which these events
occured.

• 

Go to resource ID... : goes directly to a record if you know the id• 
Open: opens the selected menu• 
Reload/Undo: reloads the current record without taking account of the modifications already done• 
Repeat latest action: repeats the last action or report• 
Preview in PDF/editor: previews the or one report related to the current record in PDF/Office mode• 
Export data: exports the selected record in a CSV format or to MS Excel. You can select the fields to
export

• 

Import datas: imports records of the current resource type, in the CSV format.• 

The "Options" menu

Menu bar: allows to choose the representation mode of the menu bar; with only icons, text, icons and
text.

• 
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Client Mode: goes from �Normal" mode to �PDA� mode.• 

The �PDA� mode shows the form in only one columnm, which is easier to see with a low
resolution. Superfluous elements such as the status bar are no more visible in PDA mode.

Print: Do you have to preview documents before printing ?• 

Save options: Save the selected options for the next runs of the Tiny ERP client.• 

The "Plugins" menu

Run a plugin: displays the available plugins list. This one depends on your installation. The main plugin
is the current workflow printing thanks to the BPM (Business Process Management) system included in
Tiny ERP.

• 

The plugins are common for all the types of resources.

The "Help" menu

Support request: allows to send a support request to Tiny ERP or an official partner. To have the
guarantee of a reply, that requires a support contract with either a partner or Tiny sprl

• 

User manual: opens your favorite file manager on the Tiny ERP User manual• 
Contextual help: also opens the user manual but directly at the page concerning the current resource.• 
Tips: opens the Tiny ERP �tips�• 
Licence: shows the text of the GPL v2 (licence under which Tiny ERP is published)• 
About: shows information related to Tiny ERP and the editor Tiny sprl.• 
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Requests

Requests are the internal messaging system of Tiny ERP. They are used to:

Send messages to others users• 
Send reminders based on a date to other users or yourself• 
Receive alerts automatically generated by Tiny ERP: stocks reporting, results of scheduling, etc.• 

In addition, each request can be linked to one or more Tiny ERP resources to increase the usefullness of the
message to send. For example, you can schedule a request which will be sent to one of your employees in 15
days, to remind a phone call to a supplier for checking the price drop of a pruduct that you use to purchase, with a
link to the supplier contact, as another link to the product concerned, and with the lcurrent price.
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Recurrent concepts

After this first overview of the Tiny ERP user interface, you learned how using the icons advisedly, the different
elements of the menu, and how getting information. We advise the reader to install and try using Tiny ERP at that
stage of reading.

In the following sections, we are going to explore more accurately some concepts unceasingly present.

Be sure to have well understood the content of this section before going ahead with Tiny ERP; indeed, this
following section contains all you don't know yet regarding Tiny ERP, but which is necessary to take advantage
of its power.
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The finder window

The finder window is the basic tool allowing you to find records to which you want acceding. If you wish to read
or modify a record, the first operation is to find it before modifying it. The finder form is accessible by two
different ways.

Search a record

The icon �magnifying glass�, outlined in red, launches the finder interface for the records type related to the
form. In the case of above screen, I will be able to find products, if I click on the icon.

Search a relational link

The icon outlined in red in the above screen, will find the product category (relation field) of the current product,
among all the available categories.

The finder window

The finder window is divided into 2 areas:

The critera selection area• 
The list area for displaying the found results• 
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The criteria selection

The criteria selection area allows to type criteria for searching records on the basis of one or several values,
associated to fields of a record type. In our example, the product search, we can type every selected criterion in
relation with a product : code, name, variant, category, type, etc.

Contrary to certain programs or search engines, the Tiny ERP finder is a research which �adds� the criteria.
Thus, if you search the blue and square products, you will get, as result, the only products both square and blue.

For the criteria dates or numbers, you can specify an research interval. Thus, in the above example, you can
search all the products which supplier's lead time is between 3 and 9 days.

When you type the criteria, you can use the key tab to move from a criterion to another. The ENTER key
(equivalent to the Search button) allows you to seek the elements. ENTER a second time without modifying the
search criteria (equivalent to the Validate button) allows you to validate the obtained selection.

Results

The results area displays, in a list form, all the records corresponding to the selected criteria. Once the results are
displayed, if they don't satisfy you, you can modify one or more search criteria, and relaunch the research.

According to the type of research (search of record or relational link), you can either select one record or all the
records (in the case of the product category, it isn't possible for a product to have several categories, so the
research interface won't allow you to select several records in the results list).

By default, the research is limited to the first 80 results. To change this limitation, you can modify the advanced
search parameters in the bottom left of the form.
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The buttons

Three buttons are accessible in the search interface.

Search: launches a research using the typed search criteria• 
Cancel: closes the search interface without taking care of the eventual results area• 
validate: closes the search interface after loading the selected records of the results area. You can select
one or more records of the search results. If no selection update is done by you, they will be all loaded by
default (because automatically selected by the search program).

• 

To select one or more records, use the left button of the mouse combined with the <CTRL> or
<SHIFT> key of the keyboard.
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Trees

Trees are the perfect tool to help in showing the hierarchical structure of many elements of Tiny ERP. The first
example of a tree when running Tiny ERP is the menu.

Trees usefulness

In addition to the help in showing certain data types, the trees are also ideal for rights management of data
belonging to the same domain.

Thus, it is easily possible, via an arborescent product hierarchy, to define special offers on a product category,
including products subcategories and products:

services• 
products

screens♦ 
spares parts

hard drives◊ 
boxes◊ 
keyboards◊ 

♦ 

kits (on special offer)
keyboards◊ 
Mouse◊ 
speakers◊ 

♦ 

• 

You can also grant access rights to certain levels of the tree, for by instance authorizing a users group to deal with
a certain part of the Chart of Accounts, or to only have access to certain analytical accounts...
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In addition, this tree structure can allow you to represent groups of stock locations in a hierarchical way , such as
for example:

northern warehouse of Wavre
east building

rails◊ 
shelves◊ 
heated part◊ 

♦ 

south building
blue shelves◊ 
red shelves◊ 

♦ 

• 

southern warehouse of Wavre
transit area♦ 
main area♦ 
cooled part♦ 

• 

Gembloux storage location
arrival♦ 
control♦ 
departure

by truck◊ 
towards Zaventem Freight◊ 
by train◊ 

♦ 

• 

This structure can for example help you in estimating your stock value, warehouse warehouse, to see which
warehouse is the most used for corrosive substances, while taking in account the overlapping of different storage
locations.

Moddify a tree

To modify a tree structure, you have to modify the link towards the parents at the top level node to move.

Thus, in the example of above stock locations, to move the Gembloux departure area to the east building of
northern Wavre, you have to change the departure area (Gembloux storage locate) to east building (northern
Wavre).

To update a parent is only available in the form mode; also to modify the parent of a tree node, you have to select
the node in the tree, then switch to form mode (form/tree icon).

Once you are in the form mode, you have to change the value of the parent field that you wish to modify, and to
save the modifications done on the record.
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The elements, roots of a tree structure, are the elements which 'parent' field is empty.
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Sequences

The sequences are a practical and easily updatable way (in form mode) to order elements series.

Thus it is possible to define an arbitrary order which will be used to sort the objects series using a sequence
definition, rather than sorting in the alphabelitical order (name) or numeric order (id).

Since the version 3.4 of Tiny ERP, the sequences are conceived in a such way that a �drag-and-drop� on a
resource, elsewhere in the window (on the top or on the bottom part of the list), allows you to re-order the lines of
a list. The �Set Sequence� function allows you to set the value of the field sequence. It is thus possible to quickly
modify the elements order of a list with the mouse by simple drag-and-drop.
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The views

The views determine the way to represent objects on the screen. There are two great types of views, the views in
the form type, and the views in the list type. The same object can have several views or different representations,
according to the need or the context.

For example, a quote doesn't have necessarily the same representation as an order form. In Tiny ERP it is
however the same object but it evolves thanks to a different status.

Form

A view in the form type only shows one record at a time, but as compensation, proposes an user interface simpler
to understand, and more pleasant to use for the neophyte.

The previous section contains explanations about the different types of fields that you can find in the above form.
You are invited to come back to this section if you have any doubt regarding the functioning or usefulness of
every of this screen capture field.

List

On the other hand, a view in a list type, lists the whole selected records in a tabular form, in order to offer a global
view.

To still make easier the data comparizon in a list type, it is possible to sort the displayed records in an ascending
or descending order (on a column).
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Whatever, it is possible to switch from the list type to the form type by clicking on the dedicated icon, as shown
in the previous section.

Trees

The trees are a particular case of the lists, in theway they are records series which have a hierarchical structure.

However, as for the lists and the forms, it is possible to switch from tree to form, with the same icon.

The filters

The filters are a Tiny ERP special feature which should be understood to control the menu and its options. A filter
allows you to add a selection criterion to the selected records.

Thus, in the following screen capture, a double-click on the �Hours encoding� option menu will open a form for
hours entry, while a double-click on "Hours encoding > For me > Today" will open an editable entry list.
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Thus wile going down in the menu, we met two filters, one on the user, one on the date. If you open an associated
menu with one or more filters, you won't be allowed to reach date of the same type but out of the filter.

Thus, compared to the above example, if you double-click on the menu option "Hours encoding > For me > All
the entries", you will be able to see only your hours, even if you launch a research on all the users. Thus, you will
have to double-to click on the option menu "Hours encoding > For everyone > All the entries", or on the option
menu "Hours encoding", then switch to the form mode, and make a research without criterion.

We will see in the administration section of Tiny ERP that you can grant access rights to the different menus
according to the user. This functionality, combined with the filter system allows to only give restricted rights to
certain resources.

 The filters 41

18/09/06



1

Editable lists

The editable lists are a new functionality of the Tiny ERP client introduced since the version 3.3. This
functionality allows to type data via a records list presented in a tabular form, rather than via a form.

To type a great number of records into Tiny ERP, an editable list is faster but it has the disadvantage to only
support a limited number of fields on the screen. Fortunately, you can switch from list to form at every time.

The key <ENTER> allows you to validate the content of a typed line. When the cursor is in a relational field, the
key <F1> allows you to create a resource of the field type, while the key <F2> allows to open a finder window.

The key <TAB> allows you to go to the following field (while the sequence <ALT>+<TAB> allows you to go to
the previous field), and the keyboard shortcut <CTRL>+<S> allows you to save the current record and to create a
following one by positioning the cursor in the first column of the new line. <CTRL>+<D> allows you to quickly
delete an unnecessary record.

You can also use the arrow keys up, down, left and right to move to the different fields and records.
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Right click navigation

Among the functionalities of Tiny ERP, one of them is particularly interesting. It is about the right click. This
functionality allows many actions on the different fields.

For example, from an order form, by right clicking on the field partner, you can do some actions on the specified
partner, like illustrated it the following screen capture:

This functionality doesn't only apply to the partners, it is possible to execute actions on all the fields of the ERP:
from a product ask the future stock, from a salesman ask its planning, from a user ask his cases in progress, etc.

Now let us detail the available actions list.

The default values

The default values allow to save time during the entry, when specifying once and for all which value you wish to
see appearing in a field. In Tiny ERP, the default values can be conditional and depend on the value of other
fields. For example, the default value for the order delivery mode can depend on the partner.

The entry of the �to define the defect� menu allows to add, modify or remove a default value.

Add a default value

To add a default value, you have to right-click on the field which you wish to fix. Then choose the 'define the
default value " option.
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A new window such as shown below is opened.

The window thus opened tells you that you will use the value 1 as default value for the field Shop of the order
form, and ask you whether you want to specify the new default value only for you, or for all the users of the
system.

By checking the Partner_ID field, you can also indicate that this default value is valid only for the selected
partner. In that case, the field Shop is automatically filled when you create a new order for this partner. This
system is very practical for simply encode the preferences of the different customers and suppliers.

When several rules of default value apply, the most precise is selected. The rule only concerning one user is more
precise than a rule concerning all the users, and the rule containing a condition on a form field is more precise
than those applying whatever the form content.

To modify a default value, you have to put a new default value, with the same application conditions as the
default value that you wish to change. To remove a default value, you have to specify an empty content as default
value.

The actions

The action menu has the same effect as pressing the action icon for a resource having the same type as the
selected field, it means that the action menu displays the available actions list, related to the selected resource
(defined by the mouse cursor).

In the case of a right-click on the partner field in an order form, Tiny ERP displays a window such as the one
below, proposing the list of actions available for the selected partner.
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Reports

The report menu has the same effect as pressing the print icon for a resource having the same type as the selected
field, it means that the report menu displays the reports list, or prints the report if there is only one. This report
applies to the value of the field selected by the mouse.

In the case of a right-click on the partner field in an order form, Tiny ERP displays the reports as shown below.

Put in relation

The rest of the menu contains the entries allowing to put in relation the selected resource with other resources.

To come back to our example regarding the order form, the last four elements of the menu allow to respectively
open:

the list of invoices not paid by the partner• 
the list of cases concerning the module sales opportunities (commercial or support opportunities)• 
the list of purchase orders placed to the partner• 
the list of sales orders placed by the partner.• 

The new opened windows are of list type.

Examples of use

Analyzing a salesman's operations

To test this functionality, open an order form since the menu: Sales > Sales order. In the second tab, point the
mouse on the field 'salesman' who designs the commercial person in charge of this order. Right-click and choose:
... Tasks. Tiny ERP then opens automatically the tasks in progress for this commercial.

Click now on the print icon, then you obtain the planning of this commercial. In only two clicks of mouse, you
moved from the order form to the tasks list assigned to this order responsible and then to his planning.

Analyzing a product

A frequent use of the right-click functionalities is the detailed analysis of a product when entering a sale order.
When you type the first line of the quote, select a product. The products list already gives you the price and stock
availablility information. Real and virtual quantities for thes stock availability.

To obtain more information about the product, simply right-click on this field product and select: Reports. You
then obtain the choice between different reports which contextually apply to the selected product:

Future stock: a graph of the availabilities in the time,• 
Cost Structure: detail of the costs at the alternate suppliers, the raw materials and the routing• 
Product Locations: gives the location of the product in the different warehouses.• 
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The buisness functions

In the following chapters, we will present how Tiny ERP can help to organize, automate and manage the different
functions of the company.

Each company is different, that's why Tiny ERP is centered on a modular development. The different
functionality are grouped in modules which can be installed or not according to needs.

There is today more than 60 different modules, and approximately three new modules are published each month.
We will thus be contented in the following pages to present in detail only the principal modules of Tiny ERP. An
outline of the other optional modules is given in the one before the last chapter of this book.

The following chapters concern each one a buiness function established by a Tiny ERP module. In order to help
you to work out all the management aspects of management, they are structured in 5 great phases:

Introduction• 
The process• 
Use of the module• 
Setting parameters• 
Technical data sheet• 

For each chapter, a short introduction allows to define the role of the concerned module. The different
terminologies are described there and the roles of the documents are located in their context.

Then, a presentation of the process concerned is given for each module. This presentation of the different
operations allows to locate the activities of the company in their global context. This chapter is mainly useful for
the system administrator which has to control all the interactions between the different people and documents.

The following section, on the use of the module, consists of procedures for the different operations to do. These
different operations are detined to the end users and are to be seen like recipe book, simple, to apply.

The following section of each chapter describes the setting module parameter. This section is interesting for the
implementation and the initial software configuration. A good Tiny ERP setting parameter allows an adequate
adaptation to the needs of the company.

Lastly, each chapter ends in a technical data sheet presenting the listing of the detailed module functionalities.
This feature can be used as guide with the evaluation of the software compared to your needs or to compare it
with other solutions. All the functions of the module are listed there to help you to determine the applicability and
the range of the possibilities.

The 11 principal modules are thus described in detail in thefollowing chapters: client relationship
management(CRM), accountancy and finance, purchase follow-up and reordering, human resources management,
inventory control, sales order, project management and service activities, the campaigns marketing, the
production management,eCommerce interface and the system administration.

Tiny ERP is a very flexible management system, which allow to obtain different results according to the use and
the setting system parameter. We will present a good working method with Tiny ERP in the following chapters.
But with the reading of these pages, it is important to keep in mind that Tiny ERP is a formidable toolbox, and
that each one is free to use the tools proposed according to its own needs.
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Custoner relationship management

Don't we say "Customer is king" ?

In the businesses, if he isn't always the king, he has to be in any case the center of all our attentions. The goal of
the CRM module (Customers Relationship Management) of Tiny ERP is precisely to check this proverb, by
helping the colleagues of the company to better knowing the customers and their needs.

The CRM module thus proposes an impressive functionnalties number which will allow your colleagues to do
case follow-up , customers events management, sale apportunities management, helpdesk, etc.

You will appreciate to do that, the possibility to automatically segment your partners, to manage contracts types,
quotes and other functionalities of daily use.

It is also used to follow the requests and complaints of the customers, helpdesk or suppliers. For each order it
handles the different actions types: corrective preventive or other. Its power and the great easiness to track all the
associated requests and actions are very appreciated by the companies certified ISO9001.
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Partners

What's a partner ?

In Tiny ERP, a partner is an entity with which we can make deals. There are several types of partners: suppliers,
manufacturers, customers, employees and prospects. The principle of partner is much more flexible than in the
majority of the existing business applications because a partner can be one of these types or a combination of
several of these types. That avoids the double encoding and allows a greater flexibility on the functions available
for each one of these types of partners.

Thus, in Tiny ERP a partner can be, in the same time, your supplier and your customer. This functionality is
particularly important for affiliates or franchises, because in that case, the sales between the main company and
the affiliates are generally done in the two directions.

A partner has several contacts, each one being able to have his own location and data. The information regarding
the bank, historical events, accounting and relations between partners are also present in a partner record.

Categories of partners

To segment the partners, Tiny ERP integrates the concept of hierarchical categories. Four great functionalities
make that this segmentation system is the most evolved and flexible of the CRM market: the categories
hierarchical structure, the automated or manual allocation to categories, the partner system and the fact that
partners can belong to several categories.

To obtain the available partners categories, go to: Partners > Definitions > Partners Categories.
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The categories are structured in a hierarchical way. So it's possible, to apply a rule to any level of the hierarchy.
For example to define special offers for all the customers or only for the category 'Customers > Dealers >
Important'.

The tree structure is also very interesting for the different statistics reports. Indeed, you can print reports by
partners segments, and that, at any level of architecture.

We will see in one of the following sections that the categories can be manually allocated to the partners
(example : newsletter, great prospecs) or automatically by a segmentation rule (example: customers having a
turnover greater than 1.000 euros).

To define a new category, use the menu: Partners > Definitions > Categories > Edit Categories.

Define a partner

The Tiny ERP partner is defined using the menu option : Partners > Partners.

The first tab contains general partner information and his different contacts. Only the name is mandatory. The
partner title indicates the social function of the company: sarl, sa, eurl, asbl, etc. You can define your own titles
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thanks to the menu: Partners > Definitions > Titles.

The partner code is often used to type the partner short name. Thus, when you search a partner (for example, from
a sale order), it's sometimes easier to use the code than by name. The research of a partner is first done with his
code, then if no partner is found, with his name.

The partner language allows to define in which language the documents have to be printed for this partner. To
define new languages, use the menu: Administration > Interfaces > Languages. When you load a translation file
for a new language at the server installation, Tiny ERP automatically adds it to the list of the available languages.

The following section allows to define the different partner contacts. Each contact has his own location and
contact information. Those can be of different types: by default, invoicing, delivery, contact or other. That allows,
for example, when placing an order, to automatically fill the delivery / invoicing and order addresses, according
to the selected partner.

The last section of the first tab allows to indicate the categories to which this partner belongs. You can add or
delete as many categories you need thanks to the buttons 'Add' and 'Delete'.

Additional information is indicated in the second tab : 'Extra Info'.

You will find there the VAT patner number, his payment term and credit limit. The 'Debit' and 'Credit' fields
respectively indicate how much the customer owes you or how much you owe to the supplier. This couple of
fields are automatically accessible in read-only mode and are calculated thanks to the interface with the
accounting module.
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There is also a field 'active' which allows you to deactivate a partner, without having to delete it. When a resource
is deactivated, it is no more available during the research, except if you select the criterion not active. This Tiny
ERP functionality is very interesting for hiding partners with whom you don't work anymore but which have to
remain in the database because historical data are linked (invoices, orders,...). That is also used as functionality
for archiving.

Tiny ERP is able to manage the hierarchical relations between different partners. Thus, to indicate that a partner is
an affiliate, a franchise or is simply linked to another partner, fill in the field 'parent company'. That makes it
possible to build structured relations between different partners as represented by the figure below.

The field 'note' allows you to type any type of informal information related to this partner. There is no limit of
size. Finally, in the middle of the second tab, you can type the different bank accounts.

Contacts

The contacts can be directly typed in the first tab. A partner can have as many contacts as necessary. But you can
also reach your address book directly with the menu option: Partners > Partners Contacts.

Any update or creation done in this form is equivalent to the same operation done directly in the partner form, for
this contact. In Tiny ERP, this principle is called 'manage by two different views of the same object'.

The advantage of using this menu option is that the search for a contact is directly about his fields: partner name,
contact name, addresses, country, zip code,...
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Partners relations

Tiny ERP is able to manage the relations between partners on 3 different levels:

relation between the contacts of the same partner• 
hierarchical structure between partners via the field 'parent company'• 
businesses relations between different partners• 

In the same partner, it is possible to modify the contact role thanks to the field 'Address type'. This one can take
several values: delivery, invoicing, contact, by default or other. This operation is only valid for the use of the
contacts of the same partner.

To structure the relations between partners, you can use the field 'Parent company'. Thus, in an affiliate, a
franchise or a store of a central merchandizing, fill in this field with the parent company. To obtain the structure
graph of the intercompany relations, from the parent company, click on the Actions icon. Select the action
'hierarchical structure'. To obtain this same diagram from the affiliate, use the functionalities of the right-click on
the field 'Parent company'.

The third solution to manage the relations between partners is to install the optional module
�base_partner_relation�. This one adds a fourth tab named �Relations� to the form. You can give to it for each
need type (invoicing, delivery, contact), a partner who has to be used. Thus, thanks to this functionality, when an
order is placed by a shop, Tiny ERP automatically fills in the central purchasing agency addresses for the
delivery, and the addresses of the company which you have to invoice, according to the 'Partners Relations' tab
information.

Parners properties

After selecting a partner on the screen, you can click on the icon 'Properties'. Tiny ERP then gives you the list of
the properties available for this partner. If a property is empty, Tiny ERP then uses the values defined by default.
The list of the defined properties is the following:

Stock-Supplier Location: location used for the stock move counterpart when receiving goods from a
supplier,

• 

Stock-Customer Location: location used for the stock move counterpart when sending goods to a
customer,

• 

Account Receivable: 'account receivable' account of the general ledger,• 
Account Payable: 'account payable' account of the general ledger,• 
Delivery Method: delivery method by default for this partner,• 
Purchase Price List: supplier price list by default,• 
Price List: customer sales price list by default.• 

If you install additional modules, those can add properties to each partner. These properties will be explained
more in the detail in the chapters concerning them.

Actions on partner

To execute actions on partners, make a research and select a partner (form mode) or a group of partners (list
mode) and click on one of the 'Action' or 'Print' icons. Tiny ERP gives the list of the available actions:

Company Architecture: allows to display the tree of the relations between partners according to the field
'Parent company',

• 

Send SMS: allows to send a SMS to the parners selected on the screen. Tiny ERP is configured to use a
SMS gateway: http://clickatel.com. You need a subscription with this supplier to obtain a login and a
password,

• 

Mass Mailing: allows to send an mail to several partners in the same time. The address of the type
'Contact' is used,

• 
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Check EAN13: allows to check the correctness of the EAN13 codes• 
Create Sale Order: allows to automatically generate the quotes header for several customers, a quote by
selected partner.

• 

In the same way, several reports are available thanks to the 'Print' icon:

Identifiants: prints the list of the selected partners, with their ids,• 
Labels: prints labels (to stick on envelops) containing the selected parners addresses,• 
Overdue Payment: prints the customer account (recall).• 

The following picture gives an example of follow-up letter when you print a customer account:
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Cases tracking

The module CRM allows to make the cases tracking. These cases can be of 3 types: sales opportunies, support
request from a customer, request follow-up to a supplier. In Tiny ERP, these cases are done by the same system
but can be differently represented.

According to the origin, the case can be encoded in one of the three menus:

Business opportunity: Sales Management > Business Opportunities• 
Support request from customer: CRM & SRM > HelpDesk > All cases• 
Supplier follow-up: Purchase Management > Purchase Requests• 

Only the field 'Case Type' differs from a case type to the other. If you modify this field, the case will be sent from
one service to the other (from sales department to the engineering department for the support, for example).

Once the partner request encoded, the commercial can take it by clicking on the button 'Open'. The request won't
be anymore visible in the available cases list because it will be allocated to this user.
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Then the user encodes the fields 'description' and 'date of the next action' according to the next action to execute
for this request. When an action has been done, he can press on the button 'Process Action' and the fields are
erased to fill in an eventual additional action.

The user can constantly browse the actions of a case in the second tab. Double-click on an history for more
details. You will see the information related to the date of each action, the responsible user, the detail of the
action and the customer's state of mind.

When the request is finished, the user can close it thanks to the button 'Close Case'. The case becomes inactive
and isn't anymore visible in any research. To make a research in the archived cases, it is necessary to search with
the criterion 'active=No'.

It happens that you don't find anymore one case previously encoded. There are several possible
explanations: either it left in another department and it should be searched via another menu, or it
was deactivated and it should be searched with the criterion'active=No'.

Examples of use

1. A user makes a support request from the Internet site (helpdesk)

In that case, the event is automatically created when the request is introduced on the site. A technician can
appropiate it by first selecting it in the available events list then clicking on the button Open.

The field Reponsible User will then contain his name. He fixes the problem and then clicks on the butoon Close
to close the event. If he doesn't close the request directly, he can obtain the list of his opened requests thanks to
the menu: CRM & SRM > Helpdesk > All Cases > My Cases

2. A customer asks for information to the salesman (sales opportunity)

The salesman then creates his own event via his menu option: Sales Management > Business Opportunities. He
opens the event with his name by clicking on the button 'Open'. He encodes the estimated income and chances of
success. That allows the sales manager to analyze the future sales forecast thanks to 'Sales Pipeline'.

He then recontacts the customer to make him a proposal. While waiting for the customer answer, he is able to
work for other customers and open other events. At any time, he can obtain his pending events list via his menu:
Sales Management > Business Opportunities > My Business Opportunities.

If he leaves for vacation, he can requeue his events in the available events list thanks to the button 'requeue'.
Other salesmen can easily take over because all the events and customer information are linked to the case.
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Partners events

The third tab of partner feature centralizes all relating information to this partner. That can be the receipt of an
email, a phone call, the order confirmation, theinvoice validation,... the advantage of this functionality is to obtain
all the partner history of the for a fast outline of the last communications.

Certain events can be manually encoded (telephone call), others are interfaced by XML-RPC (request coming
from a Web site, interface with Outlook) and others still are generated automatically by Tiny ERP. The automatic
events can come from several sources:

The 'email_interface' module is available on http://tinyforge.org allows automatically to interface
the important emails with Tiny ERP.

Case opening (commercial opportunity, request for support, require supplier),• 
Case closing,• 
Confirmation of a customer order,• 
Confirmation of an order supplier.• 

To activate and/or deactivate sources of partners events, use the menu: CRM & SRM > Definitions > Active
Partners Events. Then reverse simply 'active' field. That allows to select information which you wish to obtain on
a partner feature and not to put the other data not to overload the feature.
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Settings of the CRM module

Minds states

The minds states allow to define a value scale which represents the partner mentality in relation to our services.
To define the scale of the minds states, use the menu: CRM & SRM > Definitions > Minds states. The scale has
to be created with a factor for each level from 0 (Very dissatisfied) to 10 (Extremely satisfied). This scale is to be
considered according to your policy customers. Thus, if a dissatisfied customer have much weight in your
company, the difference between the average state of mind and the dissatisfied state has to be be important.
Proceed in the same way for the satisfied customers.

Here an example of value scale:

Extremely dissatisfied: 0,5• 
Dissatisfied: 3• 
Not very Satisfied: 5• 
Satisfied: 8• 
Extremely Satisfied: 9• 

Segmentations rules can be developed according to the mind state. Here is an example:

  A wholesaler for butcheries has a sale cycle for his customers of on 5 days average. If a customer didn't buy anymore since 3 to 5 days cycles (15 days), that maybe he supplies in another supplier. We configure module CRM so its mind state is multiplied by the 0,8 all 3 cycles without contact with this customer. Then the segmentation rule assigns with a 'Customers to recontact' category all the customers having a mindstatelower than 4,3. The sales manager can send an automated mailing pack each week with the customers to recontact. 

To define a segmentation rule, use the menu: CRM/SRM and support > Definitions > Segmentation rules. These
rules automatically allow to allocate the partners to a given category. You must give the criteria which allow to
evaluate which must be associated this category.
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Canals

The canals represent the different communication modesavailable with the customer. With each commercial
opportunity, you can indicate the canall which is this opportunity source. To define the company canals, use the
menu: CRM & SRM > Definitions > Canals.

Here an example of canals definition:

Web site Tiny ERP.Com• 
Web site Auction-in-Europe.com• 
Telephone• 
E-mail• 
Salor or Meeting• 

The canals are mainly used for analyses on the sales according to the origin.

The partners titles and contacts

The partners titles and contacts are defined via the same menu: Partners > Definitions > Titles. Only the title type
allows to determine whether it is a partner or a contact. The following table presents an example of titles
definition.
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Title Name Shortcut Type
S.A.R.L. sarl Partner
S.A. sa Partner
E.U.R.L eurl Partner
Mister Mr. Contact
Miss Mme. Contact

Cases types

For reminds, the cases can be of three types: commercial opportunities, request for support, requires to a supplier.
For each one of these cases types, you can define categories via the menu: CRM & SRM > Definitions > case
types.

The following table gives a definition example of the cases categories:

Category Case type
Harware problem Support
Unknown Support
Bad software use Support
Website Support
Request Tiny ERP Vente
Intervention website Vente
Complaint Supplier
Looking forward merchandise Supplier

Partners events

The third tab of the partner feature centralizes all types of associated events: the sales, opportunities, the
purchases, etc. You can define the events which have to appear on this tab thanks to the menu: CRM & SRM >
Definitions > Partners Events Active.

Select events to activate or deactivate.

The deactivated events aren't visible anymore by default, don't forget to specify in research
'Active=No' if you wish to find them.
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Technical data sheet

Basic functions

Opportunities management of sale and purchase• 
Helpdesk functions• 
Customers events management• 
Tasks planning• 
Commercial actions follow-up• 

Sales opportunities

Coûts et revenus estimés• 
Suivi des opportunités par client, par commercial, par secteur...• 
Planification, contrôle et ordonnancement des rendez-vous• 
Nombreux filtres possibles pour la recherche et l'analyse de données• 
Ré-attribution simple des opportunités (à un commercial, à un autre service, sur la queue)• 
Système d'alertes intégré• 
Historique des événements• 
Gestion des documents attachés• 
Intégration avec les formulaires web possible via XML-RPC• 

Helpdesk

Suivi et attribution des demandes• 
Classification des problèmes• 
Événements centralisés dans les fiches partenaires• 
Contrôle des heures prestées• 
Historique des interventions• 

Segmentations

Classification hiérarchique des partenaires avec héritage de droits• 
Classifications manuelles et/ou automatique• 
Segmentations automatisées basées sur 3 critères; vente, achat ou l'état d'esprit• 

Communication

Outil de publipostage• 
Envoi automatisé de SMS• 
Système de mass-mailing• 

Les événements

Événements clients automatisés ou manuels• 
Événements paramétrables• 
Filtres et recherches sur les événements• 
Outil de gestion des abonnements• 
Module �Audit Trail� de contrôle des actions des utilisateurs par ressource ou groupe• 
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Les contrats (via module des ventes)

Système de gestion des contrats clients et fournisseurs• 
Listes de prix flexibles• 

Les partenaires

Gestion centralisée de tous les contacts: clients, fournisseurs, prospects, employés, ...• 
Carnet d'adresse des contacts• 
Structure hiérarchique des sociétés• 
Module de gestion des relations complexes entre les partenaires• 

Devis (via module optionnel letter)

Module de rédaction de devis évolués, devis rédigés sous OpenOffice• 
Paramétrage des paragraphes• 

Les multi's

Multi-sociétés,groupes,utilisateurs• 
Multi-langues• 
Multi-canaux de communication• 

Ergonomie

Zoom rapide sur les fiches liées• 
Fonctions de 'click and relate' pour la navigation aisée• 
Auto-complétion des champs• 
Système de gestion des préférences des partenaires• 

Intégration

Intégration des événements en provenance d'emails (pop)• 
Intégration avec Outlook (iCAL)• 
Import / Export vers Excel pour les postes nomades• 
Devis en PDF ou sous Word (MS ou OpenOffice) pour modification• 
Intégration complète avec les autres modules; RH, Gestion de projets et tâches, ventes et achats• 

Rapport

Sales pipeline (prévision des ventes et coûts futurs)• 
Ventes mensuelles ou journalières, cumulées ou non• 
Module d'analyse de la productivité des utilisateurs; encodages, ventes, rendez-vous,...• 
Système de création de vos rapports personnalisés via OpenOffice.• 
Intégration avec Excel et Word• 

Flexibilité Totale

Tous les écrans sont personnalisables (saisies, listes, états, recherche...)• 
Gestion fine des droits et des menus par utilisateur• 
Adaptation possible de tous les processus de l'entreprise.• 
Accès à distance via Internet.• 
Configuration des processus et des alertes possibles.• 
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Système de requêtes intégré,• 
Extensible via de nombreux modules optionnels• 
Processus personnalisables (via workflows, BPM)• 
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Case tracking
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Introduction to the case tracker

This chapter is for version 3.5 only of Tiny ERP.

The Tiny ERP case and request tracker enables a group of people to intelligently and efficiently manage tasks,
issues, and requests. It manages key tasks such as communication, identification, prioritization, assignment,
resolution and notification.

Tiny ERP ensures that all cases are successfly tracked by users, customers and suppliers. It can automatically
send reminders, escalate the request, trigger specific methods and lots of others actions based on your enterprise
own rules.

The greatest thing about this system is that users don't need to do anything special. They can just send email to
the request tracker. Tiny ERP will take care of thanking them for their message, automatically routing it to the
appropriate staff, and making sure all future correspondence gets to the right place.

The case tracker is part of the CRM module and has a email gateway for the synchronisation interface between
mails and Tiny ERP.
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Tracking a case

To create a new case through the Tiny ERP client, you can go to the menu: CRM & SRM > All cases.

The top part of the first tab contains all generic information about the case. A simple description, the section of
the case, the category of case, the creation date and priority, an internal responsible and the email of your partner
that implied this case. You can also put the link to the partner and a contact of this partner.

The ID of the case is a unique identifiant that is assigned to this case after his creation. You can not change this
field. When you are creating the case, it is written 0 but when you will save it, the 0 will transforms to the next
available number.

Cases are classified within the differents sections of your entreprise. Ususally, sections are defined according to
the structure of your company: support, sales, buyers, eso. The sections are structured in trees, like the above
example.
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In Tiny ERP, all different type of cases (technical support, sales, ...) are classified in different sections but uses
the same case form. This is very interresting as you can redirect a support issue to the sale department simply by
changing the section field. There is no retranscription or conversion.

The top of the first tab of the case form includes all data that may change when the case resolution evolves. The
description field contains description of the latest action made for this case, by a partner or by an internal user.
The state of mind field represent the mind (happy or not) of the partner.

The channel field is used to report the communication channel that have been used for this action: request from
the website, email communication, direct phone call, meeting, eso. This is especially interresting for
multi-channel statistics.

The user can also fill in the date of the next action so that he can track forth coming actions or tasks. Each time
you process an action for this case, you can press one of these two buttons:

Silent process: record the action but do not send anything to the partner. You can use this button to record
private comments.

• 

Reply and Process: process the action written in description and send it by email to the partner using the
email provided by the field 'Partner Email'.

• 

Please note that these buttons are not visible while the case is not open or pending. So you have to open a case
before working for it.

A case may be in different states:

Draft : A draft case is a case that have been requested / created but for which no responsible has started to
work nor is assigned to this case.

• 

Open : When you start working or accept a case, the case is open. That means that the case have to be
processed within a reasonable time.

• 

Pending : A pending case is a case that is waiting for the answer of the requestor.• 
Close : When a case is succesfully finnished, it is in the 'Close' state.• 
Cancel : When a case is finnished without success (refused, never closed, ...) it is in the Cancel state.• 

To change the state of the case, you can use buttons on the bottom right of the screen.

In the second tab of the screen, you can write all references needed to rightfully process this case: closing date,
two references to others ressources, planned costs and revenue for sales cases and the probability of succeed of
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this case.

You can also assign watchers to the case. These watchers will automatically receive copy of all emails sent or
received for this case. Write all email addresses separated by a comma. The latest email field contains the body of
the latest email sent. It is used to send reminders to the partner or the user when needed.

In the third tab of the case, you can get the complete history of the case lifecycle.
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Defining Rules

The case tracking system of Tiny ERP has a builtin rule engine to help you automate recurring tasks like sending
reminders after some days, prioritize the case based on the partner category, routing the case to the right person or
section, sending automatic questions to the customer, eso.

To create a new rule, go to the menu: CRM & SRM > Definitions > Cases > Rules.

You have to write a name for the rule and you can active or not a rule. If a rule is desactivated, it has no impact on
futur cases.

The first part of the rules consist in a series of criterions to compute if the rule have to be applied or not. All rules
are evaluated after each user actions.

You can provide different criterions:

State From: Applies the rule if the state was in this state before the action.• 
State To: applies the rule if the state arrive in this state after the action.• 
Section: Applies the rule only if the case is in the provided section,• 
Category: Applies the rule if the case is in the provided category• 
Responsible: Applies the rule if the internal responsible match the provided user,• 
Priority Min: applies the rule if the case priority is equal or bigger the provided one,• 
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Priority Max: applies the rule if the case priority is equel or lower than the provided one,• 
Partner: applies the rule only if the case is attached to the provided partner,• 
Partner Category: applies the rule if the partner attached in the case is in the provided category of
partners,

• 

Trigger Date and hours: is used to launch actions in the futur.• 

If you provide several criterions, they all have to be valid to process the rules' actions. The actions to process are
given by the second part of the form named 'Rule Actions'. All the actions are computed on the case.

Set State To: set the case state to this new value,• 
Set Section To: move the state to the following section,• 
Set Responsible To: Assign the state to the provided user,• 
Set priority To: Change the priority of the state,• 
Add these watchers: Add the comma separated email list of watchers to the case,• 
Remind Partner: send an email reminder to the partner using the latest email sent ,• 
Remind Responsible: send an email reminder to the responsible using the latest email sent.• 

Developpers may also develop their own python method on the case object (using inheritancy) and provide this
method in the 'Call Object Method' field.

In the second tab of the rule, you can also provide an automatic email that will be sent to the list of destinators
you checked: responsible, partner, watcher or static emails.

Each time an email is sent, the case ID is added between bracket in the subject of the mail. To quickly go to a
provided case ID, you can search for it or use the shortcut CTRL ^G.

Rules may be executed in cascade. For example, the result of a rule (changing the state to open) may trigger
another rule (assign all open cases). They are executed in the order provided by the sequence field.

Examples of rules

Here are a few examples of rules usage.

Better priority for gold customers

Some companies have different level of support contracts: bronze, silver, gold. Suppose you want to put higher
priority to all customers that have a gold support contract with you. The easiest way is to create categories for
partners for the different types of contract. Each time a partner sign a contract, you must assign the contract level
in his parter form.

Then you create the following criterions for your rule:

State From: /• 
State To: draft• 
Partner Category: Gold Partner• 
Section: Support Contract• 

With the following action:

Set Priority To: High• 

If you use the email gateway, that will be explained in the following section, do not forget to sort emails by
priority and then by date.
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Thanks customers for incoming sales requests

If you want to send an automatic email response for all incoming sales requests, you can create a rule with the
following criterions:

Section: Sales Department• 
State From: /• 
State To: draft• 

And for the action:

Set State To: open• 
Assign To: fp@tiny.be• 

And complete the second tab to write a mail to the partner. Here is an example of mail you can use:

  Hello %(partner_name), 

  We successfully received your request. A ticket have been asigned to track
  all communications between our two companies:
    Ticket ID: %(id)d 
    Subject: %(name)s  

  Your assigned contact for this request is:
    %(user_name)s 
    Phone: %(user_phone)s 
    Mail: %(user_mail)s 

  He will process your request and reply to you within the next 48 hours.
  Thanks for having contacting us,

  -- 
  The sales team.

Send automatic reminders

The buyer department often have to track complaints sent to suppliers. To problem is that suppliers do not often
replies within the required delay. You can then send automatic reminders to suppliers based on the priority of the
case.

So, create the following rule:

Section: Buyer Department• 
Priority: High• 
Trigger Date: Last Action Date• 
After X Days: 5• 

With this action:

Send reminder to the partner.• 

And eventually:

Set priority to: Highest.• 
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The Case - Email Gateway

Introduction

The email gateway allows your users to not do anything special within the Tiny ERP client. They can create,
assign or update cases by simply sending or receiving mails with their usual mail client (outlook, thunderbird,
evolution, ...).

The following schema represent the gateway action:

To better undertand the email gateway, lets imagine the following situation:

Example of usage:

A customer send an email to support@mycompany.com• 
The case is automatically created in Tiny ERP and some rules applies:

It's a gold partner, set priority of the case to high♦ 
The case is automatically open and assigned to a user♦ 
Tiny ERP automatically thanks the customer for his message♦ 
As the user is new in the company, the chief is added to watchers (CC)♦ 

• 

The user receive the email with the right priority and case number• 
If he forgot to reply within 48 hours, he gets a reminder by Tiny ERP• 
The user reply to the customer by email• 
Then Tiny ERP automatically updates the case:

The history is filled with the question and the answer,♦ 
The case evolved to the pending state because we are waiting a response♦ 
the response is automatically sent to all watchers♦ 

• 

If the customer replies, the case is reopened otherwise the state is closed after a few days.• 

And all these steps are made automatically by the mail wateway without using the Tiny ERP Client. So, this
implied no effort from the user or the partner.
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And, as everything is recorded in Tiny ERP, the user can go in the interface to perform powerfull actions:

If he has to go into hollidays, he reassign the unclosed cases,• 
He can get the complete history of the case or the partner,• 
He can automatically create a proposal based on a support request,• 
He can search for existing case with the same trouble,• 
He can track the history of actions for this partner, eso.• 

And the manager get all statistics he needs to improve their support process:

Average time between the creation of the case and his closing,• 
Number of cases closed by month per user and per section,• 
Analyse trends with case categories, eso.• 

Sending Commands to Tiny ERP by email

You can also send commands to Tiny ERP by email about a defined case. Only the user responsible of the case
can do this.

To do this, write your commands in the first lines of the message. Your commands must be on the form:

 Set-[ACTION] : [VALUE]

Where action define what you plan to modify and value the new value. Allowed actions and value are:

State : pending, close, cancel or open• 
Priority : 1-5 (1 = Highest, 5 = Lowest)• 
User: login or name of a Tiny ERP user which will be the new responsible of this case• 
Cost: the planned costs of this case• 
Revenue: the planned revenue of this case• 
Probability : the probability of succeed of this case (0-1)• 
Partner: the email of the new responsible on the partner side• 

For example, if you reply to the following message, you will set Emmanuel (ede) as the new responsible and set
the case as Pending because you are waiting for the confirmation of the partner.

 Set-User: ede
 Set-State : pending

 Hello Emmanuel,
 Here is a case you should take into account.
 Fabien

Automatic States

When a partner send an email about a case, this case is automatically set to:

draft if it is a new case• 
open if it is not in draft state, (either if it was closed or pending)• 

When the user replies to the partner, the case is set to close. (unless specified with Set-State: pending).

To be sure Tiny ERP will detect the associated case to a mail, do not remove the ID wich is between brackets in
the subject. This ID is automatically added by the mail gate when forwarding customers emails.
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Example for a support section

The following picture is an example of a support section using this system. In addition to the normal interactions
by email, the user can go to the Tiny ERP interface and process a series of actions at any level:

Prioritize the case,• 
Reassign to another user,• 
Escalate or forward to another section,• 
Statistics analysis,• 
Send reminders,• 
Assign watchers,• 
Create or redesign rules,• 
Get the list of open cases, ...• 

If a Tiny ERP user send a mail to a partner, the state is set as close or pending, depending on your configuration.
You can also create a rule to change this.
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Fault Tolerant

The eMAil gateway is fault tolerant for different reasons

If he can not reach the Tiny ERP server or if the connection crash, he will forward all emails to a default
email address provided with the -d argument.

• 

When you reply to an email (either from the partner or the user), the mail gateway has put a Reply-To
header with 2 emails: the final recipient and the support email address. So that there is always one mail
that is directly sent to the recipient. If the mail client does not support the 'Reply-To' feature, the gateway
detects that the recipient did not received a copy and send a copy to him.

• 

Installation

To benefit from the gateway usage, you have to install it. There is different methods available, depending on your
mail server. We will describe here a generic and simple method using the fetchmail program.

First you have to create an email address (POP3 or IMAP) for each section you plan to interface. Let's say you
created the address 'support@mycompany.com' with the following details:

POP Server: pop.mycompany.com• 
Login: support• 
Password: mypass• 

Then you have to choose a Tiny ERP user that will be used by the gateway to access the Tiny ERP server. Let's
say you will use this one:

User ID: 3• 
Password: admin• 

To get the ID of the user, open his form using the menu: Administration > Users > Users. Then note this Id
written at the bottom of the screen.

Finally, you need a case section that is created in Tiny ERP using this menu: CRM & SRM > Definitions > Cases
> Sections. Use the ID (better) of the case or his code. Let's say we will define the section with the code 'SSUP'.

After that, you must install fetchmail on the same machine of the Tiny ERP server. You wan download this
program through this website: http://fetchmail.berlios.de/ Then write a file named fetchmailrc that contains the
following rules:

 # fetchmailrc

 poll pop.mycompany.com proto pop3:
 username support password mypass mda "/path/to/terpmg/tinyerp-mailgate.py -u3 -padmin -ssupport -esupport@mycompany.com"

And run fetchmail:

 fetchmail -f fetchmailrc

When trying to run fetchmail for the first time, add -v to get all logging messages.

Each time you run fetchmail, it will download requests, dispatch them and update the case in Tiny ERP. You can
run fetchmail in background so that it check mails every 5 minutes using the -d 300 attribute. If you do not like
the 5 minute delay, consider integrating the tinyerp-mailgate program directly with your mail server.

If you want to receive requests by email, do not forget to create a rule that assign incoming messages to a given
user and verify that this user as an email address in Tiny ERP (through the address field).
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You must also ensure that a mail server able to send emails is configured in your server.
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Mail Gateway details

Requests

A central point to track:

Business Opportunities,• 
Supplier requests or complaints,• 
Support requests,• 
Helpdesk communication,• 
Internal tasks and issues.• 

Requests tracker

Submit, Assign, Prioritize, Escalate• 
Send reminders• 
Partner's state of mind analysis• 
Private comment not available to end-users• 
Powerfull search engine• 
Full history per request• 
Manage planned costs and revenues with probabilities• 
Multiples references to others ressources of Tiny ERP• 

Reporting

Trends analysis per section, user, partner and category• 
Compute graphs like the sales pipeline• 
Export everything to PDF• 
Complete integration with Ms. Excel or OOCalc form import and export.• 
Design your own report using the Tiyn ERP Open Office connector• 

Powerfull

Track multiple section sand companies within the same database, sharing some data and others not.• 
Design your tree relation map between sections• 
Configure everything through the Tiny ERP client• 
Rules configuration• 

Design your own rules to automate tasks such as:

send automatic emails,• 
escalation to another section,• 
route or reassign requests,• 
prioritization based on different criterions,• 
reminders with a powerfull time control system.• 
Design your own rules using python extensions.• 

Mail Gateway

All communications by email with automatic synchronisation• 
You can send commands to Tiny ERP by email:• 
close request, remind partner,• 
prioritize, escalate, reassign...• 
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Internationalisation

On login, Tiny ERP automatically detects which language each user prefers, so staff members can collaborate
even if they speak different languages.

You've got customers around the world. Tiny ERP lets you interact with them in their own language. Internally,
Tiny ERP converts all data to UnicodeTM, so you can respond to users in their native tongue, but work in yours.

Integrated

The tracker is integrated with others modules of Tiny ERP:• 
history in partners forms,• 
auto-complete timesheet,• 
create proposal based on requests,• 
mass-mailing and SMS support.• 
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Accountancy

TheTiny ERP accounting module covers the general accounting, analytical and budgetary. Accountancy is
managed in double-entry and multi-currencies. All accountancy is held in a currency by default but each account
and/or transaction can have a secondary currency.

Thanks to its complete integration and in real time with the other modules, in Tiny ERP, accountancy isn't simply
more a tool reporting but the heart of business management. Indeed, the countable actions influence on the
attitude of the other company. Thus, if the user account decides on blocking a customer account, that can have
direct influences on commercial management and the stock management.

Integration with the other modules also allows to limit the account work because most of the writings are
automatically generated. Indeed, the sales writings come from the invoices, which come itselves from the orders
form or the deliveries checks. That allows to avoid a double encoding, often error source.

Lastly, Tiny ERP has a strong link between the cost accounting, financial accountancy and all the other modules.
That allows a very useful control of the costs and incomes effective in many cases: projects financial follow-up,
management by business taking all the costs and incomes into account, (human resources, raw materials,
production cost),...

In this chapter the accountancy bases under Tiny ERP will be presented. But you will also find many concepts
interesting which don't exist in the traditional software accounting. To make mouth water, here there are:

The virtual plans allow to create account planswhich are automatically calculated on the real basis plan. It
is particularly interesting for the accountancy of which the account structure is imposed by the state. Out
that isn't always the company view which the financier would like to have. (by project rather than by job,
plans consolidated in real time�). With Tiny ERP, you can create plans as many as wish in financial
accountancy and the cost accounting. Then, use the reports crossed for very advanced reporting.

• 

In Tiny ERP, the fiscal years management is enough flexible to allow you to work on several years at the
same time: budgets at 3 years, states spanning to several years,...

• 

The tree accounts structure can be reorganized ad infinitum without requiring recacul data. You can thus
easily restructure your real plans or virtual during the year for better reflecting the company reality.

• 

It is also possible to install only the accounting module to use Tiny ERP like a simple accounting software,
without commercial management.
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Gestion du plan Comptable

A l'installation du logiciel, celui-ci est fourni avec le plan comptable par défaut. Pour installer le plan de compte
et les définitions des taxes correspondant à votre pays, installez le module l10n_XX. Où XX est le code pays en
deux lettres. Par exemple, pour obtenir le plan de compte français, installez le module l10n_fr.

Vous pouvez obtenir une vue du plan de compte grâce au menu: Comptabilité et Finances > Plans comptables >
Plans de compte général.

La structure du plan comptable est hiérarchique avec des comptes sous-totaux ou centralisateurs (appelés
"comptes vue"). Vous pouvez alors développer chaque compte pour parcourir les éléments qui vous intéressent.

Pour consulter les écritures d'un compte, il vous suffit de double-cliquer dessus. Vous pouvez également cliquer
sur l'icône imprimante après avoir sélectionné un ou plusieurs comptes. Le logiciel vous donne alors le choix
entre deux rapports;
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Impression du grand livre,• 
Impression des balances des comptes sélectionnés.• 

L'affichage du plan de compte peut prendre plusieurs secondes car Tiny ERP calcule en
temps réel les débits, crédits et balances pour chaque compte. Si vous désirez simplement
travailler dans le plan de compte sans les totaux, vous pouvez utiliser le menu Financial
Management > Charts > Accounts Charts > Fast Account Chart.

Définitions de comptes

Pour ajouter, modifier ou supprimer des comptes existant, utilisez le menu Comptabilité et Finances > Définitions
> Comptes généraux > Comptes. Pour modifier ou supprimer un compte, recherchez-le avec la loupe et ensuite
modifiez les champs qui vous intéressent.

Voici la signification des différents champs d'un compte;

Nom: Le nom du compte est multi-lingue, c'est pourquoi il y a un petit drapeau à droite du champ.
Indiquez ce que vous désirez comme nom de champ.

• 

Actif: Vous pouvez désactiver un compte, il ne sera alors plus visible dans le plan de compte, mais pourra
être réactivé par la suite.

• 

Type de Compte: Les types de comptes déterminent les comptes utilisables pour chaque journal. Par
défaut les types suivants sont disponibles; Vue, Compte à recevoir, Compte à payer, Compte de produit,
Compte de charge, Compte de taxe, Compte financier, Compte d'actif et Compte de capital. Vous pouvez

• 

 Définitions de comptes 80

18/09/06



1

également ajouter de nouveaux types via le menu: Comptabilité et finances > Définitions > Comptes
généraux > Types de compte. Utilisez le type 'Vue' pour les comptes qui ne servent qu'à structurer le plan
comptable et dans lesquels il ne peut y avoir d'écriture.
Code: le code du compte, il n'y a pas de limite sur le nombre de chiffres. Utilisez le code 0 pour tous les
comptes racines.

• 

Devise: la devise par défaut, secondaire, de ce compte.• 
Report à nouveau: détermine comment traiter ce compte et ses écritures lors de la clôture de fin d'année.
Quatre méthodes sont disponibles;

Solde: une écriture est générée pour que la balance du compte reste inchangée lors de la nouvelle
année fiscale (généralement utilisé pour les comptes bancaires).

♦ 

Aucun: le compte ne possède pas d'écriture lors de nouvelles années fiscales (généralement pour
les classes 6 et 7),

♦ 

Détail: l'ensemble des écritures sont conservées pour la nouvelle année fiscale,♦ 
Non réconcilié: seule les écritures non réconciliées sont préservées lors de nouvelles années
fiscales (généralement utilisé pour les comptes tiers).

♦ 

• 

Lettrage: détermine si l'on peut faire des réconciliations d'écritures sur ce compte.• 
Parents: détermine quels sont les comptes parents, pour la structure du plan comptable.• 
Taxes par défaut: quelles sont les taxes par défaut utilisées lors de ventes ou d'achats utilisant ce compte.
Cela permet de générer automatiquement les écritures de taxes lors d'encodage manuel dans un journal.

• 

Les plans virtuels

La structure du plan comptable est imposée par des règles légales en usage dans le pays concerné.
Malheureusement cette structure ne correspond généralement pas à la vue que le chef d'entreprise aimerait avoir
de son entreprise.

C'est pourquoi le concept de plans de compte virtuels a été introduit dans Tiny ERP. Ce concept permet, sans
effort supplémentaire, de gérer plusieurs plans comptables sur base des même écritures. Ainsi, le plan de compte
général peut être celui imposé par l'état et le chef d'entreprise peut alors créer autant de plans virtuels que
nécessaires, basés sur ce plan de compte général.

Pour créer un nouveau plan de compte, il vous faut créer un compte racine via le menu (Comptabilité et Finances
> Définitions > Comptes Généraux > Comptes). Pensez bien à mettre le champ code à '0' et le type de compte à
'Vue'. Ensuite vous pouvez composer votre structure en créant autant de compte de type vue que nécessaire.

Vérifiez votre structure virtuelle grâce au menu: Comptabilité et Finances > Plans comptables > Plans de compte
général.

Enfin, une fois la structure finalisée, il nous faut placer les comptes généraux qui nous intéressent dans notre
structure virtuelle. Pour ce faire, recherchez les comptes généraux et ajoutez vos comptes virtuels dans leur
champ 'Parents'.

Vous pouvez donc consulter votre plan de compte général mais également les plans virtuels qui donnent une autre
représentation de l'entreprise. Toutes les actions et les états disponibles sur les comptes généraux sont également
disponibles sur les plans de compte virtuels.

Enfin, vous pouvez également construire des plans de comptes virtuels basés sur d'autres plans de compte
virtuels. Cela donne une construction de second degré.

Vous pouvez également utiliser le concept des comptes virtuels pour créer des droits d'accès
réduit à certaines personnes ou certains magasins.
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Accounting journal

All the accountings transations have necessarily belong to an accounting journal. It's thus necessary to create at
least: a sale book (for the customers invoices), purchases journal (for the invoices suppliers), and a journal for
each case or bank count.

To consult, modify or create new journals, use the menu: Accountancy and finance > Definitions > Accounting
journals > Journals.

Just like the general accounts, the journals can be deactivated to not being visible anymore.

You have to associate a view each journal. The journal view indicates the fields which has to be visible and
necessary during the transactions seizure in this journal. The view also determines the order and the properties of
each field. For example, the 'Number extracted' field has to be visible during the seizure in a bank journal but not
in the other journals.

Before creating a new journal view, check if there isn't equivalent defined for another journal.
You will have to create a new view only for new journal types.

You can also create a sequence for each journal. This sequence gives the automatic classification of the
accounting records. Several newspapers can use the same sequence what allow you to define global numbering in
several journals.

The credits and flows accounts by default allow to automatically generate the opposite views of the transactions
in fast mode seized in a journal. For example, in a bank journal, it is wise to put the account banks associated with
credit and flow accounts by default what avoid you creating the opposite view for each entry.

A journal can be marked like centralizing. In that case, the opposite seized entries views wion't anymore be
specific to each entry but global for the journal and the period given. You will have a credit line and a debit
centralizing line for each centralizing journal.

Jounals rights management

Two controls can be done on the journlass in Tiny ERP: controls on the acounting accounts and the access
controls compared to the user groups. In addition to these controls, you can also apply all the rights management
which will be seen in the chapter on the administration.
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In order to avoid the seizure of bad accounting accounts in the transactions, you can place conditions on the
general accounts which can be used in a given journal. To do, it's necessary to list all the valid accounts in the
second 'Entry Controls' tab. If you don't encode anyaccount, Tiny ERP doesn't apply anycontrol to the entries. If
you list the accounts which can be used in a journal, Tiny ERP stops any writing which uses an account not listed.
This checking will be during the transaction saving.

This functionality is interesting to limit the seizure errors. Thus, in a bank journal you can limit the use of the
accounts only to this bank account and classes 1 to 5. That stops the user from seizing incorrect transations for
this journal.

In addition to control on the accounts, you can make controls on the users who have the right or not to work in
each journal. To do, fill in the user list groups having access to the journal in the 'Access Group' tab. The
principle is the same one as for the accounts; if no group is given, there is no control of the acess rights whereas if
groups are specified, the user have belong to at least one of these groups to work in this journal. The exellent
management of the user groups will be detailed in the chapter of administration.
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Invoices follow-up

The invoices proposition are automatically generated thanks to the orders form (purchases or sales). The user
doesn't have anymore whereas to correct and validate these propositions. But the invoices can also be encoded
with the hand without using an order form via the menu: Accountancy and Finances > Invoices Follow-up.

If you wish to obtain the invoices propostions list generated by Tiny ERP, you can use the menu: Accountancy
and finances > Invoices follow-up > Invoices customers > Outline. Ditto for the supplier menu for the purchase
invoices which weren't received and validated yet.

To encode a new invoice, it is necessary to fill the following fields;

Description: Simple invoice description, for more detailed description, you can use the notes on the third
tab.

• 

Currency: indicate the invoice currency.• 
Invoice type: Customer Invoice, Customer credit, Supplier Invoice, Supplier credit• 
Partner: When you indicate the partner, Tiny ERP automatically fills in the addresses delivery fieldsand
the associated third partner.

• 

Count Destination: the third account in which will be generated the writings of opposite writings sale
views. The field is automatically filled in thanks to the properties of partner feature.

• 

Analytical account: this optional field allows to generate the corresponding analytical writings when the
invoice is validated. An analytical sales journaland purchases must be defined, if you can't create the

• 

 Invoices follow-up 84

18/09/06



1

invoice.

The taxes are automatically calculated and put back on the invoice second tab from the taxes defined in each
invoice line. These taxes are global to all the lines and, can be added manually in a global way or by invoice line.
To calculate these taxes, you can:

Create an invoice• 
Click on the 'Compute' button.• 

For the suppliers invoices, it is sometimes more practical to encode the taxes in a global way at the
end of the page than by line. Thus don't indicate any tax in the invoice line and encode the total
taxes in the second tab.

As long as the invoice is in draft mode (or proposition, or outlines), no accounting entry is generated. This one
doesn't have any value. Once the invoice created, the invoice number and the associated transactions (in the
generaland analytical accountancy) are automatically generated.

The terms of invoice payment are put in the third tab. Those are automatically assigned according to the partner.
Think to put the terms of payment in the partner feature if you wish to use particular conditions by customer. If no
term of payment is assigned, Tiny ERP considers that it is cash payment.

In Tiny ERP, it is possible to cancel an invoice, to correct it and recreate it thereafter. To do, use the buttons in
bottom on the right of this form. You can also inhibit this functionality by modifying the process (workflow)
invoice.

InvoiceLines
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Accounting entries

Tiny ERP supports several methods for the entries seizure;

Fast seizure in a journal,• 
Seizure item by item,• 
Writings Models,• 
Subscriptions for the recurring writings,• 
Seized simplified for the case management.• 

Fast seizue

The fast seizure is the most effective method to encode writings in journal pack by newspaperjournal. There is
two available entries in the menu;

Accountancy and finance > Entries Seized > Fast Seized * Accountancy and finance > Entries seized >
Fast seized > Open Journals

• 

The first opens a window which makes it possible to select the journal and the period for the seizure. The second
is a shortcut to select among the opened periods and journals, containing writings already.

We will see two types of seizure writinggs journals: a bank journal and a sale book.

Fast seizure in a bank journal

We are encoding the partner payment. To do, click on the 'New' icon from a bank journal or cash.

The first field to encode is the extract date. By default, it automatically suggests the previous extract date.

The writing date format depends on your country, in France, use the following format;
23/12/06 You can also type only the day of the month (23) and Tiny ERP automatically fills
in the current month and the year.

Then, press the tabulation key to go to the following field. The Move field has to be blank because it
automatically will be created by Tiny ERP thanks to the sequence defined in the journal in progress. In the 'ref'
field, you can enter an internal reference of your choice, for example the number of the bank extract.
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The Extract field represents a whole of extracts (generally grouped on the same bank sheet). If you begin a new
sheet, press F1 to create a new extracts group. The starting balance is automatically calculated and you have to
give the balance of end page. That will make it possible to validate the extract thanks to the theoretical balance at
the page end which will be compared with the balance calculated by Tiny ERP. Thisextracts management is very
practical to very quickly check the encoding errors in the bank extracts. To obtain the list of all the sheets and to
check them, use the menu: Accountancy and finances > Periodic salaries > Bank statements.

In the account field, enter the code of the account or the first letters and push tab. Tiny ERP fills in automatically
the account name or opens a browser window if several choices are available for your entry. Start by selecting the
counterpart account of your bank extract, thus Tiny ERP can automatically generate the following writing line. If
it is a customer payment, choose for example account 40 - Main Receivables.

Then, if it's about a customer payment or supplier, enter the partner name in the 'Partner ref' box. The partner
choice automatically selectes the accounting account if you hadn't indicated it during the previous step.

The following field, 'Name', is obligatory and generally corresponds to the extract descriptionor its reference
number.

When your accounting entry is finished, press the Enter key to validate it. Tiny ERP then generates automatically
the counterpart which corresponds to the bank extract. If you are in a centralizing journal, all the writings will
generate their counterparts in only one centralizing line.

The two generated writings belong to the same account because they have both the same number in the column
'Move'. As a reminder, in the same voucher, the sum of the credits is equal to the sum of the debits.

Fast seizure in a sale book

Suppose now that you want to use Tiny ERP like a simple accounting software. We will see how encode the
writings in a sale book.

If you use the module of commercial management, you never will have to write your writings in the sales or
purchases journals because those are automatically generated by the invoices. The invoices themselves are
created by the delivery or orders form.

To manually encode your sales books , use the menu: Accountancy and finance > Entires seized > Fast seized .
Then choose your accounting period and a sales book .

The first writing to encode is the 7 class account(incomes). Indeed, the taxes writings will be automatically
generated thanks to the account definition which you use. Also the credit customer writing will be automatically
filled thanks to the preferences of the customer feature.

Begin by encoding the invoicing date , the internal reference and the 7 class account which you use, for example
"705 - Sale services". Enter then the name of the customer, the invoice short description and the sum duty-free net
owe in the 'Credit' field. Press then the key Enter to validate the writing, Tiny ERP then generates automatically
the counterparts for an accelerated seizure of the writings.

If you wish to add a sale line to the voucher, modify the tex line for a new account of 7 class and re-press Enter.
Tiny ERP then automatically recalcules the writings to the voucher remains weighted.
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Seized by item

If you wish encode the writings item by item, you can use the menu: Accountancy and finances > Accounting
writings seized> Seized by item. The item seizure can be done on several accounting periods and different
journals, item by item.

This form is generally used to consult the vouchers more than the encode. Indeed, the fast seizure is more
powerful because it generates the counterparts automatically what considerably accelerates the encodings and
avoids the errors.

To seize a voucher, start by selecting the journal and the period. Then, you have to encode each line of the item.
Once the finished item, click on the 'diskette' icon to save, but don't forget to check that the sum of the debits is
quite equal to the sum of the credits for all the lines of this item. If it is not the case, Tiny ERP automatically
generates compensation writings according to the item journal.

Search for writings

To seek writings, several solutions exist:

seek writings in a given account,• 
seek in a specific journal,• 
seek writings all merged journals and accounts.• 

To seek writings in a determined account, double click on an account in the plan of general account. The 80 last
writings are displayed on the screen. Click on the magnifying glass to seek a writing. Attention, your visibility is
reduced to the opened fiscal years, to seek writings in the files, use the menu: Accountancy and finances >
Accountings planes > Accountings old charts.

To seek writings during a journal and a given time, click on the magnifying glass when you are in the fast mode
writings seizure. Indicate your criteria (amount, account, date, reference, or partner) and press the button to
browse.

The simplest method to seek writings is to go to the menu: Accountancy and finances > Entries seized > Search
for writings. You can seek among all the ERP writings.
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For automatically seeking among the files of the previous fiscal years, put the field active to No
during the research.

Suscriptions

You can define subscriptions for the recurrent writings like the rent, the subscriptions invoices , etc. Tiny ERP
undertakes to generate automatically the vouchers. To encode a new subscription, use the menu: Accountancy
and finances > Entries seized > Entries subscriptions.

Once the defined subscriptions, you can generate all the writings preceding a given date (by default the current
date) via the menu: Accountancy and finances > Processings > Subscription writings. Tiny ERP then requires a
limit date on this side which all the subscriptions automatically will create the corresponding writings. By default,
it proposes the current date to you.

It is advised to use this menu at least once a month if you wish to use the subscriptions functionalities. In each
subscription, you can obtain the detail of the already generated writings.
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Periodics processings

Reconciliation

The reconciliation makes it possible to associate the payments entries to the invoices entries. There are a manual
method and an automatic method for the reconciliation. The two methods are accessible by the menu: Periodic
Accountancy and finances > Processings.

The automatic method requires to choose a power. This one indicates the writings number which can be
reconciled at the same time. Thus, a power of 5 will be able to reconcile 3 invoices with 2 payments. The more
you choose a raised power, the more the seeking time is long. You can also indicate an adjustment amount which
makes it possible to reconcile writings even if the credit sum isn't exactly equal to the debit sum: the difference
must be lower the adjustment given.

Example, if you make an automatic reconciliation with power 5 on account 40 (Main Receivable), with a possible
adjustment of 2 EUR, Tiny ERP can reconcile the following entries;

Writing Debit Credit
Invoice 3 45 EUR

Payment 12/3 25 EUR
Invoice 16 20 EUR

Payment 12/8 39 EUR

In this case, invoices 3 and 16 will be marked as being paid.

In certain cases, it's possible that Tiny ERP automatically doesn't detect payments/invoices associations. You can
then use the manual method. This one consists in seeking writings, generally by specifying a partner in the
research. Once the writings selected , click on the gears to execute the reconciliation. If there is a difference
between the debits and the credits, Tiny ERP requires information necessary to the adjustments writings.

In the automatic method as in the manual method, it is possible to make an adjustment writing. This new writing
generated by Tiny ERP allows to reconcile sums of credits and debits not equal. Generally, the counterpart of this
adjustment writing of adjustment has to be in a profit and loss account.

The reconciled writings cannot be modified anymore. However you can remove the reconciliation thanks to the
tool of the menu: Accountancy and finances > Periodics Processings > Cancel manual leterring.

Paiement d'une facture

Automatic management

In Tiny ERP, an invoice is said paid when the writings of this one are reconciled with the payments writings
corresponding. The simplest procedure for the invoices management(customers and/or suppliers) and their
payments is this one:

1. Encoding of the independently invoices, 2. Encoding of the independently payments, 3. Automatic
reconciliation via the Tiny ERP tool

Thus, the extracts encoding is done while following the order of the extracts received by the bank, independently
the fact that it is a supplier payment, a customer payment or a various operation. That allows a simple control,
sheet by sheet of all the extracxt accounts. This system also makespossible to keep count of the advances, the
payments in several times, the adjustments, etc.
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To mark the invoices as being paid, it is necessary to launch the automatic tool of reconciliation which will make
association between the payments and the invoices. Refer to the section on the reconciliation for more
information.

Manual management

For the users who don't wish to use the accountancy of Tiny ERP but which wish to mark the invoices as being
paid to be able to print the reminders, there is another method. Indeed, it is possible to select an invoice and to
mark it paid from its sheet. To do that, click on the gears when you are on an invoice feature and select Pay
Invoice.

Reminders

To print a clients account (remind), you have to select one or more partners and to click on the print icon. Then
choose the report named 'late Payments'.

You can select several partners, thanks to the debts field in progress, and to print the customers
account in mode lists in order to all print them in only once.

But Tiny ERP also supports a multilevel reminders method defining the reminders levels and to calculate each
day automatically or each week which are the letters to be sent to the customers. To do that, first you have to
define the reminders methods via the menu: Accountancy and finances > Definitions > Terms of payment >
Reminders.

Then, periodically you have to click on the menu: Periodic Accountancy and finances > Periodic Processngs >
Print the reminders. This one calculates and posts all the reminders automatically to be do. Don't forget to print
the pdf document which appears on the screen because when this launched system, Tiny ERP saved the writings
as being reminded and next the remind for these printed customers will be done only on the next level.
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It is preferable to launch the automatic reconciliation before doing a remind. That doesn't
have an influence on the amount due nor on the remind times but the customers account will
be expurgated because the reconciled writings won't be posted.

Subscriptions

For the recurring expenses such as the rent. It is possible to define subriscription writings in Tiny ERP. To do
that, each subscription must be defined via the menu: Accountancy finances > Entries accountings seizes >
Subscriptions.

You have to fill in the followings fields;

Departure date: Date of the first writing• 
Periods number: A writings number to generate• 
Period and Type Period: Determine the difference between each writing which in time will be generated,• 
Writing model: must be a valid voucher (credits sum = debits sum). You can create a new writing model
or re-use an existing model.

• 

When your subscription is defined, don't forget to click on the 'Compute' button. Tiny ERP then will
automatically generate the writings generation dates in the 'Subscriptions lines' section.
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Interated Flow

The accounting module being integrated into the other modules, it is important to make go up information such as
the invoices payments. Indeed, an order form can, according to the setting of this one, wait until an invoice is paid
to send the delevery orders of the parcels.

The following diagram shows the financial flow which accompanies each order.
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The invoices are created by the orders (purchases or sales) or can be encoded manually. On the basis of orders,
Tiny ERP creates automatically only invoices propositions (= invoices with the state draft). You need the manual
intervention of an accountant to validate an invoice.

When this one clicks on the 'Create invoice' button of an invoice proposition, this one will be generated. The user
can then print it to send it to the customer.

When it is validated, an sequential number is allocated and the entries corresponding are generated. You can
obtain the writings thanks to the second ionvoice tab.

The following phase is to pay this invoice. In Tiny ERP, that is done in two times:

Movements encoding of case or the accounts extracts,• 
Entries reconciliation of the invoice and the payment.• 

That is done in two times because an invoice always doesn't correspond to one and only one payment (advances
and balance payment, adjustment from a few hundreds, payment of several invoices in once,...). You need an
effective reconciliation system.

The user encodes payments thanks to the different writings seizure methods seen in the previous sections. Then, it
can either use the automatic reconciliation system or make a manual reconciliation.

Once the invoice writings reconciled with the payments writings, information goes up automatically with the
invoice. This one goes to the 'paid' state. If the invoice comes from an order form (customer or supplier), this one
is marked as paid and continues the operations according to its configuration.

This approach is very simple to deal with great amou of information because tou have to encode the payments
such as they arrive. The automatic reconciliation takes the responsibility to go to point the paid invoices and those
automatically make go up information until the orders.

If you use the seizure thanks to the management mode of case, the invoices are automatically reconciled in real
time.
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Budgets

Tiny ERP version 3.3 supports the budgets on the general account. These budgets can cover several fiscal years
and be modified at any moment or duplicated to fo a revision. To define a new budget, use the menu:
Accountancy and finances > Definitions > Budgets > Budget items.

Begin the seizure by encoding a name and a code in the first tab of your new budget. The budget can be done on
the products or the loads, choose the standard field consequently. Then, via the second tab, you can define the
equipments by period. For each period, you can define a quantity and/or an amount according to the currency by
default of the account plan.

It is also possible to create the different allocations over the fiscal year periods. To do that, click on the 'Distribute
button on the top of the 'Allocation' tab. A window opens requiring the fiscal year for which you wish to make a
budget, the quantities and the sum over this year. If you wish to make a budget which covers several fiscal years,
repeat several times the operation.

Once the generated allocations, you can manually modify them while double-clicking to see the allocations again
period periodically. Once the amounts periodically assigned, it is necessary to indicate the accounts for which one
makes this budget in the third tab. To do that, click on the Add button and made a multiple selection for the
different accounts which must be included in this budget. Once the three filled in tab, you can save your budget
thanks to the diskette icon.
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Edit a budget

To print a budget and to make achievements calculations, use the menu: Accountancy and finances > Print >
Budgets. Tiny ERP gives you the budgets available list.

Select one or more budgets and click on the print icon to publish it. The following figure gives an example of
budget produced by Tiny ERP.
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Analytic Accounting

Introduction

Since version 3.3.0, Tiny ERP has an analytical accounting completely integrated to the others modules. It can be
used to setup a business management, to break down the transactions by activities sectors or any other need for
detailed follow-up of the costs and profits.

Accounts definitions

To define new analytical accounts, use the menu: Accountings and finances > Definitions > Analytical Accounts
> Accounts. You have then to allocate a name to the new account and possibly a code. The parent account makes
it possible to define the hierarchical relation between the analytical accounts. An account can be explicitly
associated to a partner. You can also give validity dates for the analytical plan.

To display your analytical plans accounts, use the menu: Accountings and finances > Definitions > Analytical
Accounts > Diagram of the analytical accounts.
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If you use the analytical accounts to manage your support contracts, put validity dates at each plan. That makes it
possible to display them in red if the support contract is overwhelmed during the services attribution to this
contract.

Journals definitions

Just like the vouchers writings , the analytical writings are seized in an analytical journal. To define an analytical
journal, use the menu: Accountings and finances > Definitions > Accountings journals > Analytical journal.

If you wish to use the analytical accounts in an order form customer or supplier, it's important to at least create an
analytical njournal of the sales and an analytical journal of the expenses. If you forget one of the two journals,
you won't be able to validate the invoice and Tiny ERP will indicate an error message.

Writings
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If an analytical account is specified in an invoice, when this one is validated, the analytical writings will be
automatically generated. The analytical journal used is of sale type or purchase according to the invoice type. If
the invoice comes from a customer order or supplier, this one is automatically propagated on the invoice. This
facility allows to not create the analytical writings manually and to allow commercial or the purchaser to specify
the account in the order upstream.

You also can encode different analytical operations thanks to the menu: Accountings and finances > Entries
accounts seized > Analytical Accounts > Writings seized. Just like the general writings, you can also encode them
in a given journal via the menu: Accountings and finances > Entries accounts seized > Analytical accounts >
Jounal entries. The only difference between these two entrance points is that in the second second menu, the
analytical journal is given by default.

To break down a general writing from this one, when you are in seizure mode, fill in the Analytical "Analytical
breaking down" field of this one.

States

To obtain states on an analytical account, open the analytical plan accounts (in Financial Management - > Charts -
> Analytic Accounts Charts) and select several accounts. Click on the printing icon and Tiny ERP suggests four
different printings:

Analytical balance: allows to give the selected payments balances, those being grouped and being
breaking down by general accounts.

• 

Reversed analytical balance: allows to give the analytical writings distribution in comparison to the
general accounts.

• 

Large analytical book: allows to print the accounts and all their writings.• 
Holdings control: allows to print the balances of the general and analytical writings in order to check that
all the general writings were indeed broken down.

• 

Anamytical balance

When you choose to print the analytical balance, you have to indicate one period for which the balance will be
printed.
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Large analytical book

During the printng of the large analytical book you are invited to choose one period for the book edition.
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Accountings settings

Selection of the accounting module

Wile the installation of the software, it is important to select the accounts chartcorresponding to your country. To
do that, you have to install the corresponding module. Certain modules are in the basic distribution, others can be
downloaded on http://tinyforge.org.

The locations for different countries are in the named modules l10_XX, where XX are the code of the country.
Some examples of french accounts charts: l10n_simple, l10n_fr, l10n_be, l10n_qc. It is preferable to select the
good account module before the software installation. For more information on the module installation, consult
the section implemented.

Fiscals years

Then You have to define the fiscals years. Those can start or finish on any calendar date. To define one year
fiscal, use the menu: Accountings and finances > Definitions > fiscal Years.

Start by indicating the name and the code of the fiscal year. If you work in multi-companies mode, you have to
indicate the company to which this year corresponds. Then, indicate the depatures dates and end of the year.

The fiscal years make up periods, generally monthly or quarterly. You can encode the periods in the 'Periods'
section. To avoid encoding all periods of one year fiscal you can use one of the two 'Create monthly periods' or
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'Create 3 months periods' buttons �. Then, Tiny ERP calculates automatically the periods corresponding to the
definite dates.

The terms of payment

You can as many define terms of payment necessary in Tiny ERP. The terms of payment define the dates expires
for the payment of an invoice. To define of new terms of payment, use the menu: Accountings and finances >
Definitions > Period of payment > Terms of payment.

The above figure represents the following conditions:

35% cash payment,• 
the balance after 15 end days of month.• 

To define new terms of payment, start by giving a name to the conditions. The field description can be taken
again on the invoices, enter there a clear french description of the terms of payment.

Then, you have to give the different calculation lines of the terms, in the 'Calcul Mode' section.
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For each line you have to indicate a name. This one is given as a rough guide and doesn't have an effect on terms
calculation. The sequence field allows to define in which order the rules are evaluated.

The field value allows to calculate the amount to pay for this line:

Percent: The line corresponds to a percent of the total amount, the factor is given by the 'Amount' field.
This one has to take a value between 0.0 and 1.0.

• 

Value: A fixed value, given by the 'amount' field.• 
Balance: The balance remaining compared to the other lines.• 

Think to put the last calculation line to 'balance', to avoid any round error. This one must have the sequence most
raised to be evaluated in the last.

The last two fields allow to calculate the term of payment for this line. This extra time can be expressed in net
days or end days of month. For example, if you indicate 15 end days of month, Tiny ERP adds 15 days to the
current date and request the payment at the end of the month given by this calculated date.

After, You can allocate terms of payment to a partner thanks to the properties of the partner feature.

Levels of reminders

The levels of reminders allow to define the frequency of the automatic reminds customers. Those have nothing to
do with the terms of payment. They can thus be sent before or after the limit of payment.

To define levels of reminder, use the menu: Accountings and finances > Definitions > Payment terms >
Reminders. For each line of the reminder, you have to give the number of days in nets days or end days of month.
The description given for each level is displayed on the reminding letter.

Here a simple example of reminder customer:

30 Net days: Remind 1st Level• 
45 Net days: Remind 2nd Level• 
60 Net days: demand• 
75 Net days: Bailiff.• 

When you wish automatically to print the reminding letters, use the menu: Accountings and finances >
Processings > Print reminders.

Setup

Once the different setup defined, you have to adapt your accounts chart compared to the basic plan installed on
Tiny ERP. To do that, you can deactivate accounts and create the new ones via the menu: Accountings and
finances > Definitions > Generals Accounts > Accounts.

Make then in the same way for the accountings journal thanks to the menu: Accountings and finances >
Definitions > Accountings journals > Journals. In general, a voucher at least is defined and a journal associated
by case and account banks. You need also a book sales and a purchases journal.

If you want to use the analytical accouting, think to make in the same way for the analytical accounts and
journals. It's important to at least create an analytical journal for the sales and purchases, otherwise Tiny ERP
cannot generate the writings compared to the invoices automatically.

Departure writings

For the levellings of your different accounts, create a journal of the situation type. This one can be centralizing.
Encode writings for each account which has to be levelled in this journal. For this operation, use the menu:
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Accountings finances > Entries seized > Fast seized.
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Fiche Technique

Fonctions de base

Gestion du plan comptable général, analytique et auxiliaire.• 
Plans multi-niveaux, sans limitation sur les codes et les niveaux.• 
Gestion des comptes virtuels• 
Possibilité de travailler sur plusieurs exercices comptables en même temps.• 
Gestion des clôtures partielles.• 

Saisie d'écritures

5 modes de saisie des écritures: par pièce, saisie rapide en liste, formulaire point de vente, modèles
d'écritures et abonnements.

• 

Automatisation des contreparties et des taxes: par compte, par tiers ou par produit.• 
Pièces automatiquement créées grâce à l'intégration des autres modules de l'ERP.• 

Nombreux Automatismes

Libellé automatique, calcul de la TVA, calcul automatique de dates d'échéance, contreparties
automatiques, gestion des règlements tiers, équilibrages, appel et création de compte en saisie...

• 

Modèles d'écritures sur mesure.• 
Ergonomie 100% clavier.• 

Gestion des Tiers (partenaires)

Plans multi-niveaux sans limites.• 
Publipostages, automatisation d'envoi de SMS.• 
Rappels et conditions de paiement personnalisés et multi-niveaux.• 

Rapprochement

Pointage manuel des écritures bancaires.• 
Génération des écritures d'ajustement• 
Rapprochement automatique par compte ou en temps réel: 9 niveaux de calcul• 

Les multi's

Devises illimitées• 
Unités de mesures et conversions illimitées et automatisées• 
Multi-sociétés avec architectures• 
Multi-utilisateurs simultanés grâce au mode serveur / client.• 
Multi-plans comptables généraux et analytique• 
Gestion des doubles unités de mesure• 

Nombreux Contrôles

Gestion fine des droits grâce aux différents niveaux société / groupe / utilisateur / rôle.• 
Contrôle des écritures sur les comptes, les journaux ou les produits.• 
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Intégration des modules

Totalement intégrés aux autres modules de l'ERP: ventes, production, achats, projets, RH, ...• 
Gestion par affaire intégrée à la comptabilité analytique (avec timesheet)• 
Imputations générales et analytiques automatisées: mouvement de stock, production, prestations, ...• 
Plusieurs logiques de créations automatisées des factures.• 

Éditions

Balances, grands livres des comptes, journaux, échéanciers, rappels, ...• 
État préparatoire à la déclaration de TVA.• 
Bilans, comptes de résultat et soldes intermédiaires de gestion.• 
Déclarations intra-com et intra-stats.• 
États analytiques, budgétaires, états de reporting, contrôle de caisse.• 
Personnalisation et création de documents personnalisés grâce à l'intégration OpenOffice.• 

Comptabilité Analytique

Plans multi-niveaux analytiques et journaux illimités• 
Ventilation des écritures illimitées et automatisées selon de nombreux critères, reventilation possible.• 
Interrogations et éditions.• 
Système de contrôle des coûts, gestion par affaire et interaction avec les projets, les timesheet, les ventes
et achats et productions.

• 

Support des OD analytiques• 

Budget

Budgets illimités sur les produits, charges, stocks ou trésoreries• 
Assistant de création des dotations• 
États budgétaires• 

Flexibilité Totale

Tous les écrans sont personnalisables (saisies, listes, états, recherche...)• 
Gestion fine des droits et des menus par utilisateur• 
Accès à distance via Internet.• 
Configuration des processus et des alertes possibles.• 
Système de requêtes intégré.• 
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Human Ressources
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Les ressources humaines

Le module de gestion des ressources humaines de Tiny ERP version 3.3 permet de gérer:

les employés et leurs données,• 
les notes de frais,• 
les feuilles de présences,• 
un système de pointage automatisé,• 
gestion des prestations / timesheets.• 

De nombreux projets sont en cours de développement pour les ressources humaines dans Tiny ERP, les
prochaines versions comporteront probablement de nouvelles fonctionnalités spécifiques.

Gestion des employés

Commençons tout d'abord par la fiche des employés. Sur cet écran, vous pourrez définir le nom, l'adresse, le
nombre de jours de vacances, etc.

Toutes les informations essentielles relatives à l'employé se retrouvent sur cette fiche; son nom, la société pour
laquelle il travaille, son adresse, etc.
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Un champ vous permet aussi de définir l'utilisateur associé à l'employé. Ainsi certaines informations
s'auto-complèteront (notamment dans le système de gestion des prestations) dès la création d'un nouvel
enregistrement.

Les onglets suivants présentent les informations relatives aux congés et aux notes de frais liées à l'employé en
question.

Sur le premier onglet, le champs 'Unité de coût' est particulièrement intéressant puisqu'il permet d'imputer
automatiquement chacune des prestations de l'employé comme nous le verrons dans la section suivante.

Imputations comptables

Cet écran définit l'unité utilisée pour imputer correctement les heures de travail prestées par l'employé sur ses
différents projets.

Chaque champ est obligatoire et définit le nom de l'unité utilisée, le coût par unité, le facteur qui permet de
transformer l'unité actuelle en une unité de base et enfin le compte qui sera imputé. Toutes les transactions entrent
dans le journal analytique spécifié.

Dans l'exemple proposé, l'entreprise utilise comme unité la demi-heure de développement. L'employé qui passe
trois demi-heures de développement imputera le compte 600 à concurrence de 510 € car 3 × 170 = 510. Par contre
cette entrée comptera pour une heure et demie dans le rapport d'activité de l'empoyé car 3 × 0,5 = 1,5.

Congés

Dans le second onglet, on retrouve la liste des absences et congés qui ont été pris par l'employé. On retrouve ainsi
les dates de début et de fin, ainsi que le type d'absence (congés payés, congés de maternité, etc.).
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Notes de frais

Dans le troisième onglet, on peut retrouver la liste des notes de frais de l'employé. La date à laquelle la dépense a
été effectuée est présente sur ce formulaire tout comme un champ 'Note' permettant de spécifier les conditions
particulières qui peuvent s'appliquer.

N'oubliez pas que vous pouvez attacher des documents à des ressources (par exemple: attacher un
scan de la note de teinturier ou du ticket de restaurant).
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Gestion par affaire

Lorsque les ventes font intervenir des prestations de services et/ou de la production, il n'est pas toujours simple
d'avoir un contrôle efficace sur tous les coûts, les marges et les prestations. Que ce soit pour un client, un contrat
ou un projet, il est important de maîtriser les coûts par secteur ou par projet pour un bon pilotage de l'entreprise,
surtout lorsque l'on sait qu'un mauvais contrôle des coûts constitue 8% des causes de faillites de petites et
moyennes entreprises. (*ref)

Grâce à la flexibilité de Tiny ERP, toutes les opérations peuvent être centralisées dans la comptabilité analytique.
Cela permet au contrôleur de gestion d'être au coeur de l'entreprise et d'agir directement sur les processus pour
éviter les dérapages sur des projets critiques. La gestion par affaire permet de contrôler:

Les coûts de production,• 
Les coûts dus aux prestations des employés,• 
Les coûts des matières premières pour chaque affaire,• 
Les revenus générés par les ventes.• 

Ce mode de gestion est très utile pour:

éviter les dérapages de projet en contrôlant l'avancement, les coûts et les revenus;• 
ventiler les prestations des employés afin de dégager les centres de consommation de ressources;• 
suivre chaque employé pour analyser sa répartition du travail et sa rentabilité.• 

Qu'est-ce qu'une affaire ?

Une affaire sert à regrouper tous les coûts et revenus liés à une même activité. L'objectif du travail par affaire est
de déterminer la rentabilité de chaque activité, projet ou contrat.

Puisque les détails des prestations sont encodés dans une affaire, celle-ci est également utilisée pour la gestion des
contrats de support et pour vérifier que les prestations ne dépassent pas certaines limites. C'est très pratique pour
éviter les coûts non prévus dans des projets complexes.

Selon les secteurs d'activité, une affaire est parfois appellée projet, contrat ou production. On utilise aussi
fréquemment le terme anglais 'Timesheet' pour parler de la gestion par affaire. Dans Tiny ERP, une affaire est
implémentée par un compte analytique. Les coûts et revenus de l'affaire sont alors des entrées analytiques. Cette
représentation analytique des affaires est très intéressante car vous pouvez y appliquer toutes les opérations
disponibles en comptabilité: balances, grand livre, étude par journal, opérations diverses, budgets, ...

Si vous désirez adapter le vocabulaire de Tiny ERP pour qu'il coïncide avec les termes utilisés dans
votre secteur, il suffit d'exporter le fichier de traduction en .CSV, de le modifier et de le réimporter
dans le serveur. Vous pouvez alors utiliser vos propres termes sans modifier le logiciel.

Enfin, il ne faut pas confondre une affaire et un projet dans le module de gestion de projets. L'affaire, représentée
par un compte analytique sert à faire le suivi des coûts passés tandis que le projet est utile pour de la planification
et le suivi des tâches à réaliser. Ceux-ci sont cependant liés dans la définition du projet ce qui permet de faire le
suivi des coûts sur un projet.

Mise en route

Pour mettre en place une gestion par affaire, il faut au préalable créer un compte analytique pour chaque poste,
affaire ou travail. Ceux-ci peuvent être structurés en arbre; les coûts et revenus d'une affaire correspondent à la
somme de toutes les entrées analytiques ainsi que de tous ses comptes fils. Pour définir des comptes analytiques,
allez dans le menu; Comptabilité et Finances > Définitions > Comptes Analytiques > Comptes.
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La figure suivante réprésente la classification des affaires utilisée par la société Tiny;

Si une affaire est bornée dans le temps (ex: contrat de support annuel), vous pouvez mettre les dates de début et
de fin lors de la création du compte analytique. Lorsqu'un technicien essaie de travailler pour une affaire qui n'est
plus valide, celle-ci apparaîtra en rouge indiquant qu'il faut contacter le client pour un renouvellement de contrat.

Une fois les comptes analytiques créés, il faut créer les fiches employés, via le menu; Ressources Humaines >
Employés.

Deux champs sont importants pour créer la fiche employé;

Tiny ERP User: le lien vers l'utilisateur du système Tiny ERP.• 
Cost Unit; le coût des prestations, dépendant du salaire de l'employé.• 

La figure suivante présente un exemple de configuration des coûts des prestations pour un employé.
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Celle-ci indique que l'employé travaille à l'heure et que son coût horaire est de 30 EUR (*). Si d'autres employés
encodent à la journée, utilisez un facteur de 8 (sous l'hypothèse qu'une journée normale de travail est égale à 8h.)

N'oubliez pas de mettre le montant en négatif car c'est bien un coût et non un revenu.
Exemple: -30 EUR. Ce montant est exprimé dans la devise de base du plan de compte par
défaut.

Si vous utilisez le module de production, il faut également configurer les sections coûts et capacités des postes de
charges. La figure suivante en est un exemple;

Reportez-vous au chapitre sur la production pour plus d'informations sur les postes de charge.

Utilisation du système

Une fois les affaires, les employés et les postes de charges configurés, vous pouvez utiliser le système. Chaque
opération (une vente, une prestation, un achat, ...) va automatiquement créer des entrées analytiques dans le
compte correspondant à l'affaire. Il vous suffit ensuite d'utiliser les outils de reporting de la comptabilité
analytique pour suivre vos affaires:

historique des interventions,• 
détails des coûts et revenus,• 
ventilation des dépenses, ...• 

Les ventes vont créer des entrées positives dans l'affaire donnée par le champ "Centre de coûts/profits" du bon de
commande. Si cela n'a pas été fait au moment du bon de commande, l'affaire peut toujours être ajoutée ou
modifiée sur la facture, avant validation de celle-ci.

Les achats vont créer des entrées négatives dans l'affaire donnée par le champ "Centre de coûts/profits" de la
commande d'achat. Cela permet de prendre en compte le prix de matières premières pour chaque affaire. On peut
également corriger l'affaire lors de la réception de la facture fournisseur.
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Le coût des prestations des employés doit également être pris en compte pour chaque affaire. On demande donc
à chaque employé de compléter son timesheet en fin de journée. Il doit ventiler ses 8 heures par jour dans chaque
affaire via le menu: Ressources Humaines > Encodage des Heures > Mes heures > Mes heures du jour.

Il est conseillé de mettre le menu ci-dessus dans les raccourcis du menu de l'employé car cette
option sera utilisée chaque jour.

La figure suivante donne un exemple de répartition des heures prestées par un employé:

Si vous utilisez la gestion de projets, vous pouvez installer le module hr_timesheet_project qui
vous donnera la possibilité d'encoder automatiquement les prestations en fonction du travail
marqué dans les tâches et de la configuration du projet.

Les coûts de production sont déterminés à partir des ordres de fabrication, des gammes et de la configuration du
poste de charge. Vous trouverez plus d'informations dans le chapitre sur la production.

Enfin, vous pouvez également modifier manuellement des coûts et revenus grâce aux opérations diverses
analytiques. Pour ce faire, utilisez le menu: Comptabilité et Finances > Saisie des écritures comptables > Compte
Analytique > Saisie des écritures comptables.

Vérification des prestations

Pour contrôler les prestations des différents employés, plusieurs méthodes sont disponibles dans Tiny ERP: le
contrôle par projet, le contrôle par prestations, le rapport mensuel.

Le contrôle par projet est disponible via le plan de comptes analytiques via le menu: Comptabilité et Finances >
Plans Comptables > Schéma des comptes analytiques. Vous pouvez alors double-cliquer sur un compte pour
obtenir le détail de toutes les transactions: prestations, productions, ventes et achats. Utilisez alors la recherche
grâce à l'icône loupe pour rechercher des prestations spécifiques.

Le contrôle par prestation consiste à utiliser l'un des menus disponibles dans les ressources humaines pour
l'encodage des prestations: Ressources Humaines > Encodage des heures. Ce menu permet de ne rechercher que
les entrées concernant des prestations des employés. Utilisez également la loupe pour naviguer parmi les données.
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Le rapport mensuel permet de vérifier, mois par mois et employé par employé la ventilation des prestations
effectuées. Ce rapport est très intéressant pour vérifier qu'un employé encode bien ses 8 heures de prestation par
jour. Pour ce faire, cliquez sur le menu: Ressources Humaines > Encodage des heures > Imprimer les horaires.
Sélectionnez alors un employé et un mois, Tiny ERP génère alors le rapport des sommes par jour et par projet
pour la sélection donnée.

Les totaux par jour en rouge indiquent que l'employé a encodé trop d'heures prestées, les nombres en mauve
indiquent qu'il a encodé trop peu d'heures. Les nombres verts indiquent que les prestations du jour sont correctes.

Attention, il ne faut pas confondre le rapport d'impression d'un timesheet et les différents rapports disponibles sur
les pointages automatiques des employés. Le premier sert à ventiler les heures prestées sur les différents projets
tandis que le second permet de contrôler les présences/absences des employés.

Le contrôleur de gestion

Le contrôleur de gestion peut alors simplement consulter les plans de compte analytique pour une vue globale des
activités de l'entreprise par affaire via le menu: Comptabilité et Finances > Plans Comptables > Schéma des
comptes analytiques.

Pour obtenir le détail d'une affaire, vous avez deux possibilités:

double-cliquez sur le compte et vous obtenez le détail des entrées (coûts et revenus), vous pouvez alors
rechercher, modifier ou ajouter de nouvelles lignes.

• 

cliquez sur l'icône 'imprimante' pour obtenir plusieurs rapports au choix.• 

La figure suivante présente une balance analytique et une balance analytique inversée sur un contrat de support
annuel avec des entrées comprenant des prestations, un remplacement de disque dur (facturé) et un déplacement.
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Grâce à cette fonctionnalité intégrée dans Tiny ERP, le contrôle de gestion n'est plus un poste à part de
l'entreprise dédié au reporting mais devient un vrai acteur de l'entreprise qui pourra influencer la stratégie de
l'entreprise mais aussi les affaires en temps réel.
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Pointage des affaires

Lorsqu'un employé travaille sur plusieurs affaires dans une même journée, il n'est pas toujours facile de remplir le
timesheet progressivement ou en fin de journée. On a vite fait d'oublier un coup de téléphone, une réponse à un
mail de support ou autre. Or, pour certaines entreprises, l'exactitude du timesheet peut être très importante. En
effet, celui-ci peut servir pour comptabiliser les heures de support pour un client, ou même pour facturer à la
prestation. Dans ce cas, un oubli représente donc directement des prestations non facturées.

Depuis la version 3.3, un système de pointage a été introduit dans Tiny ERP. Celui-ci permet de ne pas saisir les
temps mais simplement de pointer chaque jour lorsque l'utilisateur entre dans la société, change d'activité et quitte
la société. Ces pointages sont associés à des affaires pour automatiquement générer les prestations
correspondantes.

Les avantages d'utiliser les pointages plutôt que les timesheets sont:

Un résultat plus précis, avec moins d'oubli et sans trous,• 
La possibilité de déterminer les fiches de présence exactes,• 
Un système temps réel qui limite l'effort d'encodage.• 

Définitions

Pour utiliser les pointages par affaire, il faut que le module 'hr_timesheet' soit installé. Si vous utilisez
l'installation par défaut du logiciel, il est probablement déjà installé. Si vous n'installez que le module 'HR', un
système de pointage est également disponible mais celui-ci ne fait que les entrées et sorties, pas la répartition par
affaire.

Pour paramétrer le système, deux champs doivent être complétés dans la fiche employé: l'unité de coût,
l'utilisateur associé à l'employé et le groupe de travail. La première, expliquée dans la section précédente, indique
le coût horaire de l'employé. L'utilisateur permet de faire le lien entre l'utilisateur qui va pointer et l'employé qui
correspond à cet utilisateur. Le groupe de travail permet d'indiquer la feuille de présence théorique de l'employé.
Ceci permet de comparer le théorique du réellement presté grâce aux différents rapports vu en fin de chapitre.

Les équipes de travail sont définies via le menu: Ressources Humaines > Définitions > Groupes de Travail. La
figure suivante représente une répartition classique de 38 heures par semaine, du lundi au vendredi.
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Utilisation

Lorsqu'un utilisateur arrive le matin dans l'entreprise, il commence par cliquer sur le menu: Ressources Humaines
> Pointage. L'écran lui permettant d'indiquer qu'il vient d'arriver s'ouvre alors.

L'utilisateur clique alors simplement sur le bouton 'Start Working' en laissant le champ 'date de départ' vide. Tiny
ERP enregistrera alors la date indiquée sur le serveur pour le pointage. La date du client sur lequel se trouve
l'utilisateur n'a pas d'effet ce qui permet d'encoder l'arrivée dans l'entreprise sur un poste et de noter la sortie ou le
changement d'activité sur d'autres postes sans erreurs de configuration de dates.

Notez que l'utilisateur a la possibilité d'indiquer une date et heure antérieures, si par erreur il a oublié d'encoder
son arrivée dans l'entreprise. Cela permet de régler facilement des petits oublis. Bien sûr, le responsable des
ressources humaines possède un rapport qui montre les écarts entre les heures encodées (si elles ont été forcées) et
les heures réelles d'encodage. Cela permet d'éviter toute triche de la part des employés mais leur permet
également de modifier des oublis d'encodage.
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Pensez à mettre le menu Pointage dans vos raccourcis car il sera utilisé tous les jours.

Ensuite, l'utilisateur commence à travailler sur une affaire. Lorsque celui-ci doit changer d'affaire (par exemple un
coup de téléphone), il lui suffit de recliquer sur ce menu. Si la fenêtre de départ n'a pas été fermée, Tiny ERP s'est
automatiquement positionné sur ce choix. L'écran permettant d'encoder une nouvelle activité s'ouvre alors.

Dans cet écran, l'utilisateur doit remplir l'affaire pour laquelle il vient de terminer son travail. Le champ
description permet une information libre quant au travail réalisé. Sur certains projets clients, il est parfois utile de
sortir un état des prestations réalisées pour le client (pour justifier un contrat de support, par exemple), veillez
dans ce cas à mettre une description suffisamment claire.

La date de clôture peut également être forcée si l'utilisateur a oublié de clôturer au préalable. Par exemple, si vous
vous connectez le matin et que vous obtenez cet écran-ci, indiquez la date à laquelle vous avez quitté l'entreprise
hier soir. Le responsable des ressources humaines peut voir l'écart entre les dates indiquées et réelles pour éviter
des triches ou erreurs trop fréquentes.

Le champ 'Minimum Analytic Amount' permet d'indiquer l'imputation minimale dans les coûts analytiques. Ainsi,
si vos contrats de support comptabilisent chaque prestation au quart d'heure, indiquez 0.25 dans cette case. Une
prestation de 33 minutes sera alors comptabilisée comme 3/4 d'heure. Les prestations enregistrées pour les fiches
de présence ne sont pas influencées par ce champ. Les présences de chaque employé seront donc exactes à la
seconde près.

Le montant des coûts analytiques minimum est généralement constant pour l'entreprise,
pensez alors à le mettre en valeur par défaut pour pour éviter de le réencoder à chaque fois.

Les Rapports

Les rapports disponibles sur les prestations sont de deux ordres: les rapports de coûts sur les affaires ou comptes
analytiques et les rapports de présence des employés. Quelques exemples d'état sur les affaires ont été donnés
dans la section précedente. Nous verrons donc ici les rapports de présence des employés.

Pour imprimer les présences d'un employé, sélectionner un ou plusieurs employés via le menu: Ressources
Humaines > Employés. Cliquez alors sur l'icône 'imprimante'. Tiny ERP vous propose alors 3 rapports: le détail
des entrées/sorties, la fiche hebdomadaire, la fiche mensuelle.
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La fiche de présence hebdomadaire pour un seul employé, après sélection des dates à imprimer:

La figure suivante présente la fiche de présence mensuelle pour une liste de plusieurs employés sélectionnés:
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Fiche Technique

Fonctions de base

Gestion des employés• 
Plan des horaires et absences• 
Suivi des prestations et de leurs coûts par affaire• 
Module de pointage• 

Les employés

Intégration avec les fonctions partenaires de Tiny ERP (SMS, mails, hiérarchie et contacts)• 
Unités de ventes et coûts• 
Horaire de travail• 
Régime salarial• 
Suivi des prestations• 
Gestion des préférences par utilisateur• 

Gestion des absences

Demandes d'absences et validations• 
Congés légaux et de l'entreprise pris en compte• 

Notes de frais

Introduction des notes de frais• 
Validation par un responsable• 

Présences

Mécanisme de pointage• 
Interface possible en XML-RPC• 

Gestion par affaire

Intégrée à la comptabilité analytique pour le suivi des coûts salariaux par projet client.• 
Import automatique des prestations grâce aux travaux effectués sur les tâches• 
Plusieurs unités de mesure possibles (senior developper day, junior developper hour, ...)• 
Nombreux états de la compabilité analytique pour l'analyse des coûts et revenus par projet• 

Traçabilité

Traçabilité par utilisateur sur tous les documents de l'ERP• 
Module d'audit trail pour le contrôle et le reporting fin des opérations des utilisateurs• 

Rapports

Module d'analyse de la productivité des utilisateurs• 
Rapport détaillé sur les présences d'un employé• 
Feuille de présence par semaine ou par mois.• 
Ventilation des heures effectives par affaire sur le mois.• 
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Flexibilité Totale

Tous les écrans sont personnalisables (saisies, listes, états, recherche...)• 
Gestion fine des droits et des menus par utilisateur• 
Adaptation possible de tous les processus de l'entreprise• 
Accès à distance via Internet• 
Configuration des procesus et des alertes possibles• 
Système de requêtes intégré• 
Extensible via de nombreux modules optionnels• 
Processus personnalisables• 
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Les produits

Qu'est-ce qu'un produit ?

Un produit dans Tiny ERP est quelque chose que vous pouvez produire, stocker, vendre ou acheter. Les produits
ont différentes caractéristiques telles qu'un prix, des fournisseurs, des codes produits, etc. Les principaux
exemples de produits sont:

les articles gérés de stock• 
les services• 
les consommables• 
les ressources• 

Le premier exemple est de type "Stockable", tandis que les trois derniers types sont marqués non stockables ou
services. Selon leurs caractéristiques, les produits se comportent différemment. Par exemple, la livraison en
produits stockables dépendra de l'état des différents stocks et entrepôts. Par contre, un besoin en produits de type
"Service" peut engendrer des tâches à réaliser dans la gestion de projets.

Dans Tiny ERP, les produits peuvent également avoir plusieurs variantes, qui déclinent le produit en différentes
instances qui diffèrent par seulement quelques caractéristiques. Le produit générique est appelé gabarit ou
template de produit et la variante est le produit qui sera vendu ou acheté. Par exemple, un template de produit
peut être un t-shirt et les différentes variantes peuvent être la couleur rouge, la taille XL ou même le grammage du
textile.

 Les produits 125

18/09/06



1

Les catégories de produits

Les produits sont structurés en différentes catégories. Ces catégories servent à définir des groupes et sous-groupes
permettant d'attribuer des fonctionnalités ou propriétés à un ensemble de produits. Grâce aux catégories, il est
ainsi possible de définir les préférences comptables pour tout un ensemble de produits, d'appliquer une promotion
ou une règle de calcul du prix sur la catégorie entière ou de générer des états statistiques par groupe de produits.

Comme de nombreux documents de Tiny ERP, les catégories sont structurées hiérarchiquement. Ceci permet
d'appliquer des propriétés à différents niveaux de la structure des catégories de produits. Pour consulter les
catégories, utilisez le menu: Produits > Catégories de Produits.

La figure ci-dessus présente une structure simple de catégories de produits. Vous pouvez alors double-cliquer sur
une catégorie pour obtenir la liste de tous les produits appartenant à celle-ci.

Pour définir une nouvelle catégorie ou éditer une catégorie existante, utilisez le menu: Produits > Définitions >
Catégories de Produits.

Le champ 'Catégorie Parent' permet de définir la relation d'arbre entre les différentes catégories. Si vous modifiez
la valeur de ce champ, la catégorie ainsi que toutes ses sous-catégories seront déplacées dans un autre
emplacement de la hiérarchie.

Les comptes de valorisation de stock pour chaque produit peuvent être définis par produit ou pour tout une
catégorie de produits. Pour ce faire, sélectionnez une catégorie et cliquez sur l'icône 'propriétés'. Vous pourrez
alors indiquer les comptes généraux de valorisation de stock pour les produits de cette catégorie. Si un produit a
redéfini ses comptes, ceux-ci prendront priorité sur ceux définis dans la catégorie pour ce produit.
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La fiche produit

Les unités de mesure

Tiny ERP peut gérer les produits sous plusieurs unités de mesure. Les unités de mesure qui appartiennent à la
même catégorie d'unité de mesure peuvent être converties entre elles. Ainsi, dans la catégorie 'Longueur' on peut
retrouver les unités de mètre, centimètre et kilomètre. La conversion entre ces différentes unités n'implique pas
d'opération car elles appartiennent à la même catégorie, ce n'est qu'une question d'appellation.

Il convient donc au préalable de définir les catégories d'unité de mesure via le menu: Produits > Définitions >
Unités de mesure > Catégories d'unités. Ensuite, vous pouvez définir les unités grâce au menu: Produits >
Définitions > Unités de mesure > Unités de mesure.

L'écran suivant présente la définition d'une unité de mesure:

Dans la définition de l'unité de mesure, le champ 'Facteur' indique le facteur de conversion entre l'unité par défaut
de la catégorie et l'unité définie. Dans l'exemple ci-dessus, l'unité par défaut est le gramme, le facteur du
kilogramme est alors 1000. La précision d'arrondi indique la plus petite représentation de cette unité. Par
exemple, pour l'unité 'PIECE', un facteur de 1.0 indique que l'on ne pourra pas vendre des demi-pièces. L'unité de
vente comptable est simplement l'appellation qui doit apparaître sur les factures.

Sur la fiche produit, vous pouvez définir des unités de mesure par défaut à l'achat et à la vente/gestion de stock.
Ces définitions sont uniquement des valeurs par défaut car vous pouvez changer d'unité au moment de l'utilisation
du produit.

Par exemple, un industriel actif dans la bâtiment peut acheter le sable à la tonne mais le vendre au kilogramme.
Exceptionnellement, s'il achète son sable en urgence chez un autre fournisseur, il peut tout de même le
commander au kilogramme, ce n'est pas un problème pour Tiny ERP.

Les doubles unités de mesure

Tiny ERP est l'un des rares ERP capable de gérer de nombreuses unités de mesure mais surtout d'avoir une
gestion de stock en doubles unités. Cette fonctionnalité est un véritable atout pour certains secteurs car cela
permet de gérer simplement des problèmes qui peuvent être très complexes sur d'autres systèmes.

En plus des conversions possibles entre unités de mesure de la même catégorie, Tiny ERP peut tenir une gestion
de stock en doubles unités de mesure. Ces deux unités n'appartiennent pas nécessairement à la même catégorie et
il peut ne pas y avoir de relations directes entre ces unités.

L'une est généralement utilisée pour la gestion de stock, tandis que l'autre est utilisée pour la valorisation de stock
ou la facturation. Tous les mouvements de stock sont alors tenus en double unité.
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Dans Tiny ERP, l'unité de gestion de stock est appellée "Unité de mesure", tandis que l'unité de valorisation /
facturation est appellée "Unité de vente".

Exemple dans l'agro-alimentaire

Cette fonctionnalité est une nécessité dans le domaine de l'agro-alimentaire. En effet, lorsque vous achetez du
jambon en grandes surfaces, ce sont des paquets de jambons que vous achetez. La tenue de stock se fait alors au
paquet.

Une fois que vous arrivez à la caisse, le paquet est pesé et le montant à payer dépend alors du poids du jambon.
La seconde unité (le Kg) sert alors à la valorisation du produit. Il en est de même lorsque la grande surface achète
de la marchandise à son fournisseur: celui-ci livre des jambons entiers mais facturés en fonction du nombre de
kilogrammes livrés.

Toute la gestion de stock de l'entreprise doit alors se faire en double unité de mesure car elle doit connaître le
nombre de paquets de jambon disponibles en stock mais également le nombre de kilogrammes que cela représente
pour la valorisation de son inventaire. Il n'y a pas de relation directe entre un paquet et le poids car certains
paquets sont plus lourds que d'autres, chaque opération et chaque lot doit alors être tenu dans les deux unités.

Exemple pour un fabriquant de rouleaux de tissus

Prenons maintenant l'exemple d'un fabriquant de vêtements. Les produits sont fabriqués à base de tissus qui sont
disponibles en rouleaux. Il manipule donc son stock en nombre de rouleaux qui possèdent une certaine longueur
de tissu. Pour chaque rouleau, les tissus peuvent être consommés, ce qui diminue le nombre de mètres disponibles
sur un rouleau.

Dans cet exemple, la première unité de mesure sera le nombre de rouleaux. Dans cette catégorie d'unité de
mesure, on peut avoir plusieurs autres unités comme le pack de 3 rouleaux.

La seconde unité de mesure sera le nombre de mètres pour chaque rouleau. La plupart des rouleaux sont complets
et font 10 mètres de long. On a donc bien une gestion de stock au nombre de rouleau mais une valorisation de
stock au mètre. De même le coût de production d'une série de produits finis (5000 t-shirts) dépendra du nombre
de mètres utilisés pour cette série, et non du nombre de rouleaux.

Lors de la réception de nouveaux rouleaux, il faudra également indiquer le nombre de rouleaux reçus mais
également, pour chaque rouleau le nombre de mètres de tissus disponibles.

Tiny ERP est l'un des rare ERP suffisamment flexible pour gérer ces différentes situations avec autant de
simplicité.

Les unités logistiques

Les unités logistiques permettent d'indiquer les différents modes possibles de packaging pour un produit donné.
Elles sont principalement utilisées dans le domaine de la distribution. Par exemple, un produit peut être
conditionné de deux manières différentes:

livré par palette de 64 boîtes sur 4 couches, chaque boîte contenant 22 produits.• 
livré par cartons de 6 boîtes de 16 produits par boîte.• 

Les unités logistiques sont optionnelles et peuvent ne pas être utilisées par
l'entreprise.

La figure suivante présente un écran de description d'une unité logistique:

Les doubles unités de mesure 128

18/09/06



1

Les variantes

Tiny ERP est également capable de gérer les variantes de produits. Les variantes permettent de définir des
produits qui ne diffèrent que par quelques caractéristiques. Le produit générique avec toutes les caractéristiques
communes est défini par un template de produit et chaque variante avec ses spécificités peut être définie sur base
de ce produit générique.

A l'installation par défaut, une seule dimension de variante est disponible mais si vous
installez le module e-Commerce ou Fashion, vous avez la possibilité de gérer autant de
dimensions que nécessaire pour les matrices de variantes.

Prenons l'exemple du textile. Vous avez par exemple un produit 't-shirt'. Ce produit possède trois dimensions de
variantes:

la dimension couleur: rouge, vert, bleu, blanc, noir, jaune, gris chiné• 
la taille: S, M, L, XL, XXL• 
et le grammage du textile: 150gr/m2 ou 180gr/m2• 

Un exemple de produit fini est alors un 't-shirt blanc, XL, 180gr/m2'. D'autres systèmes ERP qui ne supportent
pas les variantes de produits possèdent alors une explosion du nombre de produits dans la base de données. En
effet, rien que pour ces t-shirts, cela donnerait 70 produits à définir.

L'avantage dans cette représentation est que chaque modification apportée au modèle est automatiquement
reportée sur toutes les variantes. De plus, la matrice des prix et les nomenclatures génériques peuvent être définies
une seule fois pour le modèle de produit avec les adaptations par variante.

Pour travailler avec des variantes, vous pouvez définir les modèles de produits grâce au menu: Produits > Produits
> Modèles. Les variantes sont définies par le menu: Produits > Produits > Variantes.

Si vous ne désirez pas utiliser le système de variantes, vous pouvez utiliser le menu: Produits > Produits. Cela
permet de définir en une seule opération le produit fini, c'est à dire son modèle et sa variante unique.

La fiche produit

La figure suivante présente le premier onglet de la fiche produit:
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Les champs 'Type de produit', 'Calcul des besoins' et 'Méthode d'approvisionnement' conditionnent la manière
dont un besoin de ce produit est traité. Vous trouverez plus d'informations à ce sujet dans le chapitre sur les
approvisionnements.

Le prix tarif donne le prix catalogue de base. Il peut être différent du prix de vente, mais généralement il sert de
base au calcul du prix de vente. Nous verrons à la section suivante que le prix de vente est donné par les listes de
prix.

Le prix de revient, parfois appellé coût standard donne le prix auquel ce produit est valorisé dans la comptabilité.
Tiny ERP supporte plusieurs méthodes de valorisation des stocks, chaque produit peut être valorisé selon sa
propre méthode. La méthode du produit est donnée par le champ 'Méthode de coût', celui-ci peut-être: PRSTD
(prix standard), PMP (prix moyen pondéré) ou FIFO (first in first out).

Un produit peut avoir un responsable de produit. Celui-ci recevra des tâches ou requêtes selon certains
événements.

La figure suivante montre l'onglet 'Approvisionnement' de la fiche produit:
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Le délai de production et le délai fournisseur donnent le délai moyen pour s'approvisionner en ce produit. Ce
champ est très important car il conditionne toute la planification du moteur de calcul des besoins. Celui-ci sera vu
en détail dans le chapitre sur les approvisionnements.

Pour chaque produit, vous pouvez donner une liste de fournisseurs. Pour chaque fournisseur, il faut donner le
délai moyen de livraison et la quantité minimale à commander. Les fournisseurs sont triés par séquence et lors
d'un calcul automatisé d'approvisionnement, Tiny ERP suggère toujours le fournisseur par défaut, celui du dessus.

Le troisième onglet permet d'encoder des références produits et des noms de produits qui dépendent du partenaire.
Cela permet de gérer des références différentes chez des fournisseurs différents. De même, puisque les partenaires
peuvent également être des clients, vous pouvez livrer le même produit avec des références différentes par client
afin d'éviter qu'ils comparent leurs prix.

L'onglet 'Descriptions' permet d'encoder les trois descriptions du produit: interne, à la vente, et à l'achat. Ces
descriptions sont automatiquement reportées sur les bons de commande, ce qui permet de rappeller certaines
conditions ou de mettre automatiquement une description commerciale sur un devis.

Le dernier onglet permet d'encoder les différentes unités logistiques disponibles pour ce produit. Vous pouvez
également y indiquer s'il s'agit d'un produit à mesure fixe ou à mesure variable. Un produit à mesure variable est
par exemple un jambon, qui doit être repesé avant la livraison. Si la case suivi du lot de fabrication est cochée,
Tiny ERP imposera à l'utilisateur de mettre un numéro de lot de fabrication lors de la livraison ou de la
production.
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Les listes de prix

La gestion des prix n'est pas toujours simple d'une entreprise à l'autre. Chaque entreprise possède ses propres
règles pour la gestion des tarifs clients et fournisseurs; tarifs au client, ristournes en cascade, promotions
saisonnières, prix de vente basés sur le prix d'achat, etc. Elle est pourtant cruciale afin de bien intégrer toutes les
conditions clients et fournisseurs pour la saisie rapide de devis.

Cette gestion des prix dans Tiny ERP se fait grâce au système puissant de listes de prix. Les listes de prix
permettent d'encoder les prix de vente et d'achat d'un produit selon différentes conditions comme la période, la
quantité commandée, le type de produit, etc.

Il ne faut pas confondre prix de vente et prix de base du produit. En effet, dans la configuration de
base de Tiny ERP, le prix de vente est égal au prix de base marqué sur la fiche produit mais un
client peut avoir des prix de vente différents selon ses conditions. Idem pour le prix d'achat et le
coût standard.

Chaque liste de prix permet de calculer des conditions particulières sur les tarifs appliqués. On crée alors autant
de listes de prix que de politiques commerciales en vigueur dans l'entreprise. Par exemple, une entreprise qui
vend ses produits selon 3 canaux différents correspondants à différentes classes d'entreprises pourra créer les
listes de prix suivantes:

Grandes Distributions
Liste Spécifique Leclerc♦ 
Liste Spécifique Leclerc, Centrale de Paris♦ 

• 

Vente par Correspondance• 
Client Directs• 

Une liste de prix peut avoir plusieurs versions, dont une et une seule doit être active à un instant donné. Ces
versions permettent d'enregistrer les différents changements de tarifs dans le temps. Ainsi, la liste des clients
directs peut avoir 5 versions différentes, correspondant aux différentes saisons: automne, été, soldes d'été,
printemps, hiver. Selon la saison, les clients directs bénéficieront des tarifs adaptés.

Chaque liste de prix est exprimée dans une seule devise. Si votre entreprise vend ses produits dans plusieurs
devises, il faut créer autant de listes de prix que de devises concernées. Seulement, les tarifs d'une liste de prix
peuvent dépendre d'une autre liste, ce qui évite de redéfinir toutes les conditions de chaque produit. Ainsi la liste
de prix en EUR peut être basée sur la liste de prix en USD. Si le taux de change de la devise EUR change ou si le
prix en dollar change, le tarif en EUR sera automatiquement adapté.

Définir une nouvelle liste

Pour définir une nouvelle liste de prix, utilisez le menu: Produits > Listes de prix > Listes de prix.
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Pour chaque liste, il faut obligatoirement définir:

un nom explicite pour cette liste• 
un type de liste: vente pour les clients ou achat pour les fournisseurs• 
et la devise appliquée pour l'entièreté de cette liste• 

Si vous installez le module EDI, un troisième type de liste de prix apparaît; le prix de vente
consommateur qui définit le prix affiché pour le consommateur final qui n'est pas nécessairement
votre client.

Une fois la liste définie, il faut obligatoirement lui définir une version. Pour ce faire, utilisez le menu: Produits >
Listes de prix > Listes de prix Version. La version contient toutes les règles qui permettront de calculer le prix
pour un produit et une quantité donnée.
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Indiquez alors le nom de cette version. Si la liste ne possède qu'une seule version, vous pouvez utiliser le même
nom pour la version que pour la liste de prix. Dans le champ liste de prix, sélectionnez la liste que vous venez de
créer.

Pour éviter de définir une nouvelle liste et version en passant par deux menus, vous pouvez
commencer par la version et créer la liste automatiquement grâce à la relation 'Liste de Prix' dans la
version.

Indiquez ensuite les dates de début et de fin de cette version. Ces deux champs sont optionnels, si vous n'indiquez
aucune date la version sera toujours active. Dans la version 3.3.0 de Tiny ERP, les dates ne sont pas encore prise
en compte, pour activer ou désactiver une version de liste de prix, il faut utiliser le champ 'Actif' dans les
versions.

Une version de liste de prix est constituée d'un ensemble de règles qui s'appliquent sur les prix des produits.

La première partie de l'écran permet de définir si la règle est applicable pour un produit donné. La règle est
applicable pour le Template de produit et/ou la catégorie de produit indiquée. Puisque les catégories de produits
sont définies en arborescence structurée, si une règle est appliquée à une catégorie, elle l'est automatiquement
pour toutes les sous-catégories de celle-ci.

Si vous indiquez une quantité minimale, la règle ne sera applicable que pour une quantité suppérieure ou égale à
celle indiquée. Cela permet par exemple de faire des tarifs dégressifs par palier selon les quantités commandées.

Pour une même commande, plusieurs règles peuvent être d'application. Tiny ERP évalue alors les règles par
priorité afin de sélectionner laquelle il doit appliquer pour le calcul du prix demandé. Si plusieurs règles sont
applicables, seule la première est calculée. L'ordre d'application des règles est donné par le champ 'Priorité', de la
priorité la plus faible à la plus élevée.

Une fois qu'une règle est sélectionnée dans la liste, il faut ensuite déterminer comment calculer le tarif à partir de
cette règle. Cette opération est faite grâce aux critères de la partie inférieure du formulaire intitulée 'Calcul du
prix'.

Le premier champ à remplir est nommé 'Basé sur'. Vous devez y indiquer sur quel prix de base doit se baser le
prix de vente client. Vous avez le choix entre:

Le prix catalogue indiqué dans la fiche produit• 
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Le coût standard indiqué dans la fiche produit• 
Une autre liste de prix, celle-ci est donnée par le champ 'Base Price List'• 

Nous verrons dans la section suivante que d'autres critères peuvent être ajoutés à cette liste.

Ensuite, diverses opérations peuvent être appliquées sur ce prix de base pour calculer le prix de vente ou d'achat
pour le partenaire et la quantité donnée. Ce calcul est donné par la formule indiquée: New Price = Base Price (1 -
Champ1 ) + Champ2.

Le premier champ 'Champ1' indique donc une ristourne. Indiquez par exemple 0.20 pour une ristourne de 20%
par rapport au prix de base. Si votre prix est basé sur le coût standard vous pouvez indiquer -0.15 pour faire 15%
de bénéfice sur le prix de vente par rapport au coût standard.

Le Champ2 indique un supplément fixe exprimé dans la devise de la liste de prix. Ce montant est simplement
ajouté (ou déduit si négatif) au montant calculé avec ristourne du Champ1.

Ensuite, vous avez la possibilité de donner une méthode d'arrondi. Le calcul de l'arrondi se fait au nombre le plus
proche. Par exemple, si vous indiquez 0.05 dans cette case, un prix de 45.66 sera arrondi à 45.65. De même un
prix de 14567 arrondi à 100 donnera un prix de 14600.

Le supplément du Champ2 est appliqué après le calcul de l'arrondi ce qui permet des calculs intéressants. Par
exemple, si vous désirez que vos tarifs terminent tous par 9.99, faites un arrondi à 10 et un supplement dans le
Champ2 de -0.01.

Les marges minimum et maximum permettent de garantir une marge donnée par rapport au prix de base. Ainsi,
une marge de 10 EUR permet de vérifier que la ristourne ne descend pas en dessous de 10 EUR de marge. Si vous
laissez 0 dans ces champs, leur effet n'est pas pris en compte.

Une fois la liste de prix définie, vous pouvez l'attribuer à un partenaire. Pour ce faire, sélectionnez un partenaire et
cliquez sur l'icône 'Propriétés'. Vous pouvez alors changer la liste de prix de vente ou d'achat par défaut pour ce
partenaire.

Quelques Exemples

Pour les exemples qui suivent, supposons que les catégories de produits suivantes sont définies:

Tous les produits
Accessoires

Imprimantes◊ 
Scanners◊ 
Clavier et Souris◊ 

♦ 

Ordinateurs
Laptops

Laptops Wide-Screen⋅ 
◊ 

Ordinateurs
Ordinateurs de bureau⋅ 
Ordinateurs professionnels⋅ 

◊ 

♦ 

• 

Ansi que ces produits, définis dans la devise de base du plan comptable installé:

Produit Prix Catalogue Prix Standard Prix fournisseur par défaut
Laptop Acer 1200 887 893

Laptop Toshiba 1340 920 920
Clavier Cherry 100 50 50

Ordinateur Perso 1400 1000 1000
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La liste par défaut

A l'installation du logiciel, deux listes de prix sont créées par défaut: l'une pour les ventes, l'autre pour les achats.
Celles-ci ne possèdent qu'une version et qu'une ligne dans la version.

La ligne est configurée selon la figure suivante:

Le prix de vente est donc donné par le champ prix catalogue de la fiche produit. Aucune ristourne, supplément ou
arrondi n'est appliqué à ce prix. Cette règle est applicable pour tous les produits et toutes les catégories de produit
pour une quantité minimale de 1. L'effet est donc que le prix de vente d'un produit est donné par le prix catalogue
dans la fiche produit. Cela permet aux entreprises qui n'ont pas de besoin en liste de prix d'utiliser
automatiquement les prix indiqués dans la fiche produit sans utiliser de liste.

Une liste de prix pour les achats est également définie par défaut à l'installation du logiciel, celle-ci fournit
automatiquement le coût standard d'un produit lors de l'achat chez un fournisseur.

Une entreprise de négoce

Prenons maintenant le cas d'une entreprise de négoce pour laquelle nous allons définir ses prix de vente pour les
revendeurs comme suit:

  Pour les ordinateurs portables, les prix de vente sont calculés
  par rapport à la liste de prix du fournisseur ACER avec un supplément
  de 23% par rapport au coût d'achat. Pour tous les autres produits, le 
  prix de vente est donné par le coût standard de la fiche produit sur
  lequel on ajoute 31% et doit terminer par ",99". Enfin, le prix de 
  vente des claviers Cherry est fixé à 60 EUR pour une quantité
  minimale de 5 claviers achetés.

Supposons que la liste de prix ACER soit définie dans Tiny ERP, la liste de prix pour les revendeurs et sa version
possède alors trois lignes:

Ligne ACER:
Catégorie de produits: Laptops♦ 
Basé sur: Autre Lise de Prix♦ 
Liste de Prix: ACER Pricelist♦ 
Champ1: -0.23♦ 
Priority: 1♦ 

• 

Ligne Clavier Cherry:
Template de Produit: Clavier Cherry♦ 
Quantité Minimale: 5♦ 
Champ1: 1.0♦ 
Champ2: 60♦ 

• 
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Priority: 2♦ 
Ligne Autres produits

Basé sur: Standard Price♦ 
Champ1: -0.31♦ 
Champ2: -0.01♦ 
Arrondi: 1.0♦ 
Priorité: 3♦ 

• 

Dans cet exemple, il est important que la priorité de la deuxième règle soit inférieure à la priorité de la troisième
règle. Autrement, la troisième règle sera toujours d'application car une quantité de 5 est également supérieure à
une quantité de 1 pour tous les produits.

Notez également que pour fixer le prix à 60 EUR pour les 5 claviers Cherry, nous avons utilisé la formule: New
Price = Base Price * (1 - 1.0) + 60.

Conditions pour le client TinyAtWork

Supposons maintenant que notre société de négoce désire encoder les conditions particulières de son client
TinyAtWork. La société TinyAtWork possède un contrat valable un an avec les conditions suivantes:

 Pour les Laptops Toshiba TinyAtWork a une remise de 5% par rapport 
 aux tarifs revendeurs. Pour tous les autres produits elle bénéficie
 des conditions revendeurs telles quelles.

La liste de prix TinyAtWork possède donc deux règles:

Ligne Laptop Toshiba
Produit: Laptop Toshiba♦ 
Basé sur: Autre Liste de Prix♦ 
Liste de Prix: Prix Revendeurs♦ 
Champ1: 0.05♦ 
Priority: 1♦ 

• 

Ligne Autres Produits
Produit: Laptop Toshiba♦ 
Basé sur: Autre Liste de Prix♦ 
Liste de Prix: Prix Revendeurs♦ 
Priority: 2♦ 

• 

Une fois cette liste encodée, il faut aller rechercher la fiche partenaire de la société TinyAtWork. Cliquez ensuite
sur l'icône 'Propriétés' pour mettre le champ 'Liste de prix de vente' à 'Ligne Laptop Toshiba'. Puisque le contrat
n'est valable qu'un an, n'oubliez pas de placer les champs date de début et date de fin dans la version de liste de
prix.

Ainsi, lorsqu'un commercial fera un devis à TinyAtWork, les prix proposés seront automatiquement calculés par
rapport aux conditions TinyAtWork.

Calcul basé sur un autre champ du produit

La flexibilité de Tiny ERP vous permet de faire dépendre les tarifs par rapport à n'importe quel champ de la fiche
produit, en plus des deux prédéfinis: prix catalogue et prix standard.

Pour ce faire, utilisez le menu: Produits > Définitions > Types de Prix. Créez alors une nouvelle entrée pour le
nouveau type de prix. Vous devez alors y encoder le nom du champ, le champ de la fiche produit auquel ce type
de prix correspond et la devise dans laquelle est exprimée ce champ. Cette opération fonctionne également sur les
nouveaux champs ajoutés sur la fiche produit dû à des développements spécifiques.

Une fois cette opération effectuée, vous pouvez faire dépendre les listes de prix sur ce nouveau type de prix.
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Ainsi, en ajoutant le champ poids et/ou volume, le prix d'un produit à la pièce peut dépendre de son poids et/ou
volume. Cette opération est différente que de définir un prix au poids, dans ce cas l'unité de mesure par défaut est
le poids et non la pièce.

Listes multi-devises

Si notre société de négoce désire lancer un catalogue produits dans une nouvelle devise, plusieurs solutions
s'offrent alors:

Encoder les prix dans une nouvelle liste de prix indépendante et tenir à jour les listes dans deux devises
séparément.

• 

Créer un champ sur la fiche produit pour cette nouvelle devise et faire dépendre la nouvelle liste sur ce
champ. Les prix sont alors maintenus séparément mais au niveau de la fiche produit.

• 

Créer une nouvelle liste de prix pour la seconde devise et faire dépendre cette liste sur une autre liste de
prix ou un prix produit. La conversion des devises se fait alors automatiquement au dernier taux en
vigueur.

• 
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Stock management

Stock management, and the inventories holding is a nightmare for any company having several storage sections,
in which are few hundreds or thousands of different products.

Dans cette section, vous apprendrez comment fonctionne la gestion de stock dans Tiny ERP, et comment il est
possible d'utiliser avantageusement les concepts de zones de stockages virtuelles, de zones de stockages
structurées suivant le concept des arbres, et le suivi des mouvements de stock via le système de doubles entrées...
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Inventory control

Tiny ERP introduces a new concept for the inventory control. Just like accounting, the inventory control is in
double entry; there are not appearance/disappearance of batches but only movings of a storage section to another.
Stock available for a given zone being equal to the sum of the less entering movements the sum of the tunring out
movements.

The following figure illustrates a complete supplier transaction to the customer with a phase of production.

In that example, only the storage sections on a gray backgroung belong to the company. The 'Default Production'
zone doesn't correspond to a physical stock but is used for the other side of theproduction transactions (raw
material consumption and production of finished product).

The following stages are represented in the above graph;

1. Raw material reception coming from a non-European supplier.1. 
2. Displacement of this raw material of the quality control to the stock of level 1.2. 
3. Consumption of the raw materials 1 (MP1) and 2 (MP2) for a production.3. 
4. Production of the finished product (PF1).4. 
5. Delivery of the product finished to the customer.5. 

By supposing that all the storage sections were empty before these transactions, the contents of the zones after
these transactions are;

Non-European suppliers: -1 MP2.• 
Stock Level 1:-1 MP1 (*).• 
Default Production: +1 MP1, +1 MP2, -1 PF1.• 
Customers: +1 PF1.• 

(*) What is theoretically not possible bus as stock Level 1 corresponds to a physical stock, it cannot be negative.
In practice, you can arrive in this situation type if you forget to encode a reception of goods. Tiny ERP is flexible
enough that not to be blocking in this kind of situation.

This system of inventory control of double entry allows a very great number of situations which aren't hard to
manage by the traditional inventory control programs.

That gives to the system a great simplicity because all the operations relating to the stock of the company are
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brought back to only one form of inventory turnover; production, inventory, return to the workshop, reception of
goods, quality control. That considerably simplifies the training of the software by the users.

In addition to this simplicity, this representation allows a better visibility on the company actions because all the
stock operation can be made on real stocks but also on the potential zones; valorization of a production stock,
analyzes section supplier storage, ...

It is also a very great advantage for the traceability because this one goes from the supplier to the customer,
whereas the traditional control programs are limited to the warehouse view. It's very interesting in the case of the
after-sales service and return to the workshop for defectiveness.

Generally, in all systems of stock management, there are errors between reality and what was really encoded in
the program. It is thus frequent to have to seek errors when you note differences (forgetting encoding of delivery
of goods, productions more important than planed,�). Just like in accounting double entry, it's quite simple to find
errors. In Tiny ERP you will be able to find a stock error in a warehouse thanks to the others side of each
transaction. If it misses articles in a warehouse, that has necessarily come from a zone of supply supplier, of an
production account, ...

Moreover, the Tiny ERP inventory control has a tree architecture. You can thus deliver batches in a given
warehouse, or deliver batches in the cupboard 3 which is on level 2 of the warehouse. In the same way, the
suppliers and customers zones can be structured according to their geographical location, according to their
volume of purchase/sale, ...

If there are several suppliers or customers zones, Tiny ERP uses the preferencies of the partner feature to know
which section storage to use according to the customer.
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Base functions
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The picking list

The "picking list" is the principal form of the inventory control, it's thanks to this one that you can move items
from a storage section to another in Tiny ERP. A picking list is made up of several lines which represent the
inventory turnovers done on the items. You will always find there, on each line, a source zone and a destination
zone.

The picking lists are in menu Stock > Incomings/exports Goods. Sub-menus and sub-menus under of this menu
(receipt waiting for sending, treatment for reception,�) are only screened views of this menu.

The picking lists are of three great types: delivery of goods (from a supplier zone to an internal zone), shipment of
goods (from an internal zone to a customer zone), and other movements.

The following figure gives an example of picking list.

The transaction state can have several values:

draft: no movement was made nor confirmed for the future.• 
confirmed: the movement was confirmed and will be done (probably) at the date marked by the field
'Dates Planed'.

• 
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assigned: in addition to be confirmed, the goods were reserved (no other movement will be able to move
it).

• 

done: the inventory turnover was done at the date "Date".• 
cancel: the inventory turnover will never be done.• 

Generally, the user doesn't have to encode the receipts and shipments picking lists of goods because those are
automatically generated by the orders forms and the purchases.

The reservation phase of goods (from the confirmed state to an assigned state) is done automatically by the
scheduler at the coming time. The user can however force the reservation if it wishes to make the inventory
turnover whereas the scheduler didn't require it. If you force an inventory turnover from a zone which doesn't
have a product, this zone will fall then into negative.

The stock movings with picking list are the base of the inventory control in Tiny ERP, train to do
inventory turnovers manually in order to understand the principle.

The imporant elements of the form of picking list are:

Auto-Picking field
If this one is ticked, the picking is confirmed and automatically finished. Thus, the pickings necessary to
supply the machines during productions are in the auto-picking, which avoids a ERP massaging to the
person in charge of the production.

'Split Lines in Two' button
This button is used to spread out one or more lines of the picking list in two equivalent lines. You use this
button, for example, if you encode the parcels numbers on each picking line and that this picking list is on
two parcels. You will be able to thus spread out a line of ten items in a line of three items over the first
parcel and a seven line over the second.

'Split & Track Lines' button
This button is used to classify a line of several items in several lines of one or more items with a different
serial number.

The "Locations" and "Dest fields. Location" on the form of picking list are optional, they are only
used to put the default values of the zones of each line. The only zones taken into account are those
indicated in the lines of picking.
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Stock moves

The inputs/outputs lines, like those of a work order, are stock moves.

Those indicate the moving of several items in the same type (a batch) from a zone to another. On this moving you
can indicate the serial numbers of the manufacturing batch or the tracking number of the logistic unit (ex: the
pallet on which these batches are).

You will notice that there are two measuring units; UoM (Unit of Measure) is the unit of measurement for the
inventory control, and UOS (Unit of Sale) is the unit of measurement for the invoicing and promotion of stock.
Thus, in certain sectors like the food processing, you can individually count products in stock , and invoice them
with the kilo with weighed again before delivery for example.

For needs of traceability, if you wish to follow a product, you have to click on its line in the picking list and to
add to him a number of manufacturing batch or a number of follow-up (alignment). If it's the first time that this
number is assigned, it's necessary to create new, otherwise it is necessary to seek existing.
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Stock transfer

After making the picking, now you have to transfer the batch towards the consumer. Indeed, the picking list only
allows to gather and pack the ordered products. On the tree level of the storage sections, the products were still in
the "stock" zone before the picking list and will find in the "output" zone after you made the picking. The
"output" zone, just like the "stock" zone, belonging to the "company" super-zone, the products on this tree level
of the storage sections are still in the company. It's the transfer which will cause to put the parcels in the truck
which will leave towards the consumer.

The products will then pass from the "output" zone towards the "Customers" zone which, is apart from the
internal zone of the company.

The proposals for batches transfers are generated automatically after the execution of the picking list. You will
find the transfers to do in the menu Stocks > Transfers of consumer batches > Transfers to do. Here the feature of
a batches transfer:

The "title" field is filled automatically and indicates that it's about a transfer (move) of the order form number
002. The "date planed" field contains this current date, but it's possible to modify it if iyou decide that the transfer
will take place later. The second "Date" field fills as soon as the transfer is done. The "Batch consuming" field
contains the reference of the batch. If you click on the "file" icon, the detail of the batch will be displayed. The
destination area of the batch is also indicated (the batch will leave towards the Customers zone).

The "Sequence number" field is a free field where you can indicate, for example, the reference number of UPS.
The origin of the transfer is indicated (here, you can see that the transfer comes from the picking list 1). The
shipping address of the partner is mentioned in the last field. You can always change the shipping adress before
confirming the transfer.
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Location

There are two ways to find in which zone a product is (on which tree location of the storage sections it is): via the
product feature and the location.

Via the product feature

From the product feature (Menu > Products > Produced), seek the product which interests you thanks to the
browser icon. Then, you have to click on the "Print" icon and to choose "Products location" among the proposals
displayed.

You will then obtain a pdf document taking the product back as well as the location.

It's the internal location to the company. The stock level mentioned represents real stock, which
remains in our warehouses.

Via tree location
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If you seek the product localtion or that you simply wish to know what a certain location contains, you have to go
in the tree location (Menu > Stocks > Tree location), choose the location which interests you and click on the
"Print" icon (example: choose to see what the "Company" location contains). Three kinds of stocks reports are
possible:

"Outline location " what contains the current zone. If you choose this report for the "Company" zone, the
report will be empty because there is no product in this zone.

• 

"Contents location (with children)" take again all the products being in the current zone ("Company"), by
also taking account into the subfields. You will thus have a list of all the products being in the company.

• 

"Batches by location " shows the existing products in each zone:• 

Via tree location 148

18/09/06



1

Stock reporting

There are several methods to know the stock reporting. The first consists to print it from the tree location. to do
that, use the menu: Stocks > Tree location. Select a zone and click on the print icon. Three reports are proposed
by Tiny ERP:

Outline of the location: give the stock reporting for the selected location * Contents of the locations (with
children): give the stock reporting by taking account into the tree hierarchical structure of the location

• 

Lots by location: allows to give the products location in the different location.• 

But you can also print the stock reporting from a selection of different products. to do that, use the menu:
Products > Produced. Seek one or more products then and click on the printer. Tiny ERP proposes three reports:

Location of the products in the different locations, and• 
Future estimated stock for the selected products.• 

The figure below shows an example of future stock forecast for a products selection.
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Inventories

Tiny ERP manages the turnings inventories, on a small part of the company and not necessarily on the stock
globality. Moreover, you aren'tt forced to stop the stock movement during a great inventory but Tiny ERP is able
to display again the stock movements at the inventory date even if before there were other movements.

The inventory is also used to update stock after installation. To do that, use menu Stock > Inventory of the
batches. Then, for each location in your company, create a line by product by indicating the models number in
stock.

It's preferable to seize the fields in the order for each inventory line, because when you will enter the
location and the product, the ERP will automatically fill in the items number available in this zone
and the measuring unit by default. you will have then to adjust this number.

Don't forget to click on the button to confirm when the complete inventory is finished. Then Tiny ERP will
generatethe inventory movements corresponding to the different compared to what is encoded in the ERP. You
can obtain the detail of these movements in the second tab.

The inventory form is useful at the end of the year but also for simply adjusting only one product of which the
recorded items number isn't correct for a given location.
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Lastly, to make analysis of locations, you can specify an inventory zone by default for each product while

clicking on the preference icon( ) when you are on a product feature.
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Traceablility

The traceability system upstream/downstream of Tiny ERP is very powerful. Once you made inventory
movements while having marked numbers of follow-up or manufacte batch on the movements, you can trace all
the included movements.

To do, go in the menu Stocks > Trceability > Manufacture batches (or Numbers of follow-up, according to what
you want to trace). Made a search for a number with the magnifying glass. Once the selected element, press on
the gears icon and you obtain all the traceability of the selected batch.

The productions or inventory movements in 'Make to Order' are chained with a patent-child relationship in the
traceability tree. While the lauched elements of movements by of Make to Stock are on the same level in the
traceability history.

You can select any element of the tree and click again on the action icon (gears) to trace the element selected
downstream or upstream. The inventory control at double entry of Tiny ERP makes it possible to make
traceability of the customer to the supplier by taking account into the returns workshops, the productions,...

 Traceablility 152

18/09/06



1

Accounting interface

In Tiny ERP, the inventory control is completely integrated into accounting. Thus, when you take delivery of
goods, you can setup Tiny ERP for automatically increasing the value of stock.

To do that, you have to enter an account number in the general accounting in each internal location. Then Tiny
ERP will be given the responsability to make the accounting transactions corresponding to the inventory
movements when a product enters or leaves a promoted location.

The accounts being used for the accounting other side are given by the preferencies of product feature as
indicated in the figure below.

The inventory control at double entry of Tiny ERP allows to simply manage consignees stocks by
marking a location of your supplier as being of your accounting (stored in the supplier but belonging
to you). or conversely, a zone being stocked in your buildings, but not belonging to the company
(without accounting promotion).
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Setup of stocks

Define locations

The first thing to setup the stock is to define the structure of the locations. To do that, use menu Stocks >
Definitions > Locations. During the software installation, a basic structure is defined, you can obtain it by menu
Stocks > Tree locations.

During the software installation, Tiny ERP declares the zones which have obligatorily to be defined:

Inventory Loss, of 'Inventory' type, used for the other sides of the inventory writings.• 
Procurements, of 'Supply' type, used for the other sides of the supply writings, before knowing which will
be the exact zone; supplier, production�

• 

Default Production, of 'Production' type, used for the consumed raw materials (moreover) and the
finished products made (in less).

• 

Suppliers, of 'Supplier' type, used for the other sides of the recipt of goods from a supplier.• 
Customers, of 'Customer' type, used for the other sides of the shipping of goods towards a customer.• 

Each one of these locations can also be subdivided for analytical needs. An example:

Suppliers
European

Textile◊ 
Subcontractor◊ 
Others◊ 

♦ 

Non-European♦ 

• 

These 5 basic locations are used for the operations other sides of inventory movement. The locations used for the
supplier and the customer location are given by the properties of a partner feature. The inventory loactions,
supplies and production to be used for each operation using a product are defined by the properties of a product
feature.

On top of these zones, you have also to define the locations corresponding to your company and your warehouses.
For each warehouse, it's necessary to define three locations: incoming location the goods, stock location and
export location of the goods. The incomings and sotcks locations can be identical, for example if it isn't necessary
to go by an entry quality control. But the export location has to be isolated and cannot be child of the stock
location. These locations have to be defined in 'Internal' type.

The following figure represents the case of a company having 2 warehouses of which one which is structured on
2 stages.
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In this example, the first warehouse has an incoming location of the goods where the raw materials await a
restocking in stock. The second warehouse doesn't have an entry buffer location, the good is directly sent in stock.
It has a location for the obsolete products which is located out of stock in order to to prevent that a need reserves
products in obsolete stock.

For each location, you can give an account of your general ledger which will be used for automatic risings of the
inventory movements. For example, the obsolete stock of the above example, contrary to the others, can't be
developed in accounting. In the same way a consignee stock in a supplier can be developed in your accountancy if
you paid it.

Lastly, once the set stock location, you have to allocate the properties to the partners and products particular in
order to use the good locations for each operation. It is preferable to do that before the first inventory of
regularization of stock.

Warehouses

When the locations are defined, you have to define the different warehouses. Those are used in the sales and the
purchases. They determine the sending or reception source of goods during the orders.

To define your warehouses, use menu Stocks > Definitions > Warehouses. For each warehouse it is necessary to
define incoming location, stock and the export of the goods.

Control your export warehouse location isn't in the stock of this one or of another warehouse.
Otherwise, Tiny ERP could use the parcels on standby delivery customer to supply other orders.

The link between a warehouse and a customer order is done via the definition of a sale point. Indeed, each sale
point is associated one and only one warehouse. The hierarchical structure of the stock location makes it possible
to define a principal warehouse and two secondary warehouses.

Warehouse principal
Brussels Warehouse♦ 
Paris Warehouse♦ 

• 

In the above example, an order done in the principal warehouse will be able to be supplied in the stock of
Brussels or Paris according to products availabilities. The location selection is done by the nearest location thanks
to coordinates X,Y,Z of each location.
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Gestion des achats
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Purchase Flows

With its built-in expected needs engine, TinyERP can greatly simplify a company�s procurement process.
Purchasing proposals then are automatically generated leaving purchasing agents only to validate them.

Criteria used in the needs computations are: Planned procurement date, required quantity, product�s default
supplier and his price list. When unexpected needs arise, purchase order can also be manually generated.
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TinyERP generates draft purchase orders. These can then be modified and validated by the purchasing agent
using the �Confirm Purchase Order� button. Purchase orders must then be either confirmed or rejected by the
supplier (acknowledgement of receipt of order). Once the purchaser and supplier have validated the order, two
parallel processes will be initiated: Product Receipt and Invoice Control

You will find in this menu all the ordered storable products awaiting receiving. These can be done in Inventory
control / Picking Lists / Getting goods / Pickings to process for goods reception menu hierarchy. In this menu,
you will find all stockables products awaiting receiving. Order receiving can be done several times.

Finally, when all line items have been received and the invoice has been paid (*), the order is automatically
closed. You can track orders through it�s different stages using the sub-menus Order Management > Purchase
Order Entry.

(*) In the Accounting Chapter, we shall see that an invoice is deemed paid when its accounting entries have been
reconciled with its payment entries.
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Purchase Orders

Purchase orders can be entered manually or proposed automatically by TinyERP based on computed expected
needs. This first section will cover manual entry. Automated methods will be covered in the Procurement section
of this chapter.

To create a new purchase order or quote, use the menu Purchasing > Order Entry.

The order will open in �draft� mode as a quote. A quote and an order are entered using the same form but simply
in different states. The quote may (or may not) become an order.

The reference number in the first field is automatically generated by the sequence of purchase orders. Then it is
necessary to enter the warehouse where the goods are to be delivered. Though not mandatory, it is highly
recommended it be filled, as it will allow the �Place of Delivery� mandatory field in the second tab to be filled
automatically. Assigning a default value to this field is highly recommended, as it will save entering the field for
every order.

When you enter the partner, the other required fields are filled automatically: Supplier address and the price list
that defines the specific conditions. Note that the price list also defines the currency used for the order.
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Using the « Cost Centre » field, you can associate the order to an analytical account. Analytical entries are only
created when the when the supplier invoice is checked. At this time, in Tiny EPR, the order�s analytical account
is unique for the whole purchase. If you wish to allocate the order across several analytical plans, you ill have to
use miscellaneous operations.

The two reference fields allow you to encode the supplier�s reference and, eventually, an internal one. Once the
heading completed, you must then enter the order�s line items.

It is possible to request delivery directly from the supplier to the final customer. In this case, do not
fill in the warehouse but specify the final customer on the form�s second tab. You will still receive
the bill of lading but this to simply verify that the customer has received the goods.

Order Line Items

First enter the desired quantity and then select the product. The remaining fields will fill themselves in
automatically using the data on the product sheet:

Unit Of Measure: Tiny ERP selects the default purchase Unit Of Measure from the product sheet (field:
Puchase UoM)

• 

Description: Product name, shown based on the user�s current language settings.• 
Expected Delivery Date: is the current date plus the supplier�s average lead time as available on the
product sheet (Field: Lead Time)

• 

Unit Price: is the supplier�s price, which depends on the selected price list for the partner.• 
Sub-Total: This field is updated only after the draft is saved, as it is the Tiny ERP Server that does the
line-by-line computation. It is always set to zero when the order is created and remain so until you select
the �Save� or �Compute� button.

• 
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Recurring orders.

Frequently, one often orders the same line items with a supplier every few weeks or months. Just as for sales,
there are two ways to automate these recurring orders.

The first method requires finding and duplicating a previous order using the drop-down menu Form > Duplicate.
A new draft, copy of the current one is automatically created. One then only needs to modify and validate it.

The other method links the order line items to the supplier. Once you are done with a complete order, click on the
title �Order Detail� and set the field�s default value ticking the dependency with respect to the partner. In the
future, when you create a new order, the lines items are automatically filled in when the partner name is entered.
Only a few lines need to be modified before validating the purchase.

Supplier Complaint Tracking
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Customer complaints are managed just like sales opportunities. They are accessible using the menu Purchase
Management > Supplier Request.

These requests track outstanding problems as well as the interchange history linked to each problem.

Each communication with the supplier can summarised in a report using the screen above. Once the summary
completed, click on the �Action� button in the section �Next Action� to add it to the history log available in the
second tab.
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Procument

Tiny ERP supports several methods to automate procurement proposals:

Refill stock using a reorder point rule (sometimes called minimum re-order point),• 
Just in time trigger further to a make to order request. This request can be:

A sale to a customer,♦ 
A manufacturing order♦ 
Manual provisioning♦ 

• 

Procurement Manual entry• 
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Procurement Flow
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The above figure shows the procurement flow depending on the type of product. This graph is important as it
establishes the per product requirements.

Procurement requests are named using the Production > Procurement Orders menu. Usually, procurement is not
done manually because orders are automatically generated by other resources:

Validated sales order line item• 
Consumed resources in a validated manufacturing order• 
Triggered re-order point rule (minimum stock)• 

Dans Tiny ERP, les produits stockables et les services sont totalement intégrés et peuvent être
utilisés indépendemment dans la plupart des actions. Par exemple, il est possible de mettre un
produit de type service que l'on achète (sous-traitance) dans une nomenclature.

Lorsqu'un approvisionnement est nécessaire pour un produit, Tiny ERP détecte automatiquement les actions à
déclencher en fonction de la fiche produit.

Le premier test est effectué pour déterminer si c'est un produit stockable ou un service. Pour ce faire Tiny ERP
consulte le champ 'Type de Produit' de la fiche produit. Celui-ci peut avoir deux valeurs: produit stockable ou
service.

Gestion des produits stockables

Si le produit est stockable, il faut déterminer s'il est tenu, par défaut, de stock ou sur commande. Si celui-ci est
tenu de stock, Tiny ERP va attendre qu'il y ait suffisement de stock disponible et ensuite réserver les produits
pour l'usage de l'approvisionnement en cours (une production, une livraison, ...). Les réservations se font dans
l'ordre de priorités des approvisionnements en tenant compte de la date planifiée.

Dans le cas d'une tenue de stock, l'approvisionnement automatique peut se faire grâce à une règle de point de
commande ou un achat manuel.

Si le produit stockable est tenu 'sur commande', il faut déterminer si on doit l'acheter chez un fournisseur ou si
c'est un article que l'on fabrique en interne. Cette information est donnée par le champ 'Méthode
d'approvisionnement' du deuxième onglet qui peut prendre deux valeurs: acheter ou produire.

Si le produit doit être acheté chez un fournisseur, il ne faut pas oublier de lui encoder la liste des fournisseurs
disponibles dans l'onglet 'Approvisionnement'. Pour chaque fournisseur, il faut donner: le délai de livraison
moyen en jours, le fournisseur (un partenaire) et la quantité minimale de commande. Le fournisseur par défaut est
toujours celui à la plus petite séquence, celui du dessus de la liste.

Si le produit doit être fabriqué en interne, il faut absolument créer une nomenclature qui détermine les ressources
utilisées pour la fabrication. Vous trouverez plus d'informations à ce sujet dans le chapitre consacré à la
production.

Si vous oubliez d'encoder un fournisseur par défaut ou une nomenclature, lors du calcul des besoins, vous
retrouvez toutes les exceptions accessibles par le menu: G.P.A.O. > Demandes d'approvisionnement >
Exceptions.
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Vous pourrez donc corriger le problème via chaque entrée de ce menu. Tiny ERP donne un message suffisament
explicite que pour pouvoir le corriger facilement.

Même si un produit est tenu de stock par défaut, il peut être forcé sur commande pour certaines
opérations telles qu'une ligne d'un bon de commande explicitement mise 'Sur Commande'. L'inverse
est également d'application.

Gestion des services

Si le besoin d'approvisionnement porte sur un service (produit de type service), il faut également déterminer s'il
est sur stock ou sur commande. Si le service est sur stock, il ne se passe rien et l'approvisionnement est
immédiatement clôturé. Ainsi, si vous mettez un service qui est géré 'sur stock' dans une ligne de bon de
commande, cette ligne n'impliquera aucun effet (si ce n'est qu'elle sera facturée).

Si le service est sur commande, il faut déterminer si c'est un service que l'on achète ou que l'on traite en interne.
Tout comme les produits stockables, cette information est également donnée par le champ 'Méthode
d'approvisionnement'.

Si c'est un service que l'on achète, on a affaire à de la sous-traitance, il faut alors encoder les différents
fournisseurs qui offrent ce service. Lors d'un approvisionnement, Tiny ERP proposera automatiquement un bon
de commande fournisseur avec ces paramètres.

Si le service est 'produit' en interne, lors d'un approvisionnement Tiny ERP va automatiquement créer une tâche
dans la gestion de projet. Le besoin sera terminé lorsque la tâche sera clôturée par un utilisateur.

Attention, de nombreux utilisateurs confondent sur stock/sur commande et produire/acheter. Ces
deux concepts sont différents mais complémentaires, le premier détermine quand il faut
réapprovisionner tandis que le second détermine comment réapprovisionner.

La logique

L'une des grandes forces de Tiny ERP est donc cette simple intégration entre tous les concepts. Il est important de
comprendre cette relation produit stockable/service car tous les documents agissent en conséquence. Un rapide
exemple doit nous permettre de bien comprendre la puissance de ce concept.

Prenons un bon de commande pour un client, ce bon de commande est marqué comme étant à facturer par rapport
aux quantités livrées et non aux quantités commandées. Si ce bon de commande contient des produits stockables,
la facture dépendra de la note de colisage (picking list). Si ce bon de commande contient des services, la facture
dépendra alors des heures prestées dans la gestion de projet, pour autant que le service soit 'sur commande'.

Cette fonctionnalité peut également intervenir dans la définition d'une nomenclature qui va conditionner un ordre
de fabrication. En effet, il est tout à fait possible de mettre un service dans une gamme ou une nomenclature. Cela
permet par exemple de mettre de la sous-traitance pour l'usinage de pièces chez un fournisseur. Ainsi, lorsqu'il
faudra fabriquer ce produit fini, une proposition d'achat de sous-traitance pour l'usinage est générée par Tiny
ERP.
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Le calcul des besoins

Le calcul des besoins permet de déclancher et ordonner par priorité les différentes demandes
d'approvisionnements. Celui-ci peut être lancé manuellement grâce au menu: G.P.A.O. > Exécuter les calculs de
besoins.

Le système demande alors de compléter quelques paramètres qui sont inhérents à l'entreprise. Ces paramètres sont
donnés en jours calendriers:

Délai d'approvisionnement: temps à ajouter entre chaque opération (réception, production, livraison),
généralement entre 0 et 1 jour.

• 

Durée d'un colisage: temps moyen pour une mise en colis d'une demande de stock,• 
Cycle pour le scheduler: temps entre deux exécutions du calcul des besoins (habituellement 1 jour),• 
Cycle des achats (PO): durée moyenne pour la négociation d'un bon de commande fournisseur,• 
Jours de sécurité: toutes les opérations seront déclenchées x jours avant par sécurité.• 

Ainsi, c'est au moment du calcul des besoins que le système procède aux réservations de stock, à l'explosion des
nomenclatures pour le calcul des besoins en matières premières, à l'évaluation des règles de point de commande, à
la détection des erreurs de paramétrage, ...

Après chaque calcul des besoins, une requête est envoyée au responsable des besoins avec le résumé des
opérations effectuées. Les raccourcis suivants sont utilisés dans la requête:

MTS: Make To Stock = Demande sur Stock (généralement manque de stock)• 
MTO: Make To Order = Demande sur commande (achat ou production).• 

Vous pouvez consulter les requêtes grâce au menu: Utilisateur > Lire mes requêtes ou au
raccourci en bas à droite de l'écran (la loupe).

Si des exceptions sont détectées par le calcul des besoins, vous obtiendrez les details ligne par ligne grâce au
menu: G.P.A.O. > Demande d'approvisionnements > Exceptions. Corrigez alors le problème ligne par ligne et
cliquez sur 'Réessayer' dans le formulaire de réapprovisionnement.

La figure ci-dessous donne un exemple de message reçu via une requête:
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Par exemple, si c'est une exception d'un approvisionnement sur stock, vous avez deux possibilités pour corriger le
problème:

transformer le formulaire d'approvisionnement de 'sur stock' à 'sur commande',• 
passer commande manuellement, tout en vérifiant qu'une règle de point de commande n'a pas déjà fait
une proposition d'achat.

• 

Le calcul des besoins 169

18/09/06



1

Les règles de point de commande

L'une des méthodes pour automatiser les réapprovisionnement est de définir des règles de point de commande
(Stocks > Seuils de réapprovisionnement > Point de commande). Celles-ci permettent de définir des bornes
minimum et maximum autour desquelles le stock de produit doit évoluer. Une règle se définit par produit et par
entrepôt.

Le système de règle de point de commande est généralement utilisé par les petites entreprises grâce à sa grande
simplicité de mise en oeuvre.

Lorsque le stock d'un produit descend en dessous du stock minimum d'une règle de point de commande, cette
règle crée automatiquement une proposition de réapprovisionnement pour remonter au stock maximum défini
dans la règle. Cet approvisionnement, après exécution journalière du calcul des besoins, va automatiquement faire
une proposition d'achat ou de fabrication.

Ce calcul de l'état du stock ne se fait pas sur le stock réel mais sur le stock virtuel. Ainsi, il prend en compte les
réservations en cours, les ordres de production futurs et les achats en cours chez les fournisseurs. Il se peut donc
que le système vous propose de réapprovisionner alors que vous avez suffisament de produits en stock. S'il le fait
, c'est qu'il y a des réservations pour des clients en cours et le stock va bientôt tomber en dessous de la borne
minimale.

Pour chaque règle de point de commande, vous pouvez indiquer un nombre qui forcera la quantité commandée à
un multiple donné par ce facteur (arrondi au supérieur). Il est aussi possible de mettre des règles de points de
commande sur les matières premières ainsi que sur les produits intermédiaires qui sont fabriqués en interne.

Prenons les données suivantes comme exemple:

Ecrans en stock: 25 Ecrans• 
Réception d'une commande fournisseur à court terme: 10 écrans• 
Ecrans réservés un ordre de fabrication: 15 écrans• 
Commandes clients en attente de livraison: 10 écrans.• 

Si la règle de point de commande est à minimum 12 écrans et à maximum 40, Tiny ERP fera une proposition pour
acheter 30 écrans. Il le fera directement car (25+10-15-10) < 12. Si vous avez indiqué une quantité multiple de 7,
il va proposer d'acheter ou produire 35 écrans.
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Fiche Technique

Fonctions de base

Gestion et suivi des achats.• 
Réapprovisionement par point de commande, ou en flux tendu.• 
Gestion des contrats fournisseurs, des listes de prix et des conditions de paiement et livraison.• 

Commandes

Suivi des demandes de devis.• 
Multiples adresses fournisseurs.• 
Validations par visa acheteur et confirmation fournisseur.• 
Livraison à l'entrepôt ou au client final directement.• 
Commandes manuelles ou suggérées par Tiny ERP selon vos règles de gestion.• 
Regroupement de commandes.• 

Lignes de commande

Calcul automatique des délais de livraison souhaités et prix.• 
Saisie rapide 'sans produit'.• 
Gestion des doubles unités de mesure à la commande.• 

Facturation

Contrôle des factures.• 
Intégration à la comptabilité analytique via les centres de coût.• 

Réapprovisionnement

Méthode de point de commande (stock mini) par produit et par entrepôt.• 
Possibilité de mettre le produit en mode �sur commande�.• 
Système de requêtes intégré pour les alertes et exceptions sur les états de stock.• 
Modification possible, et ce à tout moment, du processus de réapprovisionnement (calcul des besoins,
annulation, ...)

• 

Listes de prix

Gestion des ristournes et promos fournisseurs.• 
Gestion des prix limites.• 
Conditions et contrats fournisseur et tarifs saisonniers.• 

Visibilité Rapide

Fonctions avancées de reporting pour une prise de décision rapide.• 
Zoom sur le stock futur, détail du prix de revient, commandes et événements fournisseurs.• 

Livraisons (cfr section Gestion commerciale)

Multiples grilles livraisons.• 
Prix configurable par poids, volume, prix ou autres mesures.• 
Différentes logistiques de livraison.• 
Gestion des préférences fournisseurs.• 
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Suivi et contrôle

Historique complet des états.• 
Contrôle des factures reçues.• 
Contrôle, automatisation et plannification des livraisons.• 
Gestion des réceptions et facturations partielles.• 
Suivi des retards fournisseurs.• 
Support de 12 codes barres.• 
Gestion des unités logistiques.• 

Les produits

Gestion des gabarits et variantes.• 
Gestion des produits stockable et des services (sous-traitance).• 
Nombre illimités de fournisseurs.• 
Catégories hiérarchiques.• 
Préférences fournisseurs; quantitée minimale, délais, préférenciel, ...• 
Références et appellations fournisseurs.• 
Gestion des fournisseurs et fabriquants.• 

Les multi's

Multi-points de ventes.• 
Multi-entrepôts.• 
Multi-langues.• 
Multi-mode de livraisons.• 

Ergonomie

Fonctions de cadencier.• 
Gestion des abonnements.• 
Zoom rapide sur les fiches liées.• 
Fonctions de 'clic et lie' pour la navigation aisée.• 

Intégration

Module EDI pour les commandes, facturations et livraisons électroniques.• 
Intégration à la comptabilité générale et analytique.• 
Intégration avec le contrôle des stocks et le suivi des tâches.• 

Flexibilité Totale

Tous les écrans sont personnalisables (saisies, listes, états, recherches...)• 
Gestion fine des droits et des menus par utilisateur.• 
Accès à distance via Internet.• 
Configuration des processus et des alertes possibles.• 
Système de requêtes intégré.• 
Extensible via de nombreux modules optionnels.• 
Processus personnalisables.• 
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Sales Management

 Sales Management 173
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The sale flow
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The above figure presents the complete sale flow of Tiny ERP, from business apportunity to the delivery and the
invoicing of the order. This diagram represents basic flow, such as it's with the software installation . Thanks to
the integration of the BPM (Business Process Management) of Tiny ERP, each company can modify this flow of
sale for specific needs. Generally, the making contact with a customer starts with a business apportunity. This one
can be manually encoded (a telephone contact) or automatically (interface with a contact form on the Web site).
Each opportunity is associated to marketing people which is charged to do the follow-up.

Then, if the customer is interested, from the business apportunity you will go to the quote. In the quote, the
conditions, the rates and the products are indicated. In Tiny ERP, a quote isn't yet validated order (state draft or
draft).

Later, if the customer gives one's consent to the quote, this last is validated and transformed into real order. From
there, Tiny ERP takes care making the delivery and the invoice follow-up, which can be launched at the same
time or one after the other.

Lastly, two new speakers are necessary; the countable will have to validate the invoice proposaland the
storekeeper will have to proceed the products delivery. If the products are not on stock and available in stock, the
cycle of restocking is given the responsability to update stock necessary.

The order is considered as paid when it is delivered and invoiced.
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Sales opportunities

Introduction

Sales opportunities are available via the menu: Sales > Business opporunities. They are used to make the
customers requests follow-up , before quote. The commercial requests are encoded, assigned to a marketing
person and followed by this person until they are canceled or lead to a quote.

They are used to maintain: * The meeting calendar, * The requests follow-up in progress, * The history of the
request treatment, * Results analysis of the marketing people.

The requests not assigned with marketing people are available by the menu: Sales > Business opportunities >
Commercial opportunities in progress. You can assign a demand for clicking on the'Initial state' button in the
form. If you interfaced Tiny ERP with a Web site, the requests customers coming from a form will be available in
this menu. Then it's wise to designate a person in charge in the company which will make the routing of the
requests towards the different marketings ones.

Then, each marketing person have to maintain its own requests list via the menu: Sales > Business opportunities >
My opportunities. With each time an action is made for this request, it is necessary to fill the fields 'Next Action'
section, and to click on the 'Action' button. The data then come to be put in the second tab containing the history
of the actions done for this case.
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If the request isn't a commercial request but a support request, you have to change the 'Case'
field towards Support or Purchase. The request won't be available anymore in the sales menu
but via the menu: CRM/SRM & Support > Support center for the supports requests.

The sales pipeline

Then the sales manager can ask for a report on the requests in progress. That makes it possible to obtain the
forecast of the future sales. To do that, you have to select a requests list (by marketing person, type of request, or
all the requests) via the 'magnifying glass' icon. When the selection is made, put you in list mode and click on the
print icon. Then Tiny ERP calculates automatically the sales pipeline.
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On this graph, you find in abscissa the succes percentage estimated of each request. These percentages are
indicated by the marketing people when they meet the customer. The graph of the top gives the estimated costs
and incomes while the graph of the lower part represents a point by business. Each color of the graph corresponds
to marketing person.

If you don't sell enough, there can be two explanations: * Either you don't visit enough customer, then it doesn't
have enough points on this graph, * Either you aren't enough effective in the before-sale, then there is a
concentration of the businesses in the left part of the graph.
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Write an invoice

In Tiny ERP, an invoice is an order form not confirmed. The writing of a new invoice is done via the menu: Sales
> Seized of the customer orders. For a greater simplicity, the invoice form has the same structure that an invoice
paper; a heading containing the info of the customer, the invoice lines and the footer with the totals and the taxes.

If you have well configure your sequence, the invoice number is automatically indicated when you return in the
window. Then, you have to type the fields in the order.

The sale outlet for which this invoice is made. If the marketing person works mainly for the same outlet,
it's advised to put it by default with the right click of the mouse on this field. This outlet determines the
warehouse which will be used and the available items number in stock.

• 

The partner. Once the selected partner, Tiny ERP automatically supplements the order addresses,
invoicing and delivery for this order thanks to the type of address indicated in the partners feature. You
can of course modify these data.

• 

The cost center. Determine the analytical account which will be used if you make management by
business. Defer to the chapter on management by business for more information on this subject.

• 
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The price list is automatically selected according to the partners preferencies ("preferencies" icon on a partner
feature), but you can of course modify this field to benefit the customer of special rates for this only order.

Notice that there is no field currency in an order form. Indeed, the purchase currencyorder is given by the
currency of the current price list in this order form.

(*) To modify the number sequence of the invoice numbers, in the menu: Administrations > Sequences >
Sequences and modify/create a sequence of the Sale Order type (Sequence Codes field).

The invoice lines

Once the heading written, you have to add a line by ordered product.

If you forget the heading fields, it will be more complex to create the order lines, thus take care to
supplement the heading before encode the lines. For example, if you forget the outlet, the available
products stock won't be exact because the warehouse used depends on the outlet.

For the seizure of each order line , begin to encode the quantity requested (Quantity UOM), the measuring unit
being optional. Then, select the product.

If you don't know the product code, press ENTER from the product field to select among the available products
list to the sale. In this list, you will find several columns interesting;
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Real stock: quantity in stock, depends on the outlet and the selected measuring unit,• 
Potential stock: quantity available to the sale (=real stock - reservations + receipt and productions planed
in short-term),

• 

Price customer: price whose the partner has advantage according to the selected price list,• 
List Price: basic price selling normal for this product.• 

Once the product selected, all the other fields are automatically complete each other ; description, the packaging
by default, the price partner, the method of supply (on stock/order) and planned ship date which depends on the
conditions indicated in the product feature.

If you wish more information on the product, use the functionalities of the right click once this one is selected.
For example, if you choose a report, you can obtain: the cost structure explosion of the product, the forecast graph
of future stock, or product location in the warehouse.

You can modify the proposed fields by default before confirming the invoice line.

Moreover, the product isn't obligatory in this form because the field isn't in blue. Thus you can sell items which
are not defined like products. In that case, you have to encode the price, the description and the ship date
manually. Moreover, there will be no inventory controm for this command line.

For the fast invoice seizure, you can use the two following short cuts; CTRL Enter: validate the line
and seize another, Esc: leave the edition of the invoice lines.

Double measuring units

The order form supports the double measuring units. First (UOM) is necessary for the stock control while second
(UOS) is necessary for the invoicing. The conversion ratio from the one to the other is indicated in the product
feature (Fields UOM->UOS Coef).

This functionality is frequently used in the agro-alimentary sector. You can for example sell hams at piece-rates
but invoice them with the kilo. If a ham weighs on average 3 kilos, the conversion factor in the product feature is
3. There can be a weighing during the picking list it results that maybe there will be 2.8 kilos which will be
invoices and only one delivered ham.

If the company uses only one measuring unit, the conversion ratio of the productfeature is equal to one and the
two fields are equal on the invoice.

Planned ship date

The planned ship date is calculated according to the conditions indicated in the product feature, via the 'ship time
average' field. This date is very important because the calcul scheduling of the needs is based on the planned ship
date.

An order can be delivered in several times this is why the date may be different on each invoice line.

On Stock/ on Order

On stock or order management depends on the 'Calcul of the needs' field for the product feature.

A stock request simply will wait until necessary stock is available and launch a shipping request for the planned
date in the command line. Thus stock for this product will decrease.

A request order will automatically launch supply for this request (just in time flow). This supply may be of
different types according to the product feature: an order to a supplier, a production, a task in the project
management,... The lines which are marked 'on order' don't affect the inventory status reports and can be ordered
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and validated if there is no available stock.

For example, if a customer orders 15 Computers in urgency but you only have 6 in stock. You can create an
invoicee with two lines;

5 Computers on stock to be shipped in 3 days• 
10 Computers on order to be shipped in 10 days Then there will remain a computer on available stock for
other orders and a work order for the 10 computers will be automatically suggested. To deliver this order
twice, don't forget to put the 'Ship method' field of the second tab to 'Ship as soon as possible' instead of
'Ship in only one parcel'.

• 

Invoice options

The second tab of the invoice contains options which will affect the performance of this one. Most important are:

'Ship method'; determines if the order may be sent in several times according to the availability of the products or
if it's necessary to send all in only one parcel to limit the postage.

The 'Ship terms' field can have three different values;

Payment before shipping: allows to generate the invoice and to create the request for shipping only once
the invoice paid. This method is generally used for Internet orders.

• 

Invoice after shipping: The invoice is automatically created once the shipping totally finished.• 
Shipping and manual invoicing: The shipping is directly ordered and the invoice must be manually
produced while clicking on the 'to create invoice' button or by using the gears to invoice several orders of
a blow. This option is frequently used when you invoice all at the end of the month.

• 

Lastly, thanks to the 'Invoices on' field, you can decide to invoice on the ordered quantities or the shipped
quantities.

Invoices or recursion orders

Two methods exist to simplify the seizure of recursion orders.

The first consists in seeking a previous partner order. Then, duplicate this order thanks to the menu of the top:
Form > To duplicate. Then Tiny ERP generates a new invoice based on the order or the duplicated invoice.
Modify this invoice before saving.

Another method consists in allocating the orders lines to a partner. Once you made a complete order for a partner,
click on the 'Orders - Detail' title and indicate the default value of the field while not forgetting to tick the
dependence in relation to the partner. Then, when you will create a new invoice for this customer, the orders lines
are automatically completed from the partner seizure. You have not to modify the few lines which change before
closing the order.

This last functionality is very used to implicate a calendar.
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Fromm invoice to the order

When a customer wishes to make order. You can find the invoice corresponding which is given by the list of the
not validated invoices: Sales > Seized of the customer orders > My orders > Your requests for invoice.

To transform the invoice into order, click on the button in bottom on the right: 'Confirm order'. Then the invoice
becomes grayed because you can't anymore modify it.

If you made an error in the order and that this one was not delivered yet, you can cancel it,
correct it and regenerate it by pressing the buttons in bottom on the right of the order.

Then Tiny ERP generates automatically the generated documents by this request such as the shipping and the
invoicing. You will find the history of the shippings and invoicings for an order in the 'Historical' tab. These
details are also given by order linethanks to the second tab of each order line.

Certain complex operations like the production and restocking are planned by the calcul of the needs. Thus, if you
wish to directly see the influence of your order, you can manually launch the calcul of the needs via the menu:
G.P.A.O > Launch calcul of the needs.

It can be interesting to find an order by making a research not on the order but on the order lines. To do that, use
the menu: Sales > Order - Detail. That makes it possible to seek on criteria like the product, the quantities, the
state of the line, ...
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The delivery management

The delivery management in Tiny ERP allows:

encode delivery preferencies for each partner,• 
to select among the different deliveries methods to the order,• 
to calculate the purchase and selling prices for the delivery of a given order, * to generate the tasks or
subcontractings of this delivery.

• 

Two objects have to be defined for each available delivery mode by the company:

a delivery mode,• 
one or more rates grids for this delivery mode.• 

Definitions of a delivery mode

To define a new delivery mode, use the menu: Stocks > Definitions > Transport > Carrier. When you enter this
menu, Tiny ERP presents you the list of all the available delivery modes. For encode a new, press on the 'New'
icon(the white sheet).

Start by giving a name to your delivery method, for example 'UPS Express'. Then give then the link towards the
partner feature of the associated carrier. If it doesn't exist in the database, you have to create a new.

Then give the product reference which will be used in the order form for the delivery. This product has to be
defined like a service. If no processing (other that invoicings and inventory movements) has to be done in this
delivery in Tiny ERP, configure this product of supply method 'Make to Stock'.

If you wish that your delivery generates a task in the project management, configure the associated product in
'Make to Order', supply method: 'Production'. Thus don't forget to define a person in charge for this product. In
the same way, if you wish that this product is bought by another company (subcontracting), put the product in 'On
order' mode, supply mode 'Purchase'. Then don't forget to define the available suppliers list for this service. For
more information as for the processing of the operations according to the product feature, defer to the supply
chapter.

The catalogues and standard cost price of the defined product won't be used because the delivered price will be
calculated thanks to the rate grid of the currier.

Definition of the rate grid

Once the delivery method defined, you can encode the different rate grids. For example, for delivery 'UPS
Express', three rates grids can be defined: France, Europe and the rest of the world.
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Definitions > Transport > Grids of transport. Tiny ERP then opens the list of the defined grids. You can select
one to modify, to create a new one or to seek an existing grid according to its name or of the delivery method.

The first tab includes all necessary information to the grid definitionand the calculation of the delivered price
according to the order.

Start by indicating the grid delivery name, for example 'UPS Express France'. Then indicate the previously
defined delivery method. You can activate or not this grid thanks to the 'Active' field.

The sequence number makes it possible to define which grid will be evaluated in first. Thus, if a grid is available
for France and a second for Europe, it is important that the sequence of the grid for France is lower than the
sequence of the grid for Europe. Indeed, France belonging to Europe, if the ERP starts by evaluating Europe, it
will apply the rate European to a delivery bound for France. To sum up, more the grid is specific, more the
sequence number must be weak.

Then, indicate a whole of rules in the 'Deliveries rates lines' section.

Each rule has to have a name given by the first field. Then it's necessary to give an application condition of the
rule. This condition can relate to 4 variables: the weight of the order, volume, the weigths*volume or the price.
The weight and volume must be expressed in the same unit as that used in the product feature, the reference
weight is with the choice of the user. An example of rule: weight >= 300 kg.
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Then it's necessary to indicate the variables necessary to the calcul of the purchase and selling price if one is
under the condition of the rule defined above. To do that, fill in the fields price selling and price standard.

The price indicated can be fixed (45 EURO) or variable, dependend on a factor (2.3 EURO kg). The price must
be defined in the currency by default of the company. If the price indicated is variable, you must indicate the
variation factor which can be of 4 types: weight, volume, weights*volume, price selling.

If several rules are applicable, Tiny ERP automatically chooses the rule most favorable (the least
expensive) for the partner.

Once the calcul rules of the encoded price, it is still necessary to give the application conditions of this rate grid.
Indeed, as there can be several grids for the same delivery method, Tiny ERP must be able to determine which to
use in each situation. To do that, use the second tab heading 'Destination'.

The selection of the applicable rate grid according to the delivery method is done thanks to the delivery
destination. This destination can be defined by a list of country, a list of states and possibly an interval of postal
codes.

Example of definitions

As example, we will define three delivery modes as follows: the post office based on the weight of the parcel, a
method UPS Express and a method UPS Standard based on the weight*volume.

To do that, it is necessary:

To define two partners corresponding to the companies which will deal with the delivery: The Post office
and UPS. For each one of these two partners you have to encode the order addresses and the different
contact.

• 
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To define three products for each one of these deliveries. The products have to be of 'service' type, in
restocking mode 'On Stock'.

• 

To define the three following deliveries modes:
the Post office: partner 'the Post office', product 'Postal delivery'♦ 
UPS Express: partner 'UPS', product 'Delivery UPS Express'♦ 
Standard UPS: partner 'UPS', product 'Standard Delivery UPS'.♦ 

• 

Then we define the delivery grids for each of the three modes. The post office has fixed rates, by steps according
to the total weight of the order. The following fields are then completed for the differents steps:

Name: Weight >= 500gr• 
Condition: Weight - >= - 500.0• 
List Price: 12 EUR• 
Standard Price: 9.5 EUR• 
Price Type: Fixed• 

We can for example add a free delivery condition for any order higher than 1000 EUR. the following figure
presents the definition of this promotion.

Name: Free if order >= 1000 EUR• 
Condition: Price - >= - 1000• 
List Price: 0 EUR• 
Standard Price: 9.5 EUR• 
Price Type: Fixed• 

Thus you can mix conditions on the weights and the prices in the same rate grid. Tiny ERP will automatically
choose the most advantageous rule for the partner.

UPS rates are a function of weight*Volume of the total order. Several rates grids are defined according to the
cutting of the countries in zones defined by UPS, these zones are encoded in the second tab of the grid. Contrary
to the postage rate, the delivered price is variable and depends on this Weight*Volume.

Name: PV >= 1200• 
Condition: Weight*Volume - >= - 1200• 
List Price: 2.3 EUR• 
Standard Price: 1.8 EUR• 
Price Type: Variable• 
Variable Factor: Weight*Volume• 

Use of the deliveries

When the rate grids are defined, you can allocate delivery preferencies to each partner. To do that, select a partner
feature from the menu: Partners > Partners. Then click on the 'properties' icon and fill the 'Delivery method' field.
If you did not define delivery for a given partner, it's not a problem because you will be able to select the delivery
at the time of the customer order.

To add the delivery expenses on an order, when this one is finished, click on the 'Action' icon represented by
three gears and select the action 'Add the delivery expenses'. Then Tiny ERP asks for you the delivery method
chosen for this order. When you click on the button 'Create the delivery line', the delivery line with the calculated
rate is automatically added to your order.

The delivery price is calculated on the basis of total order, thus take care to add the delivery expenses when the
order is completely encoded. If the order is modified, it's necessary to start again the calcul of the delivery rate.
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Setting

Before setting the sales module, check that the following modules are well setting: accounting, stock
management, products.

To use the order forms, the products have to be defined. For each product which can be available to the sale, don't
forget to check that the 'Can be sold' field is ticked. Otherwise, the marketing person won't be able to consult this
product from an invoice or an order form. By default, all the products can be sold.

Then, it's necessary to define the differents outlets or ships. To do that, use the menu: Sales > Definition > Outlet.

For each outlet it's necessary to define the name of the outlet. Then, you can indicate a price list by default. This
price list is used if the partner doesn't have an associated list. If a test has specific conditions via a price list, Tiny
ERP automatically chooses the list of the partner and not of the outlet.

If you use the analytical accounting for writings breaking down by shop, you can indicate an analytical account
associated to this shop. This field is optional.

The payment methods and the payment by default are useful only in the case of sales counter. You have to
indicate to it the differents available payment methods in your outlet. Those correspond on accounts of the
general ledger. Thus it's necessary to create an account by case.

The associated warehouse to the outlet is optional but it's highly advised to indicate if you make the inventory
control. The goods to deliver or take delivery during the order done to this outlet will be at the warehouse
indicated in this field.
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If you install an interface with a software eCommerce, each Web site is consulted as a outlet.
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Sales orders technical features

Basic functions

Opportunities management, invoice, orders, and deliveries.• 
Management of the contracts customers, the price lists and the terms of payment * Followed-up
commercial actions

• 

Orders

Management of the delivery addresses, invoicing, and orders• 
Differents delivery logistics• 
Management of Incoterms• 
Delivery as soon as possible or when the order is complete• 
Templates and fast copy of orders and/or invoice• 
Control preferencies customers• 

Command lines

Automatic calcul of the delivery periods, inventory status reports, price• 
'On Stock' or 'Order'• 
Fast seizure 'without product'• 
Configurable products• 
Management of the double measuring units to the order• 
Support of the orders allocated• 
Management of the consuming selling price• 

Invoicing

Many delivery logics invoicing (handbook, automatic, prepayment, ...)• 
Integration with the analytical accounting via the centers of profit• 
Invoicing on the quantity delivered (or done) or ordered• 

Price lists

Management of the rebates and promotions in multilevel cascade• 
Management of the limiting prices• 
Preferencies customer and contracts• 
Many flexible methods of calcul of the selling price• 

Fast visibility

Advanced functions of reporting for a fast decision-making• 
Zoom on future stock, detail of the cost price, orders and events customers, ...• 

Deliveries

Multiple grids of deliveries• 
Configurable price by weight, volume, price or others• 
Different logistics of delivery• 
Management of the preferencies customer• 
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Opportunities

Follow-up and scheduling of commercial opportunities• 
Different states; sales pipeline, monthly sale,...• 
Definition of actions with description of the action, canals of communication, state of mind of partner• 
The historical, traceability of the actions• 

Follow-up and control

Complete history of the states• 
Control invoicing * Control, automation and plannification of the deliveries• 
Livraison and/or invoicing by possible line of order• 
Automated scheduler• 

Products

Management of the gauges and alternatives• 
Many possible configurations• 

The multi'S

Multipoint of sales• 
Multi-warehouses• 
Multi-languages• 
Multi-deliveries and price lists• 

Ergonomics

Functions of cadenciar based on the preferencies customers• 
fast Zoom on the dependent features• 
Functions of 'click and reports' for easy navigation• 

Integration

3 supported free interfaces eCommerce; ezPublish, OSCommerce, Joomla• 
EDI module for the orders, invoicings and deliveries electronic.• 
Integration with the general ledger and analytical• 
Integration with the inventory control, the follow-up of the tasks, restocking,...• 

Report

Sales pipeline (forecast of the sales and future costs)• 
Monthly sales or dailies, cumulated or not• 
System of creation of your reports customised via OpenOffice.• 
Integration with Excel and Word• 

Total flexibility

All the screens are customized (seized, lists, states, research�)• 
Fine management of the rights and the menus by user• 
Remote access via Internet.• 
Configuration of the procesus and possible alarms.• 
System of requests integrated,• 
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Extensible via many optional modules• 
Process customized• 
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Production

 Production 194

18/09/06



1

Production flow

An order of production can come either from a manual encoding, or automatically created by Tiny ERP following
a need on a product. For reminder, this product has to be configured in storable product which is made inside. It
must at least exist an available nomenclature for this product.
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If the request comes from a need, then Tiny ERP seeks a nomenclature which corresponds to the hoped product to
determine how it will be done. If several nomenclatures exist, the properties make it possible to make a selection
among those. If the properties don't give a satisfactory result, Tiny ERP takes the nomenclature having the
smallest sequence. The production orders generated are in draft mode and don't have at this step any influence.

Then it's necessary that a user confirms or cancels this order. If the order is confirmed, thus Tiny ERP will make a
request for supply for each necessary goods to the production. With the launching of the needs calculation, then
these requests are done and can generate themselves other orders of production (streams), of the purchases, the
deliveries or subcontracting. The needs calculation is done in infinite capacity.

For more information on this process, defer to the supply chapter. If the raw materials are available (supply
satisfied), the picking list to fill the production is automatically validated to avoid an additional step which would
weigh down the process. Thus the raw materials are automatically moved with the wished location for the
production.

The production order goes then in the 'ready to produce' state. The workerscan obtain the production list on
standby and have to start with the first one because those are sorted by importance/urgency. When the user begins
the production, he clicks on the 'Start Production' button. Now the raw materials are consumed and the accounting
entries for those are generated.

Lastly, when the production is finished, the user clicks on 'Finished Production' and the finished product is
generated and added to stock. The analytical charges according to the ranges definition and charging stations are
charged at this step.

We will see in the following chapters that the production module of Tiny ERP is very flexible and bears:
multilevel nomenclatures and ranges, cascade productions, phantom and substitution nomenclatures, as well as
the configured products.
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Bill of Materials

Bill of Materials (BOMs), sometimes called recipes, are documents that form the bonds between the finished
products and their components. BOMs describe the raw materials used in the manufacturing of the end product.
Thus, calculation of the production requirements and the supplying of a retailer is possible, taking into account
the customers needs or internal requirements.

The needed machines and the human resources are determined by the routings which will be discussed in the
following chapters.

To access the BOMs form, the menu path is: Products > Bill of Materials

The first fields that should be filled are the name of the BOM and its code. The name of the BOM should not be
confused with the name of the product because there can be several BOMs (or routings) for the manufacturing of
the same product. If there is only one BOM per end product, it is sufficient to use the name of the product as the
name of the BOM so that it will be easier to find in a later time. In this case, leave this field empty and it will be
automatically completed when you select the end product.

Le code de la nomenclature est donné à titre informatif et est optionnel. Il n'a pas d'autre effet que de simplifier la
recherche d'une nomenclature.

Ensuite, le produit et sa quantité par ordre de fabrication sont donnés sur ce formluaire. Vous devez encoder ici
les données théoriques sans tenir compte des éventuelles pertes ou pourcentages de perte. En effet, un facteur
correctif pour la nomenclature ou par ligne peut être encodé par la suite pour représenter les pertes moyennes en
produits finis ou matières premières.
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Si vous fabriquez ce produit à la pièce, prenez une quantité de 1. Si ce sont des séries multiples de 50 pièces,
encodez votre nomenclature avec une quantité de produits finis à 50 pièces.

Ensuite, vous pouvez spécifier une gamme associée à cette nomenclature. Ce champ est optionnel, mais si vous
spécifiez une gamme, les effets sont les suivants:

Le coût des postes de charges seront pris en compte dans le calcul théorique et réel du coût des produits
finis.

• 

Les ordres de fabrications seront automatiquements complétés avec la séquences des opérations inclues• 
Les entrées dans la comptabilité analytique pour les coûts de production seront automatiquement générés.• 
La calcul des besoins se fera en capacité infinie mais avec contrôles de charges possibles sur chaque
poste.

• 

Généralement, on n'utilise les gammes que si les coûts d'utilisation des postes de charges sont très importants ou
si la planification doit se faire en tenant compte de la charge de chaque poste.

Le type de nomenclature peut être normal ou fantôme, nous verrons l'explication détaillée de ce champ dans la
sous-section suivante.

Enfin, les matières premières doivent être encodées dans les lignes du champ 'BoM structure'. Chaque ligne, qui
définit une ressource utilisée, est également une nomenclature. Les lignes peuvent alors être définies avec tous les
paramètres expliqués si dessus.

Le deuxième onglet sert à encoder les différents changements ou révisions apportés à la nomenclature.
L'encodage de ces changements doit être manuel, une petite explication peut être ajoutée à chaque modification
sur une nomenclature. Cela permet de garder l'historique des changements effectués de manière informelle.

Le troisième onglet permet de définir des paramètres comme:

les dates de validité de la nomenclature,• 
l'arrondi permet de donner la précision des appareils de mesure de la quantité de matières produites. Si
vous fabriquez à la pièce, l'arrondi doit être 1.

• 

l'efficacité produite permet de donner le rendement de produits fabriqués, un paramètre de 0.95 permet
d'indiquer que 95% des matières premières sont transformées en produits finis, il y a 5% de perte.

• 

Les propriétés permettent de définir des produits personnalisables. Celles-ci seront définies dans la sous-section
suivante.

Produits configurables (ou personnalisables)

Dans Tiny ERP, il est possible de définir deux nomenclatures pour le même produit fini. Chacune de ces
nomenclatures peut avoir des matières premières et/ou des gammes différentes.

Nous allons illustrer ce principe par deux exemples distincts: un producteur de jus de fruit pour la grande
distribution et un assembleur d'ordinateurs.

Producteur de jus de fruits.

Commencons par examiner le cas d'un producteur de jus de fruits qui possède deux machines pour broyer les
fruits et les mélanger avec l'eau et le sucre. La première est utilisée pour faire des prototypes et de petites
quantités car elle ne nécessite pas de paramétrage important en début de série mais elle possède un débit inférieur
car de nombreuses opérations sont manuelles lors de la production. La seconde machine possède un débit 5x
supérieur mais doit être configurée pendant 4 heures avant de commencer une série, elle est donc généralement
utilisée lorsque les quantités nécessaires sont beaucoup plus importantes.
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Supposons maintenant que ces deux procédés de fabrication permettent d'obtenir les mêmes jus mais à des coûts
et séquences d'opérations différentes. Notre producteur possèdera donc deux nomenclatures pour le même jus,
une pour chaque machine. Chacune de ces nomenclatures possèdera une gamme différente contenant les
séquences d'opérations sur la machine concernée.

Il faut alors définir des propriétés qui permettront au commercial, sans connaître les techniques de fabrication,
d'agir sur le choix de la méthode qui sera utilisée. On définit alors trois propriétés telles que: prototypage, petite
quantité en urgence, faible coût pour quantité supérieure à 8000L . Ces propriétés sont définies par le menu:
G.P.A.O. > Definitions > Propriétés > Propriétés.

On attache alors les propriétés aux nomenclatures via le troisième onglet:

Machine 1: prototype -- petite quantité en urgence,• 
Machine 2: faible coût pour quantité supérieure à 8000L.• 

Lorsque le commercial fera un devis ou un bon de commande, il pourra donner les propriétés souhaitées sur
chaque ligne de commande. En fonction du choix du commercial, Tiny ERP sera capable de planifier les temps,
coûts et matières.

Attention, il ne faut pas confondre produits configurables et variantes de produits. Les variantes
déterminent des produits différents tandis que les produits configurables permettent de définir
plusieurs méthodes de fabrications du même produit. Il n'est pas rare de devoir utiliser une
combinaison des deux concepts.

Assembleur d'ordinateur

Prenons maintenant le cas d'un assembleur d'ordinateurs qui possède deux produits phares 'PC de bureau' et 'PC
de luxe'. Les fiches techniques des produits permettent à l'entreprise d'être relativement flexible sur le choix des
composants qu'elle assemble dans un produit 'PC de bureau'.

A chaque fabrication, il faut décider si l'on utilise des composants SCSI ou IDE. Les composants SCSI sont
moins performants mais plus durables et possèdent une garantie de 3 ans. L'entreprise définit alors les deux
propriétés suivantes appartenant au même groupe de propriétés: 'garantie 3 ans mais moins rapide' et 'garantie un
an mais plus rapide'.

Deux nomenclatures pour chaque carte mère sont alors créées, l'une garantie 3 ans utilisant du SCSI et l'autre plus
performante mais garantie 1 an utilisant de l'IDE. A chaque approvisionnement ou vente client (si le produit est
défini en 'make to order'), l'utilisateur pourra spécifier les propriétés de l'ordinateur de bureau ou de luxe choisi.

Les propriétés ne sont pas des produits mais bien des concepts qui sont définis librement par
l'entreprise. Ces propriétés permettent de sélectionner la bonne fabrication à utiliser pour un même
produit.

Nomenclatures multi-niveaux et fantômes

Dans Tiny ERP, il est également possible de définir des nomenclatures pour les produits intermédiaires. Ce
produit peut alors être utilisé par plusieurs produits finis.

Pour ce faire, définissez simplement plusieurs nomenclatures via le menu: Produits > Nomenclatures. Si les
produits intermédiaires ne sont pas gérés de stock mais à la demande, il suffit de les configurer en mode
d'approvisionnement 'Make to Order'. Ainsi, pour combler une demande en produits finis, les fabrications se
feront en plusieurs ordres: fabrications des produits intermédiaires et ensuite fabrication du produit fini.
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Cette construction en plusieurs nomenclatures est très intéressante car elle permet de gérer des sous-ensembles
communs utilisés par plusieurs nomenclatures. Une modification dans l'un de ces sous-ensembles est alors
directement répercutée sur toutes les nomenclature qui l'utilisent.

La figure suivante représente les nomenclatures de deux produits finis qui utilisent le même sous-ensemble
correspondant au produit intermédiaire: Regular Processes Config.

Le problème d'une telle représentation est que lorsqu'il faudra produire un PC Basic, deux ordres de fabrications
seront automatiquement générés par Tiny ERP: une demande pour un Regulare Processor Config et ensuite une
demande pour le PC Basic.

On peut forcer Tiny ERP à ne générer qu'un seul ordre de fabrication incluant les deux nomenclatures d'un coup
en marquant la ligne Regular Processer Config de la nomenclature PC Basic à nomenclature fantôme. Dans ce
cas, le calcul des besoins ne passera pas par le produit intermédiaire et la fabrication incluera directement toutes
les matières premières: CPU1, MB1, FAN, RAM, TOW1, HDD2. Ces nomenclatures sont appellées fantômes car
on ne passe jamais par ces produits intermédiaires "fantômes".

Une autre méthode de construction de nomenclatures dans Tiny ERP sont les nomenclatures multi-niveaux.
Chaque ligne de nomenclature est elle-même une nomenclature, vous pouvez alors définir plusieurs niveaux, sans
limites sur ceux-ci. Dans ce cas, l'ordre de production sera exécuté en une seule fois comme dans une
nomenclature fantôme. Seulement, à la différence des nomenclatures fantômes, les sous-niveaux d'une
nomenclature multi-niveaux sont attribués uniquement à la seule nomenclature pour laquelle ils sont définis. Tout
un niveau peut être déplacé dans une autre nomenclature en modifiant le champ 'Nomanclature Parent' d'un
sous-niveau. La figure suivante présente un exemple de nomenclature à deux niveaux:
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Produits de substitution

Tiny ERP permet de définir plusieurs nomenclatures pour un même produit. Si plusieurs nomenclatures existent,
le calcul des besoins va sélectionner la bonne en choisissant la nomenclature dont les propriétés correspondent le
mieux aux propriétés demandées lors de l'approvisionnement. Si les propriétés requises sont équivalentes pour
deux nomenclatures, ou si aucune propriété n'est spécifiée, Tiny ERP prendra la nomenclature avec la sequence la
plus faible. La sequence est donnée dans le troisième onglet du formulaire de définition de nomenclature.

Cette fonctionnalité permet d'implémenter simplement des nomenclatures de substitution ou des produits de
substitution. En effet, si un produit ou une nomenclature n'est pas adapté, Tiny ERP peut en choisir une autre.

Pour faire des produits de substitution, vous devez marquer les nomenclatures qui utilisent ce produit en
'Fantôme' et pour chaque produit de substitution définir une nomenclature d'une seule ligne. La figure suivante
donne un exemple de produits de substitutions pour un disque dur:

En effet, selon ces 3 nomenclatures, lorsqu'un produit "HDD on demand" sera nécessaire, Tiny ERP choisira
automatiquement parmis les 3 méthodes possibles. Si des propriétés sont définies, celles-ci permettront de raffiner
ce choix.
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Routings

The routings determine the operation sequence oto do for each manufacture. You can associate a routing to each
nomenclature. The routings are defined in relation to the workcenter. A workcenter can be either human resource,
a machine or a tool.

The routings are optional, but if you use them, that allows:

to automate undertaking to accpet responsibility of the costs machines and human resources for each
work order. These costs are transfered in the analatycal accounting according to definitions of the
workcenter and the routing.

• 

to calculate and plan the future capacities on each workcenter.• 

Then the routings are used for manufacture having one of the following characteristics:

the costs of the workcenters are not negligible in relation to the material first costs,• 
the plannification of manufacture must take account into the output of each machine• 

Workcenters

Before defining each routing, it is necessary to define the workcenter of the company. You can create them via
the menu: G.P.A.O. > Definitions > Workcenters.
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A routing represents a resource or a whole of several resources considered as identical. Thus allocate a specifict
name to each workcenter. The code of this one is optional and doesn't have other effects only to make esaier
research and print themselves on the paper documents.

Then indicate the type of routing: human resources, machines or tools. A machine is considered as belonging to a
room while a tool can be moved. That it's for human resources or a machine, you can indicate a timesheet which
determines the operation schedules of this resource.

Then, information on the capacity makes it possible to deduct the time and the number of cycles necessary to
manufacture according to the quantity. Generally human resources necessary are numbered in hours while the
machines and tools are counted in cycles. Only, you can use a combination of both for the same workcenter: a
technicians team each one having the same tools and machines.

Time for a production cycle is given in hours. Time before-production is generally used for the machine settings
and time after-production for cleaning. These three parameters make it possible to calculate the real time of
consumption of this workcenter for a work order. Indeed this one will be calculated as follows: Time of use of the
workcenter = Time Before-PROD + # Cycle * Cycles Times + Time After-Prod. These parameters are generally
given by the machine chart. Only one machine wears out in time, this is why you can use the 'temporal
effectiveness' field to decrease or increase this result by a factor. A temporal effectiveness of 0.9 indicates that the
machine is 10% faster than its technical data.
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The cycle capacity indicates the number of identical resources present in your workcenter. Attention not to
confuse cycle capacity and time for a cycle. Thus, a cycle capacity of 6 and one cycle of 1h indicates that you can
produce 6 parts in parallel and, if only one part is produced, that will even so take 1 hour. Conversely, a cycle
capacity of 1 and a time by cycle of 10min will make it possible to produce only one part in 1 minute but if 6
parts are produced that will also take one hour. In that last case, the productions are made one after the other.

Lastly, costs information of use of the workcenter makes it possible automatically to generate analytical entries
on the stations of production. To do that, it's necessary to give the costs per hour and/or the cycle costs for each
post. For each cost, it's necessary to give an analytical account in which the entries will be automatically charged.
You have also to specify an analytical journal and a voucher. This last is only used to mark the type of
transactions of the analytical entries. No charge is made in the general accounts.

The routings

Once the workcenters of the company defined, you can create the routings for each nomenclature. To do that,
directly define the routing from the nomenclature concerned or use the menu: G.P.A.O. > Definitions > Routings.

Each routing must have a name and a code can it be associated.

If you indicate a location for the routing, that indicates that manufacture will obligatorily be done on this site. If
you don't indicate any location, that by default in the production order will be used. At each work order, Tiny
ERP generates a request for internal inventory movement to move the raw materials in the location indicated in
the routing or the order. If the raw materials exist in this location or a child location, the inventory move will be
automatically done without manual confirmation. You understand the importance to set well the locations
structure.

Then the routing indicates all the workcenters used, for how long and/or cycles. If a sequence number is
indicated, it makes it possible to determine the operations order of manufacture.
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Once the defined routings, you can use them on any level of the nomenclatures. If a routing is indicated for the
nomenclature, the third tab of a production order (workcenters) will be automatically pre-completed.
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Production orders

Generally, the production orders are automatically generated by Tiny ERP. We will start by seeing how to
manually create an production order for seeing how to treat the automatic requests.

To encode a new production order, use the menu: G.P.A.O. > Work orders. A virgin form allow you to encode
new orders open. Start by indicating the order name, the planned date of production and the order priority. The
manufacture name can be defined via a sequence (see the chapter on the administration of Tiny ERP).

The planned date makes it possible to plan future stock but also to know the time necessary for the supply raw
materials for this order. This date determines the maximum date of production end for this order. The beginning
date of manufacture, or the deadline to obtain the raw materials necessary, is given by the planned date which you
deduct the number of days given in the product feature on the 'Manufacture expand' field.

Then, fill in the product field: use product 'CPU_GEN - Regular processor config' if you use the available
demonstartion to the installation. The measuring unit and the quantity by default are automatically indicated.

The nomenclature field can remain empty, it will be filled by Tiny ERP at the time of the order confirmation. It's
important that a nomenclature is defined for the product which you wishe to manufacture, otherwise Tiny ERP
won't manage to calculate the production order.

Lastly, you have to complete the two fields of location. The first indicates where must occur manufacture and the
second indicates where the products must be sent manufactured. If you use the demonstration data, put 'Stock' in
these two fields. You can encode in default value (thanks to the click right of the mouse on the field) because it is
rare to change these preferencies.

You can click on the 'Calculate' button and Tiny ERP automatically will calculate the goods planned to consume
and the workcenters to be used. Tabs 2 and 3 of production order are competed.

Then click on the 'Confirm Production' button to validate the request. The production order is put in the receipt
stand by state of the raw materials to consume. You obtain the following figure:
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A picking list was generated to bring the goods to the production site. This picking list will be automatically
validated by the needs calculation because the 'auto-picking' is ticked. As soon as the goods are available, the
work order will be activated automatically. The orders to be started are available by the menu: G.P.A.O. > Work
orders > Production Orders Waiting Goods.

Then you will be able to press on the 'Start production' button when you begin manufacture from the matters.
These products are withdrawn from stock at this moment.

At any moment, you can modify the goods quantities consumed to encode the surpluses or not enough consumed
goods. It's the same for the workcenters, you can modify the last hours or cycles gone that will have an influence
on the production costs in the analytical accounting.

Also, you can modify a production order line to add a serial batch number or a manufacturing batch number. To
do taht, click on the product which you wish to mark and fill one of these two fields necessary to the traceability.

Lastly, when the finished products manufacture is finished, press on the 'Made' button, Tiny ERP makes
automatically the materials appearance to the location marked by the 'Destination Zone' field.
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Production followup

Planning

Planning is made automatically by the scheduler according to the dates and priorities planned of all the confirmed
kinds of production. It's also the scheduler which is in charge of supply proposing (internal picking list) for
manufacture.

When the responsible for production connects himself, it can obtain the proposal for a scheduler planningvia the
menu: G.P.A.O. > Work orders > Production Orders Waiting Goods. Then it can modify the different orders to
change the planned manufacture date.

Workcenters followup

The production planning is done with infinite capacity. It doesn't take account into the possibly limited resources
of each workcenter. That makes it possible to produce each day more or less that the maximum capacity. That
also makes it possible to use planning without to define all the workcenters and all the tools taking place in a
production.

To control the planning validity, the production responsible can select the workcenters which it wishes to analyze
via the menu: G.P.A.O. > Definitions > Workcenters. Once the list selected, Put you in list mode and click on the
'print' icon to ask for a graph of the future load for the selected stations.

Tiny ERP asks for the analysis type (day per day, week per week or month by month) and if you wish to analyze
the cycles or times. Once these data completed, the graph of the following figure is generated.

This graph allows to check that human resources won't have to work more 8h per day to remain in projected
planning. You can calculate again this graph after each dates modification in the work orders.
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Technical features

Basic functions

Management, manufacture control.• 
Production planning.• 
Effectiveness of the nomenclatures, workcenters and routings.• 
Supply and treatment of the stock exceptions.• 
Integrated planner.• 

Nomenclatures

Boundless multilevel nomenclatures on the levels number.• 
Configurable products and properties.• 
Phantom nomenclatures.• 
Nomenclatures of substitution.• 
Integration of subcontracting and the services/tasks.• 
Management of the rates of rebus.• 
Routings at different levels.• 
Production given rhythmed or by series.• 
Management of the services.• 
Tool for duplication of nomenclature.• 

Routings

Using again of the routings at differents levels of the nomenclatures.• 
Work with the cycle or hour.• 

Workcenterss

Machines, tools, labour.• 
Integrated into the analytical and general accounting.• 
Integration of the schedules.• 
Plannings of the prjected load and comparisons.• 

Scheduler

Planning in infinite capacity.• 
Calculation in possible tended flow.• 
Follow-up of the differents expands.• 
Interventions for possible manual corrections.• 

Traceability

Management of the parcels norm SSCC.• 
Management of the manufacturing batches, consuming batches.• 
Management of the job numbers.• 
12 codes bars supported.• 
Traceability upstream/downstream out of tree.• 
Follow-up and control of the technicians.• 
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Products

Management of the gauges and alternatives.• 
Multiple measuring units and automatic conversions.• 
Substitute products.• 
Properties of products.• 
Possible automatic update of the cost price.• 
Several logics of production.• 
Possible use of the DLC, DLUO, alarm dates and dates of withdrawal of stock.• 
Packaging Management.• 

Exceptions

Treatment effective and centralized exceptions and forecasts.• 
Possible cancellations.• 
Support of negative stocks.• 
Use of the request system.• 

Production orders

Follow-up of the material planneded compared with the really consumed material. * To slip/stick to
reorder the production orders.

• 

Comparison of planned and real time by workcenter.• 
Automation of the series.• 
Consumption and productions in several times.• 
Support of manufacture in the supplier.• 
Support of the double measuring units so necessary.• 
Promotion of stock automated.• 
Automated serial or not.• 

The multi's

Multi-warehouses.• 
Multi-units of production.• 

Inventory control

Fast detection of the errors thanks to the inventory control double-entry.• 
Promotion of the rebuses and consumption/productions thanks to the analytical stocking locations.• 

Integration

Integration with the general and analytical accounting.• 
Integration with the stocks control and the tasks follow-up.• 
Integration with the human resources module.• 
Native integration with restockings.• 

Total flexibility

All the screens are personnalisables (seized, lists, states, research�)• 
Rights fine management and the menus by user.• 
Remote access via Internet.• 
Configuration of the possible process and alarms.• 
System of requests integrated.• 
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Extensible via many optional modules.• 
Process personnalisables.• 
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Project management
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Projects management

The services and the tasks management in Tiny ERP is organized in projects. These projects are hierarchically
structured without levels limits. You can obtain the list of all the projects in progress via the menu: Projects > All
Projects, or Projects > All Projects > My Projects to obtain only the projects list for which you are the
responsible.

The following figure presents the demonstration projects configured during the first Tiny ERP installation:

You can see there that the 'Tiny ERP intergration' project was structured in 3 phases: study, development,
installation. Each one of these phases is a fully project.

All the projects can contain a list of task to to do, those are split between the different project members. In the
following chapters we will see how to define projects, tasks and how a good project management occurs.

Definition of a project

To create a new project, use the menu: Projects > All Projects > Modify Projects.
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You have to allocate a project name, a responsible, possible end and departure dates as well as the project
members.

In top on the left, you find the 'Active' field which allows to hide a project. It's preferable not to directly use this
field but rather the button 'Activity Joined'. Indeed, this one will deactivate the project but also all sub-projects
and associated tasks. Deactivate a project completely can be very interesting to create 'Types projects'. Indeed,
create a type project and deactivate it. When you wish to make a new project on the basis of this type project, you
have to to reactivate it and to duplicate it.

On the right 'Leader project', you have a check box 'Inform Leader Project'. If this box is tickeded, as soon as a
task is closed for this project, the project responsible will receive an alarm via the request system integrated of
Tiny ERP. This alarm contains all the linkss towards the project, the task and the user which did the work. This
option is interesting at the time of critical projects where the project reponsible has to control the work done by
the differents actors.

The planned and done hours are automatically calculated by Tiny ERP, these fields correspond to the sum of the
hours planned and done in all the tasks of the project. If the project has sub-projects, you will find the accrued
sum of all the lower levels than the project in the progress.

For each project, you can indicate an time sheet. This one is used automatically to calculate the tasks planning
according to this schedule. You can use an existing schedule (magnifying glass icon) or create new (blank sheet
icon). This field is optional, if you don't indicate any time sheet, the tasks planning is based over 8 working hours
by day, bank holidays included. The following figure presents a work schedule from Monday to Friday with one
hour of pause at twelve:
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These schedules can also be defined in the human resources module via the module: Human Ressources >
Definitions > Workgroups.

In the second 'Partner Information' tab, you'll find all information relating to the customer. An effect, a project can
be attached to a customer but it isn't obligatory. If the project isn't specific to a customer, each task can also
individually be attached to a customer.
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Tasks

The tasks represent the operations which have to be done by the users. These belong obligatorily to a given
project.

To encode the tasks for a project, there are several methods:

from the 3rd edition form tab of a project,• 
via the menu: Project > All tasks,• 
or after having double-click on a project to obtain the tasks in progress.• 

We generally use the first approach when we wishe encode several tasks peculiar to the same project, these tasks
are at the same time defined as the project. The others approaches allow encoding after several tasks belonging to
differents projects.

The tasks are assigned to a project and can have a responsible user or not. At the task creation you can encode the
planned hours to treat this task. Then, as soon as a person works to finish this task, he can encode a 'Task Work',
including:

the date of work for this task,• 
a summary of done work,• 
the user having contributed,• 
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the time spent for this work.• 

The 'hours effective' field of a task is automatically calculated thanks to the sum of the done work this task. The
'progress' field determines the progress of the task, from 0 (no work done) to 100 (the task is finished).

When a task is created, it's in the 'Open' state. The user has two buttons to make change this state: finish or cancel.
When this one presses one of the two buttons, the task state changes and the field 'progress' is put automatically at
100.

If the project were configured to inform the customer when the task is finished, a form opens then automatically
with the email which will be sent to the customer. You have the choice between: cancel, finish the task and send
the email, finish the task without sending email. The email will be sent to the customer indicated in the task and if
there is no partner associated with the task, the email will be sent to the partner defined in the project. If neither
the task nor the project have link towards a partner, dialogue box will require of you explicitly of which to send
the warning. The heading and the signature of the email are configurable in the second tab of the project feature.
The signature indicated in the user feature is also added at the end of the email.

The following figure presents an example of heading and signature of the email, by using the possible variables
such as the date, the name of the task, etc.
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To the email sending correctly works, you have to install a server email locally on the machine
of the Tiny ERP server.

Moreover, at the end or cancellation of a task, if the project were configured to inform the project leader during
the change of statute of a task, this one will receive a request automatically. All information relating to the task is
attached to the request. If it's leader itself which finishes the request, the system will obviously not send a request
to him.

Lastly, once the finished or cancelled task, you can always reopen it while clicking on the 'reopen' button.
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Project management

Project members

Each user have then to treat his own tasks list in progress. When a user wishes to obtain his tasks list, he uses the
menu: Project > All tasks > My tasks > My tasks in progress. The list of the open tasks opens then. These are
sorted by priority, you have to treat them one by one while beginning by highest in the list.

Each time a work is done in a task, the user completes the 'Work done' field in bottom of the task. If this one is
cancelled or finished, he pushes on one of the buttons. He can also allocate this task to an other project member
by changing the value of the 'responsible' field.

Project leader

The role of the project leader is to define new projects and possible tasks, manage the differents priorities, plan
the project, check the users work and invoice the done hours or projects made.

Classification of the priorities

The classification by tasks priorities is allocated according to 'Sequence' field (Other Information tab), 'Priority'
and 'Deadline'. More precisely, Tiny ERP starts by sorting the tasks according to their sequence number. All the
tasks having the same sequence number are sorted by priority. The tasks having the same priority and the same
sequence number are sorted by deadline.

This classification according to differents criteria is very interesting to treat all case types. Here two frequent
examples:

A support contract: in this case, all the requests for support have the same sequence number which is
allocated by default, that is 10. The support tasksare then sorted by priorities and by deadline, it's the
desired effect. You can add new tasks at any time and these will come to be inserted according to their
priority. Planning is then automatically recalculated.

• 

A complex project: in this case, certain tasks depend on other tasks and can start only when the previous
tasks are finished. Then you use sequence numbers to order the differents phases of the same project.

• 

For certain tasks, you can tick the 'Await tasks' box. In that case this task will be able to start only when the
precvious tasks will be finished. Otherwise, if the tasks are allocated to different users, Tiny ERP will be able to
suggest treating them in parallel.

The priorities between differents sub-projects of the same project are given by the value of the 'sequence' field.

Plan a project

Planning in Tiny ERP can be done starting from a project or of a tasks selection.

To ask for the project planning, select it and click on the printer. If this project has sub-projects, planning will
then take all the associated tasks. The used attendance sheet is individuallt given in each project.

If you wish to print a planning starting from a tasks selection, made a research among all the tasks according to
certain criteria and click on the printing icon. The tasks can be all users and all merged projects. This
functionality makes it possible for example to print the user planning; select all the open tasks of a user and print
them.

This planning is reccalculated with each printing, if the tasks evolved since the last printing, the graph of Gantt
will be thus different.
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Checking of the services

The project leader is also responsible for his projects go smoothly and thus to check the done work by the
differents users. To do that, He has to be admitted to the menu: Project > All tasks.

To determine the projects progress in a overall way among all the projects in progress, you can follow the projects
tree and information of planned and done hours. These same details are accessible task by task if you double-click
on a project.

If a costs control is necessary, you have to assign the project on an analytical account in the second tab of the
project feature definition, 'Accounting Class'. That makes it possible not to do a double encoding between the
done services by task and the encoded services by analytical account during the encoding of the hours by the
employees at the end of the day. To use this functionality, 'hr_timesheet_project' module have to be installed and
the users have to encode their services of day's end thanks to the menu: Human Resources > Encoding of the
hours > For me > Today's work (import from project).

During critical projects, the responsible can activate the 'warn the project leader' option in the project definition.
Then he will receive a request every time a task is finished.

Invoicing of the services

Before using the invoice functions automated starting from the tasks, it is necessary to configure the second tab of
the project. The following figure presents information necessary to the invoice:
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You have to point:

a partner and a contact: these fields are optional because this information can come from the
taskdefinition in this project. You have to fill them only when the project is dedicated to a customer.

• 

an analytical account: optional, only if you want to make a follow-up of the costs or a management by
business,

• 

A pricelist: this field is obligatory if you wish to generate orders forms, it's automatically completed
according to the selected partner.

• 

A price and a mode: the mode can be at the hour (planned), at the effective hour or to the project. If the
project is subdivided in sub-project, you can apply a price for each phase of this project.

• 

An outlet: necessary if you wish to generate orders forms.• 

In Tiny ERP, it is thus possible automatically to create orders (which will generate themselves invoices) thanks to
the tasks. To do that, the project leader uses one of the sub-menu of the menu: Project > All tasks > Tasks to
invoice.

Then he obtains the list of all the tasks to invoice and not yet invoiced (tasks open or finished, according to the
menu). To generate an order form starting from these tasks, it's necessary to click on the gears. Tiny ERP gives
you the amount to invoice and asks you then if you wish to generate a quote or a firm control. Select your choice
and validate the dialog box. A confirmation will certify that the orders are well created.

If the tasks contain products (services or storable), those are automatically added to the order form. Their rate
depends on the pricelist selected. That makes it possible to manage industrial projects, for which it's necessary to
deliver finished products.

An interesting note is that you can manually filter the tasks which you wish to invoice thanks to research, before
selecting the gears.

Also, if you wish to invoice several tasks of a blow, check that you are in list mode. Indeed, if you are in form
mode, only the screen resource will be invoiced.
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Technical Features

Basic functions

Management of the projects and tasks.• 
Projects of services, industrials or of development.• 
Multilevel sub-projects, without limit on the levels.• 
Support of the templates projects.• 
Desactivation/Activation of whole projects.• 
Copy projects and modification of projects.• 

Project follow-up

Alarms automated by email to the customer for the support projects or the qualities surveys.• 
Request to the project leader for control to the task end.• 
Flexible rights allocation and configuration of the project by the project leader. * Internal project,
customer project or assignment by task.

• 

Progress control of the project by phase and/or sub-project.• 

Planning management

Complete management of the schedules and the working groups.• 
Schedules assigned by project or user.• 
Automated replanning.• 
Seizure in list mode work.• 
Gantt graph: by project, by user, group or for a given selection.• 

Tasks

Scheduling by priorities, hierarchical sequences, and/or deadline. Support of the drag & drop.• 
Reallocation system of the tasks.• 
Specific menus for each user according to the role.• 
History of the interventions on each task.• 

 * Management of the points of sale and the price lists for the tasks.

Ergonomics

Navigation thanks to the trees, the relations and the system of cross comparison. * Colors codes used for
a fast states visibility.

• 

Fast seizure in list mode.• 
Different possible views according to the role and the made use.• 
Many keyboard shortcuts.• 

Invoice and quote

Drafting of automated quote on the basis of template or pre-project.• 
Invoices on the basis of task; by project/sub-project, by planned hour, by effective hour.• 
Validation of a quote can launch tasks.• 
Possible association of the tasks to the products.• 
Several invoice logics.• 
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Complete integration

Completely integrated into the other ERP modules; sales, production, purchases, ... * Release of the tasks
according to differents needs; production, purchases, subcontracting, delivery, ...

• 

Support of the industrial tasks.• 
Complete traceability and control of the modifications thanks to the audit module.• 

Control costs

Completely integrated with the analytical accounting for a high level reporting and a management by
business.

• 

Management of the costs according to various measuring units.• 
Automatic completing of the timesheet at the day's end /the week thanks to the tasks.• 
Support of the budgets.• 

computing projects

Support of the nimble methods of 'SCRUM' development.• 
Product backlog for the interface between the technical tasks and the functional needs for the customer.• 
Management of the 'sprints', roadmaps, 'daily meeting' and scrum master.• 
Burndown Chart: by group of task, project or customer need.• 

Extensible

Addition of optional modules available on TinyForge.org.• 
Optional risk module management.• 
Quality module management.• 
Visibility of the done work directly in the customer feature if activated.• 

Total flexibility

All the screens are customizables (seized, lists, states, researc...)• 
Support multi-languages and multi-companies.• 
Fine management of the rights and the menus by user.• 
Remote access via Internet.• 
Configuration of the procesus and possible alarms.• 
System of requests integrated, release on the state basis of the tasks.• 
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Marketing operation
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Marketing Flow

The above figure represents marketing flow. This flow is composed of different successive phases: prospective
buyers are created first as partners, then comes the creation of the marketing campaign, make up of all its stages,
and finally, when the campaign is completely finished, it'll lead to business appropriatenesses ,which will lead to
quotetes, ect (see Sales flow).

The marketing module is mainly used to make the follow-up of the campaigns marketing. You have a certain
number of prospective buyers to contact once, and little by little, this number will progressively fall untill many
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reminders. The various contact stages of the prospective buyerer can be organized according to (order to be
followed) sequences and to use different channels of communication (example: you send initially a letter, then, if
it's positive, you contact by email for finally finishing by a phone call to confirm an agreement or other). At the
end of the campaign, it will remain only serious prospective buyers which will probably give place to business
opportunities that your marketing person will have to make evolve to the contract signature or to the creation of
an order form or a quote.
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Campaigns

The creation of a campaign is done in the menu: Operations Marketing > Definitions > Campaigns

The definition form of a campaign is presented as follows:

A campaign can be defined in time. To specify times for the expand of a campaign, you have to complete the
'beginning date' and 'ending date' fields. A calendar will automatically open if you click on the 'magnifying glass'
icon.

Various costs can be associated to the marketing campaign. There are first of all the original costs (or fixed costs)
which refer to all the prior expenses of the campaign itself. Then you can encode the costs and incomes planned
for the campaign in order to check if the differents launched actions are profitable. These data are purely
informative.

In our example, the campaign named 'Marketing Campaign : Solutions Linux 2005� isn't delimited in time, we
noted initial expenses of an amount of 500 EURO (costs of the startup of the campaign), we consider a total cost
of 2500 EURO but hope for an income planned at 15000 EUR.

A description more in detail of the campaign is possible thanks to the "Description" field.

It remains to define all the steps of the campaign. In our example, the campaign has 3 steps: send a letter to the
contact, confirm by email and finally, agree to do an appointment, phone and send some booklets to him.

To create a new step, use the 'New' icon of 'Etaps' field, you will then obtain a creation feature of an etap.
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Etaps are classified by sequence order. They can be characterized by a date of beginning and of end, you can
associate it a rate of success planned as well as an planned cost. The ' Tests maximum numbers' field determines
the number of times where the etap will be repeat.

In our example: The first etap consists in sending a letter (sequence=1). We estimate a rate of success of 10%
(that is 10% of the people having received a letter will answer us), and a cost of 50 hundreds by letter (because
the euro is the currency chosen by default). We will send only one letter to each contact (a test maximum
number=1).

When your campaign and its etaps are created, you have to save it. You will find this campaign and the other
possible ones in the list of the campaigns of the menu: Operations Marketing > Campaigns

It's now necessary to determine which will be the people (contacts, prospective buyers, partners, etc) who will be
concerned by this campaign (who you have to call?). These different contacts won't be quite as interesting the
ones as the others. You will have to classify them by set of priorities, which will directly enable you to see the
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most urgent calls to do. When you are on the campaigns lists, choose one of the campaigns and click on the
'Actions' button. Then you will be able to select the partners who will be contacted for each campaign etap.

After having specified the first campaign etap, the partner (or group of partners) as well as the campaign
responsible, you have to select a partner list (via 'Add' button) and to add them to the campaign while clicking on
'Add these partners'.

It is completely possible to add various partners lists with different priorities (according to whether they are more
or less interesting). The software will then classify them by set of priorities.

Now that partners were added to our campaign, you can, in the campaigns list double-to click on our example
(Marketing Campaign: Solutions Linux 2005) and see the list of all the partners concerned with this campaign.
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Prospect follow-up

After having associated partners to a marketing campaign, you obtain their list while double-clicking on the
concerned campaign (from the menu: Operations Marketing > Campaigns)

This list thus gathers all the partners that it's necessary to contact for the campaign. They are classified according
to their priority (prior set, at the addition time of the partners in the campaign: see previous etap).

If you double-click on one of the partners, you will open his follow-up feature.

Prospect follow-up 231

18/09/06



1

This feature is made up of 2 parts. The first gathers information on the prospect (name, address, contact, notes,
etc) and the second is on information relating to the etap (the name of the etap, priority, comments and possibly,
the date if the prospect has to be call later).

At each campaign etap, for each partner concerned, you have to lauch the etap (send a letter or an email, etc) and
if this etap is finished, click on 'Continue Campaign'. The partner will go directly to the following etap. When all
the etaps are fulfilled, to announce it while clicking on 'Stop Campaign'.

All the history of the actions made for the partner is included in the second tab of the follow-up feature of the
partner.

Prospect follow-up 232

18/09/06



1

Prospect follow-up 233

18/09/06



1

Marketing technical sheet
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Joomla being one of the most development platforms of widespread Web sites currently, it was useful to create a
link between TinyERP and a platform eCommerce of Joomla.

There are several platforms of eCommerce under Joomla, VirtueMart being l' editor pick , it's also that one which
we chose

For more information on the Joomla installation or of VirtueMart, you can go on one of the following sites:

http://www.joomla.org• 
http://www.joomla.fr• 
http://virtuemart.net• 
http://www.joomlafrance.org/telecharger/fileinfo/VirtueMart.html• 
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Describe eCommerce flox HERE.
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In this part, we will see how to integrate TinyERP with a fresh installation of Joomla/VirtueMart. The installation
of Joomla/VirtueMart isn't covered by this book, if you test difficulties to do this installation, defer you to
documentation available on the sites listed in the introduction of this chapter.

Module installation in TinyERP

...

Connector installation on the Joomla/VirtueMart site

You have to copy the file TinyERP syncro.php being in the bin/addons/ecommerce/connectors/VirtueMart
repertory from your Web server at the root of yourJoomla installation

Integration between TinyERP and Joomla/VirtueMart

The integration of TinyERP with VirtueMart takes place in 7 étaps

Creation of the products categories in VirtueMart1. 
Creation of the taxes in VirtueMart2. 
Creation of the eShop in TinyERP3. 
Initial import in TinyERP4. 
Mapping of the categories and the taxes in TinyERP5. 
Addition of the products TinyERP in the eShop6. 
Synchronization of the products between TinyERP and VirtueMart7. 

Creation of the products categories in VirtueMart

VirtueMart includes the possibility of associating the products to (sub-)categories of products in order to allow a
better organization of the site. To create a new products category, open the category form: "Products" => "Add a
category".

Creation of the taxes in VirtueMart

VirtueMart has taxes calcul faculties very different from those of TinyERP. Thus it's necessary to create the taxes
in VirtueMart AND in TinyERP.

In VirtueMart, there are two ways to calculate the taxes:

based on the place where the salesman is located.1. 
based on the place where the purchaser is located.2. 

It is strongly advise to calculate the taxes according to the place where the purchaser is to keep a compatibility
with TinyERP.

To add a taxes rate, in "Taxes" => "Add a Rate of Taxes" in the adminsitratoin menu of of VirtueMart admin
menu.

Creation of the eShop in TinyERP

In the Menu eCommerce / Website of TinyERP, you have to create a eShop, that is an outlet on internet. For each
eShop, you have to specify the address where the root of your Joomla site is (where you placed the connector
TinyERP) as well as a partner by default. The partner by default is the Web equivalent of a sale counter . The
differents addresses (invoice, delivery, etc) introduced into VirtueMart will be added to this partner.
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Initial import in TinyERP

Before to put our products on Internet, we'll now have to import the differentss categories and taxes available of
the Joomla/VirtueMart site. This operation is to be done only once in general. You will have to repeat it only if
you add/remove taxes of the Web site.

Since it's much more frequent to add/remove one or several categories, there is tendency with this action which
only imports the categories of VirtueMart without changing the taxes.

Mapping of the categories and the taxes in TinyERP

Once the initial import done, we now will create the mapping , the link, between the categories and taxes of
TinyERP with those of VirtueMart. This operation is to be repeated during creation/deletion of a tax or a
category.

If you change the tax rate on the site (and for well done, in the ERP) it isn't useful to remake
the import, since these taxes have their correspondence (this one doesn't change) in the ERP
and on the Web site.

Addition of the products TinyERP in the eShop

Maybe you will sell your products on several sites and you won't sell full/the same ones of your products on all
the sites, there the usefulness to be able to choose which products will be on sale on a given site eCommerce.
Don't worry, this operation which may be tiresome will have to done only once by Web site.

Any modification made thereafter could be automatically deferred on the site

Synchronization of the products between TinyERP and VirtueMart

It only remains to synchronize our TinyERP products with those of the Joomla/VirtueMart site thanks to the
action of the same name.

This action updates (stock, descriptions, price, picture, etc) the products TinyERP on the
Web site. If you modify a product in TinyERP, don't forget to relaunch this action to see the
change on the site.
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Use

The use of the eCommerce Joomla module remains simpler. Once the initial configuration done, you have to
regulary import your orders in TinyERP and with to treat them like any other order of the ERP.

In order to to preserve stock synchronization between your ERP and your Web site (especially useful if you sell
goods by another way than the Web or if you sell via several sites), it's necessary to do a stock update.

During the stock update, the statute of the pending orders is also updated so the customer can
follow the progress of his order on Internet without any additional intervention of your share.
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eCommerce technical sheet
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Password required

Password:
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Password required

Password:
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Password required

Password:
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Password required

Password:
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Password required

Password:
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The Tiny ERP project
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Differents actors

As most of the important free software, Tiny ERP is a project at the same time collaborated, structured and
directed project. To understand that, it's necessary to differentiate three kings of actors in the software activity:
contributors community, the companies partners of Tiny ERP and the Tiny editor.

Community contributors

Tiny ERP is a free software as defined by Free Software Foundation. Everyone is thus free to download it, use it,
modify it,as well as redistribute it just as it is, or by integrating its own modifications.

We call contributor any person who takes part in the Tiny ERP activity. This participation can be done at
differents levels: drafting of documentations, answer to the questions in the forum, seeks and reports bugs,
program and documents translation, developments of new modules...

You don't have to see the contributors like voluntaries but rather like people or companies movtivated by personal
needs in the software. These needs (software comprehension, new functionality, support of a new language)
imply a work of their share, work which is transferred to the community for the growth of the software.

This addition of the done improvements carried to the project is even a legal obligation on the level of the
developments. Indeed, GPL licence under which is published Tiny ERP obliges any modification to be also
placed under a free licence, which makes anyone possible to freely benefit from all the modifications made to the
software.

The contributors don't have contractual links with the Tiny company but the communication between the
differents actors is organized thanks to the tools implemented on the http://TinyERP.org site. Among these tools,
we find:

A forum to organize the communication: http://tinyerp.org/forum• 
Mailing lists for the public advertisements: http://tinyerp.org/lists.php• 
A wiki for the collaborative drafting of documentations: http://tinyerp.org/contributors.php *The
collaborative system of development Tiny Forge (http://tinyforge.org) was setup to contribute to the
development of Tiny ERP. It has many tools by project such as forums, tasks lists, bugs follow-up
system, management systemof the versions, system of advertisement of the new functionalities, search for
qualified contributor in certain fields...

• 

Access to the codes source is provided by the management systemof the SubVersion revisions.• 

Each contributor can create his own project or optional module with Tiny ERP. Those all are available to
downloading on TinyForge.org.

Partners

Partners are companies which offer the integration service of the software. Their customers are the companies
which wish to setup Tiny ERP. They work in collaboration, by contract, with the Tiny editor to ensure a service
of quality the end-user.

They deal with all the management of the integration project which generally includes the following phases:

Analysis of needs,• 
Drafting of the conditions,• 
Development specificities customers,• 
Settings and adapations of the reports and screens,• 
Recovery and import of the data,• 
Training of the users,• 
Display and put in production,• 
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Support.• 

The huge interest of the partners network is that each partner brings his developments or his competences
according to their favourite field: quality ISO9001, agro-alimentary specialist, countable experts office.

That guarantees to Tiny ERP a fast growth and multidisciplinaries.

The Tiny editor

The Tiny company, located in Belgium, is the editor of the Tiny ERP software. It's vouch for the permaneance of
the product, and the associated services. It's it which organizes the contributors network and partners. The
technical, commercial and marketing developments in the medium and long term are led by the Tiny company.

More than 80% of the developments on Tiny ERP are internal realized by the Tiny company. Its role is also to
test and validate all the contributions received by the partners and the contributors. It then publishes periodically a
stable Tiny ERP version made up of all the most important modules having been tested and having been
validated.

Its customers are the Tiny ERP partners to who it offers a support service, technical and users trainings, vouch for
possible bugs corrections, visibility on the Tiny ERP sites, etc.

Conclusion

The following figure represents the effect of these actors on the cycle of life of a Tiny ERP version.

To each actor and phase corresponds a specialized internet site:

Community developments is published and organized thanks to the http://TinyForge.org site. *Then, the
Tiny company publishes the stableTiny ERP version on the http://TinyERP.org site. This one is also used
as platform for the users with documentations, a follow-up bugs system, a forum and mailing lists.

• 

Finally, the software promotion is made on http://TinyERP.com,you'll find there the calendar of the next
activities, the programs partners, the functionalities of the software, the demonstrations in line, etc.

• 
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Modules in Tiny ERP

What's a module ?

A module represents a whole of functionalities which are packaged in the same repertory on the Tiny ERP server.
These functionalities can be of any kind: addition of new menus, addition of new reports, modification of forms,
simple data of demonstration, etc.

For each installation, it's necessary to select the modules which will be used or not by the company. This module
management allows each company to build its system to measure.

Thus, a food wholesaler will probably install the modules: Quality ISO9001, Foodstuffs, EDI like all the basic
modules such as the accounting, sale, stock management and finance, etc. But, not to overload the system of
useless functions, it'll probably not install the textile products, the campaigns marketing, the Finnish chart of
accounts, etc...

We distinguishe two main categories of modules:

The modules which meet specific needs: Quality ISO9001, Products with matrices of variants, EDI,
interface with Outlook, French location, etc

• 

Modules specific to a sector: agro-alimentary, pharmaceutical management, service companies,
management of travel agency, etc...

• 

A module is implemented by only one file in the 'Addons' repertory of the Tiny ERP server. The description file
of the module is called __terp__.py is available in each module repertory. You'll find there information following:
module name, version, author, Web site, dependencies,module category, .XML files used and if it's active or not.
It can be interesting to modify this file before the installation to change the 'active' field from True to False vice
versa. That allows to install only the necessaries modules.

In the next Tiny ERP versions, a system of management automated of the installations, update and removal of
modules will be available directly from the customer. That will allow the administrator to manage his modules in
all simplicity. These functionalities are already available thanks to the 'Administration > Modules' menu but it's
advised to use them not before Tiny ERP version 3.4.

The chart of the modules

Certain modules can depend on other modules. Thus, the module of stock management depends on the accounting
module for the needs for accounting valorization of stocks. If you wish to install a stock management, accounting
will have to be installed.

The graph of the dependencies of the principal modules is given by the figure below.
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For example, you can read there that if you wish to install the production management (module: mrp), it'll at least
be necessary to install the following modules: purchase, hr, stock, product, account, base. If one of these modules
isn't necessary to your company, you can always hide the corresponding menus.

You can obtain this dependencies graphfor your installation thanks to the 'gen_graph.sh' program
which is in the repertory addons server.

Selection of interesting modules

Follow-up of the multilevel reminders

 Author: Tiny
 Module: account_followup

The management of the multilevel reminders allow to automate your customers revivals according to dates
defined by the differents levels of reminders. On each level, the revival letter can be different. That considerably
simplifies the revivals because you have to click on a menu to obtain all the revivals letters.

Partners relations management

 Author: Tiny
 Module: Base Partner Relation

This module allows to manage the relations between partners. It's generally used by the suppliers of large
companies, when there are central merchandizings, an accounting department managed by another partner or
other complex relations. Example: when store X buys, you have to deliver to central and to invoice at a third
company.

EDI

 Author: Tiny
 Module: edi
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Module EDI automatically allows to synchronize the documents between differents ERP. Thus, the orders or
deliveries can be automatically communicated to SAP systems thanks to standard EDI of communication. The
functionalities necessary to EDI are also found in this module: management of the codes EAN, management of
the selling price.

Integration of the projects and timesheet

 Author: Tiny
 Module: hr_timesheet_project

This module allows to establish the link between the timesheets and the done tasks in the project management.
The done work on the tasks can automatically fill the services of the employee in the timesheet.

Internationalizations

 Author: Tiny Partners 
 Module: l10n_XXX

The internationalization modules begin all with l10n_COUNTRYCODE. Where the COUNTRYCODE is given
by two letters representing the ISO code of the country. They implement differents functionalities necessary to
each country: chart of accounts and specific taxes, page-setting of invoices, translations. In addition to these
modules, translations are available in 16 different languages.

Management of the standard letters and quotes complex

 Author: Tiny
 Module: letter

The LETTER module allows to create standard documents with variable paragraphs. Those can be composed
according to the document to write. It's mainly used for important letters and when the quotes are complex and
often similar.

Management of computers paks

 Author: Tiny
 Module: network

The NETWORK module allows to manage the networks and the computers parks of the company or its
customers. You'll find there the material and network architecture installed, the history of the technical
interventions, the guarantees and the software installed. It's also very practical to centralize the passwords of the
differents components.

Manufactured goods

 Author: Tiny
 Module: product_electrinic

This module allows to add functionalities to the products features. The principal function is to add, in addition to
the suppliers, the producers of the product and their referencies.

Products with expiry

 Author: Tiny
 Module: product_expiry

The management module of the expiry dates is mainly used in the sector of chemistry and the agro-alimentary. it
allows to manage the various dates on the products and the batches. You'll find there in particular: the deadline of
consumption, the ordinary deadline of use, the date of alarm and the date of withdrawal of stock.
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Productivity analysis of the users

 Auteur: Tiny
 Module: productivity_analysis

This module allows to analyze for all the documents of the ERP, the productivity of the users of the system. This
productivity is measured compared to the number of documents of the same type which are created or modified.
It allows to display several types of graphs according to the needs. It's generally used to analyze the users whose
function consists mainly to encoding.

Management of the discounts/rebates

 Author: Tiny
 Module: sale_rebate

This module is a complement to the management of the prices by price list. It allows to manage discounts on the
customer orders (and quote) and on the invoices. These discounts are applied at the end of the document for the
whole of the lines.

Management of the lunchtime order of the employees

 Author: Tiny
 Module: sandwich

This module allows to each employee to order and manage its preferencies for the lunchtime. That allows to
automate the grouped order and to manage the preferencies of each one: who wants a Coke, which wants
mayonnaise on his sandwich, etc.

Nimble method of management of developments SCRUM

 Authour: Tiny
 Module: scrum

This module implements all the functions necessary to the nimble methodology of computer project management
SCRUM. All the concepts necessary are implemented: burndown chart, scrum manager, sprints, daily meetings,
and the backlog product. For more information on this project methodology management, visit the
http://controlchaos.com site.

Management of the subscriptions

 Author: Tiny
 Module: subcription

The management of the subscriptions and the recurrent documents allows to manage all recurrent types of
operation. There, some examples of use: management of the monthly quotes, invoices recurrent, requests of
reminder each week during 1 year, etc.

Example travel agency

 Author: Tiny
 Module: travel
 Website: http://tinyforge.org/projects/modtravel/

The Travel module was developed with a teaching objective. It allows to show how we could develop a
management system of travel agency in 20 minutes. It includes the management of the flight tickets, the hotels
and the reservation of the rooms. You will find explanations on the implementation of the module on
http://tinyerp.org
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Textile and Fashion products

 Author: Manuel Sulmont
 Module: modprodfashion
 Location: http://tinyforge.org/projects/modprodfashion/

This module allows to manage multiple dimensions of the products varaints. The production control is also
adapted to these variants in order to make generic nomenclatures which depend on the characteristics of the
product. It's mainly used in the textile and fashion field but can be used in many other sectors.

Integration eCommerce

 Author: Tiny
 Module: esale, oscommerce, joomla

There are several modules to interface Tiny ERP with one or more Internet sites eCommerce. Currently, Tiny
ERP supports the three systems eCommerce according to: Joomla, OSCommerce, ezPublish.

Management of the quality

 Author: Tecsas.fr
 Module: quality
 Website: http://tinyforge.org/projects/quality/

This module allows to manage the differents documents and operations defined by the standard quality ISO9001
v2000. It includes for example a management system of the quality manual, the correctives/preventives actions,
etc.

Email Integration

 Author: Tiny
 Module: External program
 Website: http://tinyforge.org/projects/email-interface/

This external program with Tiny ERP is interfaced into XML-RPC. It allows to synchronize the received or send
emails and to add them in the events partners according to the sender or of the adressee.

Management of the workflows XPDL

 Author: Ludovic Gasc & Nicolas Brayard
 Module: External program
 Website: http://tinyforge.org/projects/convertworkflow/

This program allows to convert workflows with standard format XPDL towards the format used by Tiny ERP
internal. This conversion is interesting to allow to use an editor of standard workflow to design the
decision-making graphs specific to the company.

Logon manager

 Author: Thymbra.com
 Module: External Program
 Website: http://tinyforge.org/projects/tlogon/

The conenctions manager of Tiny ERP allows to have a simple entrance point towards multiple authorities of
Tiny ERP. He allows a fast edition of the Tiny ERP server, a research and sorting on descriptions and the roles:
development, quality assurance, training server and production. It's very useful to manage the trainings and the
authorities of the differents classes or pupils.
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Economic model of the Editor

We couldn't finish this book, on a so great free software, without answering the permaneance question. Indeed, it
doesn't occur only one conference without a person ask the question:

How can we earn money by developing a free software ?

There are many answers to this question and certain models can be hard to explain. I'll try to answer this question
in the case of Tiny ERP, and more particularly of the Tiny company, editor of the free software.

To understand the ERP market, you have to known that the total cost of acquisition of a ERP owner is broken
down like this;

0 to 10%: study and conditions• 
30 to 40%: cost of the licence owner• 
50 to 70%: integration service (adaptations, settings, trainings, display, ...)• 

The problem of a free software is that on an integration for a customer, there is a loss of earnings approximately
35% correspondent to the licence price! The integration services cost is identical for a free ERP software that for
a ERP owner (*).

The free software offsets this loss of earnings thanks to three factors:

a company (the editor) at very low cost of structure• 
a fast growth and at low cost of the product• 
a great distribution of the software• 

Low structure costs

The R&D in an editor represents approximately 5 to 18% of the wage costs according to the size of the editor.
The remainder is spent into administrative but especially, in majority, in a sales department and important
marketing.

For the free editors, the share of R&D ranges between 40% and 75% of human resources. Mainly because a free
software doesn't require an important sales force to be spread.

Illustration: the before-sale:

We need on average 7 appointments with a final customer to sell a ERP owner (*). That costs approximately 1500
EURO by prospect. The average for Tiny ERP in before-sale is 2.8 days because the client has already installed,
tested, validated and often adopted Tiny ERP. That gets an important benefit for the reduction of the sales
department (which doesn't produce a value).

Fast growth of the product

The free community, the contributors and the companies partners of Tiny ERP strongly take part in the growth of
the software on all the sides; developments, jobs adaptations, translations, documentations, ...

This growth isn't due to a voluntary movement but to a real need for the users and retailers. Tiny ERP directly
benefit for the effect swell of snow of the GPL license which forces all improvement of the product to be
redistributed under GPL license.

It's particularly important in the ERP field where the jobs needs are important and where specific developments
have to be developed by companies having several experiment yearsin this field. An editor can't all control.
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Illustration: translations:

Six months after the launching of the translation Tiny ERP system, this one was adapted to 15 languages and in
many countries. Imagine the cost and time necessary to an European editor to adapt to the Chinese market. For
Tiny ERP, all this work was made by local contributors and 3 months later a school gave trainings on Tiny ERP
in China.

Great distribution of the product

The fact of being able to benefit for the software and the sources free implies a great diistribution; distributions
Linux (Debian, RedHat), free CD's in the informatic magazines, schools for their pupils,... That offer a customer
potential very important and to nil cost.

This mechanism is well-known from telephone operators who distributed almost free transmobile phones with
subscriptions to then sell telephone units.

Each companies know that it much less costs to sell to an already acquired customer to find new customers. It's
highly probable that each company which installs and uses Tiny ERP will have at least to take a guarantee, a
support contract, ...

Illustration: Distribution to prospects:

Tiny ERP is downloaded and evaluated by more than 600 people each day. Imagine the cost of the commercial
services of an editor owner who have visit 600 prospect by day to make demonstrations.

And risks

The free economic model allows a better sales growth and product (at lower cost) but has also more risks.

For a free software, each customer can download, test and evaluate the software before buying the service. It's an
important risk for an editor because you can't offset a bad product or a non-correspondance with a need by a
commercial good.

Also, there is place only for one handle of editors on the market of the free ERP whereas there are thousands of
software publishers owners. Indeed, the software being able to be freely tested and compared, the contributors
and customers goes spontaneously towards the best produced. We can with difficulty have a marketing policy and
effective marketing of differentiation on the market of the free software.

Lastly, the growth of a free product being very fast, the first free editor on a new sector quickly constitutes a
partner network and a strong community. It's then difficult with an outsider to catch up it.

Summary

In brief; a free software publisher has a loss of earnings Net of 35% on each integration but sells more, at lower
costs and has a product with very great growth. There are however important risks which make that the product
have to be very mature and be one of the first on its sector to succeed.

(*) first making of contact, analyzes need, demonstration to measure, to differents departments, second
appointement for the selected software, demonstration to validate the conditions, ...
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The implementation

Flexible and adjustable as rare is generally a software, Tiny ERP requires a great control, as much in the software
than itself, than the processes and entity functions in which this ERP will be put in production.

In addition to the final configuration part that we already approached in the previous chapters, remains to see the
differents ways to install the software, to configure the base, like import the old system of use in the company,
towards Tiny ERP.

Indeed, an import, as well thought is it, can't be perfect without the import of the operating data accumulated until
now.

Partners, prospects, buying and sales orders, istock reporting, products catalogued and client relationships are as
many elements as it's often possible to recover and insert in Tiny ERP before even launching it.

The present section covers and clarifies the differents ways to install and to set Tiny ERP, as well as the
techniques to implement to import the necessary data to the continuation of the usual operations of the company.
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Installation of Tiny ERP

You can install Tiny ERP on many operating systems. We will treat here the installation of the Tiny ERP client
and server, under both the Microsoft Windows and Debian GNU/Linux environments.

These examples of installation are made by respective automatic setups for both operating systems.
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Installing Tiny ERP under Windows 2000/XP

Chapter content

System requirements
Dependencies

Install PostgreSQL
Download PostgreSQL
Install PostgreSQL 8

Create a new database for Tiny ERP Server

Install Tiny ERP Server
Dowload Tiny ERP Server
Install Tiny ERP Server

Preparing the server to the first launch
Tiny ERP Prompt

Deciding how to use the server
First launch with demonstration data
First launch with an empty database
First launch whith an updated Tiny ERP Server version

Launching the server
From the command prompt
From the main menu
From the Windows Services Management

Monitoring the Tiny ERP Server
Configuring the Tiny ERP Server

Installing the Tiny ERP Client
Downloading the Tiny ERP Client
Installing the Client
Launching the Client

System requirements

The server only works under Windows 2000 and XP with the formatted hard disk in NTFS (not a partition FAT
or FAT32). Tiny ERP Server can't work under Windows 98 or ME, PostgreSQL 8 is the issue.

If you wish to use Tiny ERP, you have to install Tiny ERP Server andTiny ERP Client

Dependencies

To install Tiny ERP in your work environment, you have to install :

The Database Management System PostgreSQL http://www.postgresql.org1. 
Tiny ERP Server http://tinyerp.org2. 
Tiny ERP Client3. 

The Tiny ERP server directly depends on the database management system, so you have to install first the latter.
The client can't work without possibility to connect to a Tiny ERP server. The connexion may be either a local
connection on the computer itself or on a distant server using the network.
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Install PostgreSQL

If you have already installed and configured PostgreSQL, you can go to the section Preparation of a new
database.

Download PostgreSQL

Download the setup installers of the database management system from the site of PostreSQL.

You will find archives containing different versions of the database in the directory
http://www.postgresql.org/ftp/binary/

In this directory there are several versions, don't hesitate to download the most recent. Entering into the directory
corresponding to the chosen version, you will find the Windows version in the sub-directory win32

Install PostgreSQL 8

Decompress the archive in a directory. Be careful, four files will appear, and each of them is necessary for you !

Launch the installation program by clicking on the file named postgresql-X.Y.msi, where X.Y is the version
number.

First screens of the installer may be let with the choices by default. It is about the choice of the components which
will be installed.

There are two sets of login and password that you will have to know later :

The first login is requested in the screen in Service configuration. It's the setup of a services special
account for handling the PostgreSQL server management. Thereafter you will probably not need these
logins, but record them in case of future need.

1. 

The second login is required for accessing the database. It is defined in the screen Initialise database
cluster . Be sure to remember this login and its password. You will need it later for the installation.

2. 

Attach:pgsql_install.service_configuration.png ∆

In the screen of service configuration, the field Account domain should be the same as the server name. The
installer fills the correct value by default.

You can get a warning message saying that the password you have typed is too weak to properly protect the
database, in that case you can replace the password by a password automatically generated in a random way. Of
course you can keep your password.

Attach:pgsql_install.weak_pwd.png ∆

Attach:pgsql_install.init_cluster.admin_login_def.png ∆

In the screen Initialise database cluster You are invited to type a super userid and its password. This account is an
administrator account whithout access restriction. It will be used for creating the Tiny ERP Server database.

Choices by default in the remaining screens don't need to be modified. You have now a PostgreSQL server
installed and configured. Then you have to create a database for the Tiny ERP Server.

Create a new database for Tiny ERP Server

If you already have a database for Tiny ERP or if you update your system, you can go to the next section, Install
Tiny ERP Server
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To create the database for Tiny ERP server, open the prompt command from the main menu of PostgreSQL :

The prompt directly opens into the installation directory of PostgreSQL and you can directly create the database :

    createdb -U <superuser_username> --encoding=UNICODE terp

terp is the database name1. 
superuser_username is the adimistrator name that you choosed in the above initialisation cluster screen.2. 

Don't forget to specify the "Encoding" option. Indeed, whithout this option, data won't be recorded
in the correct format, and you could encounter errors when running TinyERP !

If you see a command with a parameter related to your configuration, the convention is
to put in angle brackets <> the parameter to key in. While customizing the command,
don't type the brackets. For example <superuser_username> means that you have to
type the postgres administrator as superuser username of the database.

Example of command :

    C:\Program Files\PostgreSQL\8.1\bin>createdb -U postgresadmin --encoding=UNICODE terp
    Password: <enter password again>
    CREATE DATABASE

    C:\Program Files\PostgreSQL\8.1\bin>

The display out can vary, and if you are asked to type the password a second time, type it a second time. If you
run the same command a second time, after typing the password, you will get the following error message :

That error message tells that the database you tried to create already exists.
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At this point, you have a complete and functional installation of PostgreSQL. You can now install Tiny ERP
Server.

Install Tiny ERP Server

Download Tiny ERP Server

You will find the Windows installer of the last Tiny ERP Server version at the following address :
http://www.tinyerp.org/download.php

Dowload the file tinyerp-server-X.Y.Z.exe.

Install Tiny ERP Server

The server application is automatically installed.

Tiny ERP Server is installed from now on as a Windows service. It means that you don't have to launch anymore
the server at each computer startup and it runs without need to open a user session.

At the end of the installation, the install guide suggests you to open the Tiny ERP Prompt, the command line,
from which you can prepare your server as follows.

Attach:terp_server.finish_install.png ∆

Preparing the server for the first launch

The Windows service for Tiny ERP Server is installed during the installation and it is configured to start
automatically while launching the system.

From now on, the configuration file is recorded in the installation directory. For example in :

 C:\Program Files\Tiny ERP Server\etc\tinyerp-server.conf

Tiny ERP Prompt

At the end of the installation, the installation guide suggests to open a Tiny ERP Prompt command.

To start manually the server, launch the Windows prompt command and go to the installation directory :
"C:\Program Files\Tiny ERP Server\bin\":

Attach:terp_prompt.cd_path.png ∆

You can also start Tiny ERP Prompt from the Startup menu which leads you directly into the server directory, so
you will be able to directly run the commands :

Attach:terps_menu.terp_prompt.png ∆

Attach:terp_prompt.cmd_serverhome.png ∆

You have to initialize the Tiny ERP server and record the configurations for the service to be able
to automatically start the service.

You should also specify a log file in order to have the printout server execution.
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Once in the server directory, type the following command, but don't run it yet:

    tinyerp-server.exe -d <db_name> -r <db_user> -w <db_password> --db_host=localhost
        --db_port=5432 --logfile="<logfile>" -s --stop-after-init

The Tiny ERP Server initialization consists in supplying the necessary information for the connection to the
PostgreSQL database and the choice indication of the structures to load. Here below is the explanation of the
options :

-d <db_name> : Tiny ERP Server database name1. 
-r <db_user> : PostgreSQL Administrator's name2. 
-w <db_password> : Administrator's password3. 
--db_host=<postgresql_server_address> : Address of the server where the PostgreSQL server is
located. If you have installed PostgreSQL on the same computer as Tiny ERP Server, you can type
localhost, else the IP address or name of the distant server.

4. 

--db_port=<port_nb> : PostgreSQL Port number. 5432 by default.5. 
-s : This option allows you to save the options in the configuration server file. It ensures a better security,
because you don't have to everytime launch the server with the unscrambled password

6. 

--stop-after-init: This option is used to stop the server after initialization.7. 
'''--logfile="<logfile>": Specifies the logfile where the information will be recorded during the execution
of the server.

8. 

Before running this command you have to decide for which usage you are going to run Tiny
ERP : Process as explained in the next section! the command is on an only line, the ohter
long commands too.

Typical command :

    tinyerp-server.exe -d terp -r postgresadmin -w postgresadminpasswd
        --db_host=localhost --logfile="C:\Program Files\Tiny ERP Server\tinyerp-server.log"
        --db_port=5432 -s  --stop-after-init

At this stage, you have to type the login and password initialized in the screen Initialise database cluster.

When you will run the inizialisation command, you will see nothing printed in the Windows prompt
if you have specified a log file.
Everything is written in the log file. You just have to wait until the restoration of the prompt.

Deciding how to use the server

You have three possibilities for the first launch. This part is very important because the correct initialization of
the data can prove to be crucial.

You can initialize the database using Tiny ERP Server in order to:

Observe the system with demonstration data. In that case the server will load different ERP objects
(products, partners, analytical accounts, etc.)

1. 

Initialize the system whith an empty database (without demonstration data). In that case you can start
creating your own data, corresponding to your company.

2. 

Update the installation of a previous version.3. 
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First launch with demonstration data

To initialize Tiny ERP Server with the demonstration data, you have to add the following option to the above
command :

     --init=all

Example :

    tinyerp-server.exe -d terp -r postgresadmin -w postgresadminpasswd
        --db_host=localhost --logfile="C:\Program Files\Tiny ERP Server\tinyerp-server.log"
        --db_port=5432 -s  --stop-after-init --init=all

This command initializes Tiny ERP Server and fills its database PostgreSQL with the demonstration data.

First launch with an empty database

Run the command with the option which excludes the demonstration data:

        --without-demo=all

This will load all the modules, but will not load the demonstration data.

Example :

    tinyerp-server.exe -d terp -r postgresadmin -w postgresadminpasswd
        --db_host=localhost --logfile="C:\Program Files\Tiny ERP Server\tinyerp-server.log"
        --db_port=5432 -s  --stop-after-init --without-demo=all

If you have already initialized the database and loaded the demonstration data, you can
recrate a new database

First launch with an updated Tiny ERP Server version

Run the command with the option which updates the structures of the data:

    --update=all

Example :

    tinyerp-server.exe -d terp -r postgresadmin -w postgresadminpasswd
        --db_host=localhost --logfile="C:\Program Files\Tiny ERP Server\tinyerp-server.log" 
        --db_port=5432 -s  --stop-after-init --update=all

Launching the server

Now, the Tiny ERP server being initialized and the configurations recorded, you can finally start the Tiny ERP
Server service.

In the menu we still kept the icon which directly runs the ERP server, but it's only for tests and debugging
reasons.

From the command prompt

Now you can launch the Tiny ERP Server service from the command prompt with a simple command:
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        net start tinyerp-services

Attach:terp_service.start.png ∆

You can also stop the service in a similar way, for example when the service is running, but that you have to
restart it:

        net stop tinyerp-services

Attach:terp_service.stop.png ∆

From the main menu

You can also control the service from the programs main menu:

Attach:terps_menu.server_controls.png ∆

From the Windows Services Management

The service and information about the running are also available in the Manager of the computer in
Administration Tools.

Attach:terp_service.mmc_terp_service.png ∆

Attach:terp_service.mmc_logs.png ∆

The service that records messages offers additional information about the execution of the Tiny ERP Server
service.

In the services manager you can also define the actions to take when the server fails.

Attach:terp_service.mmc_control_actions.png ∆

Monitoring the Tiny ERP Server

You can find information about startup and stop in the events browser.

The end of Tiny ERP Server session may be consulted in the log file that you will have secified in the
initialization command.

As the server runs as a Windows service, there is no printout message during the execution. The only solution is
to define a log file.

You can monitor the Tiny ERP Server by using the Windows Tasks Manager. In the Processes tab you will see
TinyERPServerService.exe and tinyerp-server.exe running as SYSTEM user.

Attach:terp_service.running.png ∆

Configuring the Tiny ERP Server

The Tiny ERP Server menu contains a link to the configuration file used by the service. In that way you can edit
the configuration and then restart the service in order to load the new configuration.

Attach:terps_menu.editconf.png ∆

Attach:terp_server.conf.png ∆
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Be extremely careful while updating directly the configuration file, you can corrupt the whole
system whith incorrect values.

Installing the Tiny ERP Client

Installing the client is very simple thanks to the automated Windows installer.

Before installing the Tiny ERP Client, please install Tiny ERP Server! The client can't work without the server.
You can install the Tiny ERP server either on the same computer or on a distant server accessible by the network.

Download the Tiny ERP Client

You will find the Windows installer of the last ERP Client version at the following address :
http://www.tinyerp.org/download.php

Download the file tinyerp-client-X.Y.Z.exe

Installing the Client

The server application is installed in an automatic way, you can choose the installation directory. For a later use,
note the installation directory.

Launching the Client

The installation program creates shortcuts in the main menu and on the desktop to make the client launching
easier.

Before trying a connection to the server, be sure that there is a Tiny ERP server running either on the computer
where the client is installed, or on a distant server accessible by the network. If it's not the case, you won't use the
client software.

When you launch the server for the first time, you are invited to fill a questionnaire about the Tiny ERP uses in

Configuring the Tiny ERP Server 265

18/09/06

http://www.tinyerp.org/download.php


1

your company. This information is a useful feedback for the developers.
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Installing Tiny ERP under Debian GNU/Linux

You will find here below the instructions for installing Tiny ERP under a Debian GNU/Linux system. The
necessary packages as well as the dependencies are included in the packages of the Debian distribution.

The dependencies

Tiny ERP Server directly depends on the following packages, that are so mandatory :

    * Python (at least version 2.3)
    * links Python for the XML Library
    * links Python for libxslt1
    * module Python for PostgreSQL
    * ReportLab library allowing to create PDF files with Python

The server also depends on the PostgreSQL database, but it is not necessary to have on the same system the Tiny
ERP server and PostgreSQL. So this dependence is among the recommended dependencies.

Here below, the commands to install Tiny ERP Server with apt :

    * mandatory dependencies (Tiny ERP version 3.3.0-1) : 

    apt-get install adduser python python-libxml2 python-libxslt1 python-psycopg python-reportlab python-xml

    * recommended dependencies : 

    apt-get install graphviz python-imaging python-pyparsing
    apt-get install postgresql postgresql-client

Installing the Tiny ERP server

To install the server, you have to execute the following command :

    apt-get install tinyerp-server 

At the end of the installation, and if it finds a possible local connection to PostgreSQL, the Debian automatic
installer initializes a database for the ERP. So if it is the firt time that you install the TinyERP server, the server
will automatically fill in the terp database with the demonstration data.

In that case you will be able to directly connect yourself to the client and to explore the demonstration data.

Preparing a new database

You can create a new database in PostgreSQL for only loading the basic structures without the demo data.

Creating a database

During the installation of the Tiny ERP Server package, an user account is added to the system : terp. When you
start the tinyerp-server service in /etc/init.d/, the process is executed under this name. There is also a profile in
PostgreSQL, corresponding to this user account. It allows the connection to the database service.

The database that will be used by the ERP has to belong to this profile, otherwise you have to create a new profile
which the base will belong to.

For creating a new database, you have to execute the following command:

    su postgres -c "createdb -U postgres -O terp --encoding=UNICODE terp"
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Setting up the Tiny ERP Server

The server setup is located in

/etc/default/tinyerp-server

When you want to modify the connection parameters to the database, the database name or the network interface
of the ERP server, you have to record these parameters in that file and reload the ERP server.

It is important to know that, when you modify the name of the database to use, the server initializes the database
with the demonstration data the first time it is launched.

If you have created a new database and you wish to initilize it without the demonstration data, stop the ERP
server, create the database, record the configurations and process the next section which indicates how to properly
initialize the database.

Initializing the Tiny ERP Server

To initialize a new empty database, you have to execute the following command :

    su postgres -c "/usr/sbin/tinyerp-server --without-demo=all -d newdbname"

where newdbname is the name of the database previouly created, and currently empty. Of course you can add
every server option useful for correctly processing the initialization.

This operation loads the tables structures necessary to the ERP server running.

Launching the Tiny ERP Server

The ERP server is launched by defaut in the usual runlevels, so the service is available from the system startup.

If you want to stop the execution and relaunch the server, you can do it by using the script of the service
initialization :

/etc/init.d/tinyerp-server

with classical options (start|stop|restart)

Installing the Tiny ERP Client

Installing the Tiny ERP Client can be done by using the command:

    apt-get install tinyerp-client

This command will install every dependency necessary to the client, and you can immediately connect a Tiny
ERP server.

Additional information

To get additional information, regarding the location management for example, you can consult the file :

     /usr/share/doc/tinyerp-server/README.Debian
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Configuration plan

Install whith Without Demo

The order of the points to be configured.
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Datas import

In this section we'll see how it's possible to import the data used by your current programs in Tiny ERP.

There are several import methods:

the hot import, which requires to use XML-RPC interface of the server in order to import the whole of
your recordings thanks to a program which has be developed for the need,

• 

the import by xml files, on the part Tiny ERP server,• 
the import by CSV files, on the part Tiny ERP customer.• 

In this chapter, we'll detail the third method, which is at the same time simple and powerful. It's simple because
all the procedure is made on the customer side of Tiny ERP, every user can do it. But it's also powerful because
all the relations of Tiny ERP are managed. Thus, for example, you can import a partners series with their
differents contacts in only once.

The CSV files

This method is based on data with CSV format (comma separated values). They are files to the texts format where
the differents fields are separated by commas. Here an file example:

 Title 1,"Title 2","Title 3"
 "Col 1","Col, Num 2","Col 3"
 Col 1.2,Col 2.2,Number

The following figure represents the data represented by this example of .CSV file.

We distinguishe between two variables in the definition of the CSV format:

The field separator makes possible to separate the columns by a fixed character, in that above case, it's the
comma.

• 

The text delimitor makes possible to delimit the texts by a given character, the field separator of can be
framed by two delimitors.

• 

The spreadsheves which generate .CSV files can have field separators and different text delimitors.

To obtain a .CSV file, simplest is to go from one of the programs according to: Ms. Excel, Open Office Calc,
Gnumeric. They are all the three able to import many formats of different files and to export the result under
.CSV.

If you use Open Office 2.0, parameters will be asked to you at the saving time in CSV, use the following data
which are the default values in the import Tiny ERP:

Character set: Unicode (UTF-8)• 
Field separator: ,• 
Text separator: "• 

Import datas

Each column of .CSV file have to correspond to a form field of which you wishe to import data. When your .CSV
file is ready, open Tiny ERP and place in the form the type of data which you wish to import.
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The image below represents the import form from a partner feature.

Then you have to select the fields of your file in the good order. To do, select a field within the left frame 'All the
fields' and add to it within the frame 'fields to import'. You have to use the 'Add', 'Remove', 'All', 'Anything'
buttons to create the fields list to import within the right frame.

The fields order is essential, it must exactly correspond to the same order as your .CSV file.

The fields on blue background are obligatories. You don't have necessarily to define it in the import file if, for
example, a default value were defined for the field in question.

The 'File selection' frame allows to select the file to import. If you don't know the exact way of your file, you can
display the 'Scan for other files' function.

For a first example, we suggest to the reader trying to import a file containing of the simple data:

 Company,Site Web
 Tiny sprl,http://tiny.be
 Sednacom,http://sednacom.fr

Import of the complex relations

There are three kinds of relations in Tiny ERP:
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Simple relations (many2one), such as the contact country which is a simple link towards the other object,• 
Multiple relations (many2many), such as the partner categories which can be multiple for each partner,• 
complex relations (one2many), such as the differents contacts of the same partner.• 

Simple relations

The simple relations are made while putting in the field name, the resource name towards which one you wishe to
establish a link. When the linked resource has a field codes, you can also use the resource code.

For example, if you wish to import contacts with their respective countries, you can import following .CSV file:

 Contact name,Country
 Fabien Pinckaers,France
 Stéphane Debois,fr
 Eric Flaux,be

In that example, we imported two French (Fr) and a Belgian (Be). If you indicate a country which doesn't exist,
the import will be stopped and Tiny ERP displays you an error message.

The links relations

The multiple relations are treated of same manner as the simple relations with the difference that there can be
several relations for the same resource. The differents relations must separated by a comma.

The following example presents an import example of partners with differentss categories:

 Company,Categories
 Tiny sprl,"Prospect,Supplier"
 Sednacom,"Newsletter"

For the working's import, of course it's necessary to have defined prior to the "Prospect", "Supplier" and
"Newsletter" categories. Thuen, the "Tiny sprl" partner is in two categories and Sednacom in only one.

Complex relations

The complex relations indicate resources which belong to the imported resource. For example, if you import
partners differents contacts of this partner belong to this complex relation. In the same way, the lines of an order
form belong to the complex relation of the order form.

A complex relation has several fields which all must be imported. For example, differents contact fields for the
various contacts of the same partner.

To import a field which comes from a complex relation, it's necessary to separate the name from the relation and
the field by one "/".

Thus, if you import partners containing several contacts, you can use the following datas:

 Company,Adress/Contact name,Adress/Country
 Tiny SPRL,Fabien Pinckaers,be
 ,Stéphane Dubois,be
 Sednacom SA,Lionel Darnis,fr

In that above example, two partners were imported, the first of them contains two contacts in Belgium.

Simplify the successive tests

To simplify the import procedure of the data, it's possible to enter the fields name in the first line of .CSV file.
Thus, you won't manually encode anymore the fields represented in the file.
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To do, start by selecting your file containing the data. Then click on the Auto-Detect button and Tiny ERP will
automatically load the columns according to the first line of this file.

We advise to use this method if you wish to make several successive imports not to redefine the order of the
fields each time.
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Conclusion

to write...
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to complete...
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